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Preface

This User Guide has been implemented by Boot & Work, S.L.

working under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

● Persons in charge of introducing automation devices.

● Persons who design automation systems.

● Persons who install or connect automation devices.

● Persons who manage working automation installation.

Warnings:

● Unused pins should not be connected. Ignoring the directive may damage the

controller.

● Improper use of this product may severely damage the controller.

● Refer to the controller’s User Guide regarding wiring considerations.

● Before using this product, it is the responsibility of the user to read the product’s User

Guide and all accompanying documentation.

● Maintenance must be performed by qualified personnel familiarized with the

construction, operation, and hazards involved with the control.

● Maintenance should be performed with the control out of operation and disconnected

from all sources of power.

● Care should be taken when servicing electrostatic sensitive components. The

manufacturer's recommendations for these components should be followed.
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● The M-Duino Family PLCs are Open Type Controllers. It is required that you install the

M-Duino PLC in a housing, cabinet, or electric control room. Entry to the housing,

cabinet, or electric control room should be limited to authorized personnel. Failure to

follow these installation requirements could result in severe personal injury and/or

property damage. Always follow these requirements when installing M-Duino family

PLCs.

● In case of installation or maintenance of the M-Duino please follow the instructions

marked in the Installation and Maintenance section.

● Do not disconnect equipment when a flammable or combustible atmosphere is

present. Disconnection of equipment when a flammable or combustible atmosphere is

present may cause a fire or explosion which could result in death, serious injury and/or

property damage.

Avertissements:

● Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut

endommager le contrôleur.

● Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur.

● Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de

câblage.

● Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du

produit et la documentation qui l’accompagne.

● La maintenance doit être effectuée par personnel qualifié familiarisé avec la

fabrication, le fonctionnement et les dangers liés au contrôleur.

● La maintenance doit être effectuée avec l’équipement hors service et déconnectée de

toutes les sources d'alimentation.

● Faites attention lors de l'entretien des composants sensibles à l'électricité statique. Les

recommandations du fabricant pour ces composants doivent être suivies.

● Les automates de la famille M-Duino sont des contrôleurs de type ouvert. Il est

nécessaire d'installer l'automate M-Duino dans un boîtier, une armoire ou une salle de

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences

d'installation peut entraîner des blessures graves et/ou des dommages matériels

importants. Respectez toujours ces exigences lors de l'installation des automates de la

famille M-Duino.

● En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions

indiquées dans la section Installation et Maintenance.

● Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou

combustible. La déconnexion de l'équipement en présence d'une atmosphère

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant

entraîner la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your

comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT

BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF

PERSONS, AS THEY ARE NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING

THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED TO ADDRESS THE RISKS, NEVER USE THE

INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND

INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or

standards that apply to the combination of products in the customer’s application or use of the

product.

The following are some examples of applications for which particular attention must be given.

This is not intended to be an exhaustive list of all possible uses of the products, nor is it

intended to imply that the uses may be suitable for the products:

● Systems, machines, and equipment that could present a risk to life or property.

● Nuclear energy control systems, combustion systems, railroad systems, aviation

systems, medical equipment, amusement machines, vehicles, safety equipment, and

installation subject to separate industry or government regulations.

● Outdoor use, uses involving potential chemical contamination or electrical

interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification

documents identifying ratings and limitations of use that apply to the products. This

information by itself is not sufficient for a complete determination of the suitability of the

products in combination with the system, machine, end product, or other application or use.
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Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the

catalogue and the associated technical documentation. If third-party products and components

are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,

installation, assembly, operation and maintenance have been carried out in a correct It must

respect the permissible ambient conditions. You should also follow the indications and

warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated

by qualified personnel for the task entrusted and observing what is indicated in the

documentation corresponding to it, particularly the safety instructions and warnings included

in it. Due to their training and experience, qualified personnel are in a position to recognize

risks resulting from the handling or manipulation of such products / systems and to avoid

possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even

when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining

suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL

SHIELDS’s test conditions, and the users most correlate it to actual application requirements.

Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.

Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;

however, no responsibility is assumed for clerical, typographical, or proofreading errors, or

omissions.

Residual Risks
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The control and drive components of an Industrial Shields PLC are approved for industrial and

commercial use in industrial line supplies. Their use in public line supplies requires a different

configuration and/or additional measures. These components may only be operated in closed

housings or in higher-level control cabinets with protective covers that are closed, and when all

of the protective devices are used. These components may only be handled by qualified and

trained technical personnel who are knowledgeable and observe all of the safety information

and instructions on the components and in the associated technical user documentation.

When carrying out a risk assessment of a machine in accordance with the EU Machinery

Directive, the machine manufacturer must consider the following residual risks associated with

the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,

maintenance, and repairs caused by, for example: − Hardware defects and/or software errors in

the sensors, controllers, actuators, and connection technology − Response times of the

controller and drive − Operating and/or ambient conditions not within the scope of the

specification − Condensation / conductive contamination − Parameterization, programming,

cabling, and installation errors − Use of radio devices / cellular phones in the immediate

vicinity of the controller − External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for

example: − Component malfunctions − Software errors − Operating and/or ambient conditions

not within the scope of the specification − External influences / damage.

3. Hazardous shock voltages caused by, for example: − Component malfunctions − Influence of

electrostatic charging − Induction of voltages in moving motors − Operating and/or ambient

conditions not within the scope of the specification − Condensation / conductive

contamination − External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to

people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the

system and/or failure to dispose of components safely and correctly.

6



Ref. IS.MDUINO.58+ Rev. 3: 12-12-2024

Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials

and workmanship for a period of one year (or other period if specified) from date of sale by

Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,

REGARDING MERCHANABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE

OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR

INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR

IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL

DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE

PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR

STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY, REPAIR OR OTHER

CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT

THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT

SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

Conforms to UL Std. 61010-1
Conforms to UL Std. 61010-2-201
Certified to CSA Std. C22.2 No. 61010-1
Certified to CSA Std. C22.2 No. 61010-2-201

5016476
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1 General Description M-DUINO 58 I/Os PLUS product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is important

to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from

below and D the shield from above. Having a B and a C in the middle of the.:

● The inputs in the zone B are named I0.X, being X any number suitable in the Shield.
Outputs are named as Q0.X and relays as R0.X

● The inputs in the zone C are named I1.X, being X any number suitable in the Shield.
Outputs are named as Q1.X and relays as R1.X

● The inputs in the zone D are named I2.X, being X any number suitable in the Shield.
Outputs are named as Q2.X and relays as R2.X
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1.2 Zone Distribution

The distribution of the different features that provide the M-Duino 58 I/Os PLUS is the

following one:

11

Shield B Zone C Zone D Zone

Analog Shield

13 Inputs

(13 Digital inputs, 6

of which can work as

Analog Input)

8 Outputs

(8 Digital Outputs, 3

of which can work as

Analog Output)

13 Inputs

(13 Digital inputs, 6

of which can work as

Analog Input)

8 Outputs

(8 Digital Outputs, 3

of which can work as

Analog Output)

11 Inputs

(11 Digital Inputs, 4

of which can work as

Analog Input)

6 Outputs

(6 Digital Outputs, 2

of which can work as

Analog Outputs
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1.3 A Zone Features

Shield A Zone

Communication

Shield

(1x) Ethernet

(1x) USB

(1x) I2C

(3x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485

(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

1.4 Mechanical dimension
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1.5 General Features

13

CONECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE B+C+D Zone

Input Voltage
12 to 24Vdc

Fuse protection (2.5A)
Polarity protection

Input rated voltage
24 Vdc

Rated Power 30 W

I max. 1.5A

Size 101x119.3x119.5

Clock Speed 16MHz

Flash Memory 256KB of which 8KB used by bootloader

SRAM 8KB

EEPROM 4KB

Communications
I2C – Ethernet Port – USB – RS485 – RS232 -- SPI – (2x)

Rx, Tx (Arduino pins)
Max232-Max485-W5500

USB consideration!
Only meant for uploading or debugging, not always

connected as a serial in a project!
Cannot be working in a final

application

An/Dig Input 10bit
(0-10Vcc)

0 to 10Vac
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation

Rated Voltage: 24 Vdc

Digital Isolated Input
(24Vcc)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation

Rated Voltage: 24 Vdc

* Interrupt isolated Input
HS (24Vcc)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation

Rated Voltage: 24Vdc

Analog Output 8bit
(0-10Vcc)

0 to 10Vac
I max: 20 mA

Separated PCB ground
Rated Voltage: 10Vac

Digital Isolated Output
(24Vcc)

5 to 24Vdc
I max: 70 mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc
Imax 24Vdc: 410 mA
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Digital Isolated Output
Relay

220V Vdc
I max: 5A

Galvanic Isolation
Diode protected for Relay

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70 mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Expandability I2C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)
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2 Technical Specifications

2.1 General Specifications

Item M-Duino PLC Arduino Ethernet 58 I/Os Analog/Digital PLUS

Power supply
voltage

DC power supply 12 to 24Vdc

Operating
voltage range

DC power supply 11.4 to 25.4Vdc

Power
consumption

DC power supply 30W max.

External
power supply

Power supply
voltage

24Vdc

Power supply
output capacity

700Ma

Insulation resistance 20MΩmin.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength
2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all
the external AC terminals and the protective ground terminal.

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each.

Ambient temperature (operating) 0º to 60ºC

Ambient humidity (operating) 10% to 90% (no condensation)

Ambient environment (operating) With no corrosive gas

Ambient temperature (storage) -20º to 60ºC

Power supply holding time 2ms min.

Weight 850g max.

2.2 Performance Specification

Arduino Board ARDUINO MEGA 2560

Control method Stored program method

I/O control method Combination of the cyclic scan and immediate refresh processing methods.

Programming language
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega2560

Flash Memory 256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB

EEPROM 4KB

Clock Speed 16MHz

Clock Speed 16MHz
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2.3 Symbology

Table that includes all the symbology that is used in the serigraph of the M-Duino PLC Arduino

Ethernet 42 I/Os Analog/Digital PLUS:

Symbol Standard No. /
Standard Title

Standard Reference
No. / Symbol Title

Symbol Meaning

IEC 60417 /
Graphical symbols

for use on
equipment

5031 / Direct
Current

Indicates that the equipment is
suitable for direct current only; to

identify relevant terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5032 / Alternating
Current

Indicates that the equipment is
suitable for alternating current

only; to identify relevant
terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5130 / Pulse General
To identify the control by which a

pulse is started.

IEC 60417 /
Graphical symbols

for use on
equipment

5017 / Earth,
Ground

To identify an earth (ground)
terminal in cases where neither
the symbol 5018 nor 5019 is

explicily required.

IEC 60417 /
Graphical symbols

for use on
equipment

5115 / SIgnal lamp
To identify the switch by means
of which the signal lamp(s) is

(are) switched on or off.

2004/108/EC /
Electromagnetic
Compatibility

CE Marking
CE marking indicates that a

product complies with applicable
European Union regulations

ISO 7000/ Graphical
symbols for use on

equipment

0434B /
Warning symbol

Indicates a potentially hazardous
situation which, if not avoided,
could result in death or serious

injury

ISO 7000/ Graphical
symbols for use on

equipment

5036 / Dangerous
Voltage

To indicate hazards arising from
dangerous voltages
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3 Precautions

Read this manual before attempting to use the M-Duino PLC Arduino Ethernet 58 I/Os
Analog/Digital PLUS and follow its descriptions for reference during operation.

3.1 Arduino Board

The M-Duino 58 I/Os PLUS PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate M-Duino according to the performance specifications described in this

manual.

Before using M-Duino under different conditions from what has been specified in this manual

or integrating M-Duino to nuclear control systems, railroad systems, aviation systems, vehicles,

combustion systems, medical equipment, amusement machines, safety equipment and other

systems, machines, and equipment that may have a serious influence on lives and property if

used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and

performance characteristics of M-Duino are sufficient for the systems, machines, and

equipment, and be sure to provide the systems, machines, and equipment double safety

mechanisms. This manual provides information for programming and operating the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different

systems. This means that if an external device or sensor that shares the same ground reference

(GND) with the system is connected, any potential difference between these grounds could

damage the connected components. To avoid issues with interference, ground loops, or

damage to external equipment, ensure that all connected devices share the same ground

reference or use systems with appropriate isolation.

Recommendations:

● Connection Review: Verify that all ground connections are properly made and that

there are no significant potential differences between them.

● Use of Isolation: Consider using galvanic isolators or isolation transformers if it is

necessary to connect equipment with different ground references.
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4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C

language. They can also be programmed using directly C but it is much easier working with

Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no

needed to define the pins and if that pins are inputs or outputs. Everything is set up

automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

3. Press OK to save the changes.
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4. Go to: Tools -> Board:… -> Boards Manager

5. Search for “industrialshields” on the browser.
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

Once it is selected M-Duino Family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

Also there are some examples of programming in File -> Examples -> M-Duino Family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/Industrial-Shields/

20
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5 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
M-Duino 58 I/Os PLUS uses USB-B cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> M-Duino Family

21
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- Select the correct M-Duino Board (M-Duino 58+).

- Select the correct port.
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6 How to connect PLC to power supply

- M-Duino 58 I/Os PLUS PLC is 12-24Vdc supplied. IMPORTANT: The polarity IS NOT

REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail:

-12Vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel operation,

overvoltage protection, and overcurrent protection. There is

a LED inductor for power status, the power supply is certified

according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types

of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the

equipment must be separated from the dangerous voltage cables.
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7 M-Duino 58 I/Os PLUS Pinout

7.1 A Zone connection

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any device.

24

Base
(common unit)

A Zone

M-Duino
Connector

Arduino
Pin Function

SCL
SDA
RX0
TX0
RX1
TX1
TX
RX
Z-
Y+
B-
A+
PIN3
50 SO
51 SI

52 SCK
Reset
Vin5
PIN2
GND
GND
24Vdc

21
20
1
0
19
18
16
17
-
-
-
-
3
50
51
52

Reset
Vin5
2
-
-

I2C/SS
I2C/SS
RX0/SS
TX0/SS
RX1/SS
TX1/SS

RX2(serial 2)
TX2(serial 2)

RS485
RS485
RS485
RS485

Arduino Pin
SPI
SPI
SPI
SPI
5V

Arduino Pin
Gnd
Gnd

Power Supply

Base
(common unit)

A Zone

M-Duino
Connector

Arduino
Pin Function

AREF
IOREF2
IOREF1
7Vdc
GND
3.3Vdc
GND
5Vdc
GND

AREF
IOREF2
IOREF1
7Vdc
GND
3.3Vdc
GND
5Vdc
GND

Arduino PIN
Arduino PIN
Arduino PIN

-
GND

Arduino PIN
GND
-

GND
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*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using
serial communication. When uploading code to Arduino Mega set switch to ON.
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7.2 B Zone (Analog Shield)

1 See section 8 to select suitable switch configuration to enable these connections.
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B Zone

M-Duino
Connector

Arduino
Pin

Function

I0.12
I0.11
I0.10
I0.9
I0.8
I0.7

(-)I0.6/INT1
I0.6/INT11

(-)I0.5/INT0
I0.5/INT01

(-)I0.4
I0.4

(-)I0.3
I0.3

(-)I0.2
I0.2

(-)I0.1
I0.1

(-)I0.0
I0.0

59
58
57
56
55
54
-
3
-
2
-
26
-
25
-
24
-
23
-
22

Analog/ Digital In
Analog/ Digital In
Analog/ Digital In
Analog/ Digital In
Analog/ Digital In
Analog/ Digital In

GND I0.6
Interrupt 1 In

GND I0.5
Interrupt 0 In

GND I0.4
Digital Input
GND I0.3

Digital Input
GND I0.2

Digital Input
GND I0.1

Digital Input
GND I0.0

Digital Input

B Zone

M-Duino
Connector

Arduino
Pin

Function

GND
A0.71

A0.61

A0.51

Q/Vdc
COM(-)
Q0.71

Q0.61

Q0.51

Q0.4
Q0.3
Q0.2
Q0.1
Q0.0

GND
6
5
4
-
-
6
5
4
40
39
38
37
36

GND
Analog Out
Analog Out
Analog Out

External Isolated Out Vdc
External Isolated Out GND

Digital/PWM Out
Digital/PWM Out
Digital/PWM Out

Digital Out
Digital Out
Digital Out
Digital Out
Digital Out
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7.3 C Zone connection

See section 8 to select suitable switch configuration to enable these connections.
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C Zone

M-Duino
Connector

Arduino
Pin

Function

I1.12
I1.11
I1.10
I1.9
I1.8
I1.7

(-)I1.6/INT1
I1.6/INT11

(-)I1.5/INT0
I1.5/INT01

(-)I1.4
I1.4

(-)I1.3
I1.3

(-)I1.2
I1.2

(-)I1.1
I1.1

(-)I1.0
I1.0

65
64
63
62
61
60
-
19
-
18
-
31
-
30
-
29
-
28
-
27

Analog/ Digital In
Analog/ Digital In
Analog/ Digital In
Analog/ Digital In
Analog/ Digital In
Analog/ Digital In

GND I1.6
Interrupt 1 In

GND I1.5
Interrupt 0 In

GND I1.4
Digital Input
GND I1.3

Digital Input
GND I1.2

Digital Input
GND I1.1

Digital Input
GND I1.0

Digital Input

C Zone

M-Duino
Connector

Arduino
Pin

Function

GND
A1.71

A1.61

A1.51

Q/Vdc
COM(-)
Q1.71

Q1.61

Q1.51

Q1.4
Q1.3
Q1.2
Q1.1
Q1.0

GND
7
9
8
-
-
7
9
8
45
44
43
42
41

GND
Analog Out
Analog Out
Analog Out

External Isolated Out Vdc
External Isolated Out GND

Digital/PWM Out
Digital/PWM Out
Digital/PWM Out

Digital Out
Digital Out
Digital Out
Digital Out
Digital Out
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7.4 D Zone connection

See section 8 to select suitable switch configuration to enable these connections.
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D Zone

M-Duino
Connector

Arduino
Pin

Function

I2.12
I2.11
I2.10
I2.9
I2.8
I2.7

(-)I2.6/INT1
I2.6/INT11

(-)I2.5/INT0
I2.5/INT01

(-)I2.4
I2.4

(-)I2.3
I2.3

(-)I2.2
I2.2

(-)I2.1
I2.1

(-)I2.0
I2.0

NC
NC
69
68
67
66
-
21
-
20
NC
NC
-
35
-
34
-
33
-
32

NC
NC

Analog/ Digital In
Analog/ Digital In
Analog/ Digital In
Analog/ Digital In

GND I2.6
Interrupt 1 In

GND I2.5
Interrupt 0 In

NC
NC

GND I2.3
Digital Input
GND I2.2

Digital Input
GND I2.1

Digital Input
GND I2.0

Digital Input

D Zone

M-Duino
Connector

Arduino
Pin

Function

GND
A2.7
A2.61

A2.51

Q/Vdc
COM(-)
Q2.7
Q2.61

Q2.51

Q2.4
Q2.3
Q2.2
Q2.1
Q2.0

GND
NC
13
12
-
-
NC
13
12
NC
49
48
47
53

GND
-

Analog Out
Analog Out

External Isolated Out Vdc
External Isolated Out GND

-
Digital/PWM Out
Digital/PWM Out

-
Digital Out
Digital Out
Digital Out
Digital Out
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8 Switch Configuration

8.1 A Zone: Communications

4. SCL/I2.6: Choosing between SCL or the input I2.6. If this switch is ON, it enables the I2.6

input and disables the SCL. If this switch is OFF, it enables SCL and disables I2.6.

3. SDA/I2.5: Choosing between SDA or the input I2.5. If this switch is ON, it enables the I2.5

input and disables the SDA. If this switch is OFF, it enables SDA and disables I2.5.

2. RX1/I1.6: Choosing between RX1 or the input I1.6. If this switch is ON, it enables the I1.6

input and disables the RX1. If this switch is OFF, it enables RX1 and disables I1.6.

1. TX1/I1.5: Choosing between TX1 or the input I1.5. If this switch is ON, it enables the I1.5

input and disables the TX1. If this switch is OFF, it enables TX1 and disables I1.5.

29

LEFT ZONE
Switch Analog Shield

ON OFF
D ZONE

SCL/I2.6 I2.6 SCL
SDA/I2.5 I2.5 SDA

C ZONE
RX1/I1.6 I1.6 RX1
TX1/I1.5 I1.5 TX1

B ZONE
Pin 3/I0.6 I0.6 Pin 3
Pin 2/I0.5 I0.5 Pin 2

uSD & RS-485
D53(SD) Q2.0 SD

FD RS-485 HD HD FD
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4. Pin 3/I0.6: Choosing between Pin 3 or the input I0.6. If this switch is ON, it enables the I0.6

input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables I0.6.

3. Pin 2/I0.5: Choosing between Pin 2 or the input I0.5. If this switch is ON, it enables the I0.5

input and disables the Pin 2. If this switch is OFF, it enables Pin 2 and disables I0.5.

2. D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket and disables

Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD

can’t be used.

1. FD RS-485 HD: Choosing between FD or HF. If this switch is ON, it enables the Half Duplex

(HD) option and disables the FD. If this switch is OFF, it enables Full Duplex (FD) and disables

HD.

1. RTC SDA: This switch enables the communication to communicate with the RTC using I2C.

Having this switch in ON mode activates this communication, whereas if it is in OFF mode it

disables the I2C to reach the RTC.

2. RTC SCL: This switch enables the communication to communicate with the RTC using I2C.

Having this switch in ON mode activates this communication, whereas if it is in OFF mode it

disables the I2C to reach the RTC.

3. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in ON

mode or OFF mode.

4. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in ON

mode or OFF mode.
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LEFT ZONE
SWITCH ON OFF

NC - -
NC - -

RTC SCL RTC -
RTC SDA RTC -
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8.2 B, C & D Zone Switches

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF

it can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide

this analog output is represented with AX.X, being X any number of the tables above.
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B ZONE C ZONE D ZONE
SWITCH ON OFF SWITCH ON OFF SWITCH ON OFF

NC - - NC - - NC - -
Q0.7 Q0.7 A0.7 Q1.7 Q1.7 A1.7 Q2.7 Q2.7 A2.7
Q0.6 Q0.6 A0.6 Q1.6 Q1.6 A1.6 Q2.6 Q2.6 A2.6
Q0.5 Q0.5 A0.5 Q1.5 Q1.5 A1.5 Q2.5 Q2.5 A2.5
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9 M-Duino Arduino I/Os 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed

according to Arduino features such as I/Os operating at 5V or any additional features present in

the pins (for example I2C communication in pins SCL and SDA). As this pins are directly

connected to the Arduino Mega board they are not as well protect as the normal inputs. These

pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarized in the table below. In order to access some of

these pins the configuration switch must be set to OFF position (see section 8) and some extra

considerations must be taken in consideration when using these pins.

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.

These terminals provide direct access to the Mega board.

A part from the switch configuration there are some special conditions depending on these 5V.

Now it is going to be shown the considerations to operate with these pins.

9.1 I2C pins – SDA/SCL

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it

reads 5V when nothing is connected. The pull-up configuration is stablished by default in these

pins.

If it is meant to work them as a GPIO at 5V, it has to be considered that they are pull-up inputs.

*IMPORTANT: I2.5 & I2.6 are not pull-up inputs although they are referred to the I2C pins

(switch configuration). There is a “reverse pull-up circuit “that is stablished in order to have the

same behaviour as the other inputs.

9.2 Serial 0 – RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in

case that all the 5V pins are already performing a function. This is because they are shared with

the USB interface. If using these pins, the USB communication cannot be working at the same

time. When the PLC is not installed, the USB communication is normally required for
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M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TX0 1
RX1 19 Communication switch: OFF
TX1 18 Communication switch: OFF
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF
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debugging, uploading and intercommunicating with the Ethernet controller. If using both

interfaces at the same time the Arduino board will get blocked.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be stablished an external pull-up or pull-down circuit in order to correctly work with

these pins.

9.3 Serial 1 – RX1/TX1

These pins are only referred to the inputs I1.5/I1.6. If the switch configuration is in OFF position

the pins RX1/TX1 will be available. If not using the Serial 1 interface these pins can work as

digital, either input or output.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be stablished an external pull-up or pull-down circuit in order to correctly work with

these pins.

9.4 SPI – MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the

Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours

cannot happen at the same time as the Ethernet would not work.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be stablished an external pull-up or pull-down circuit in order to correctly work with

these pins.

9.5 Pin 2/Pin 3

These pins are only referred to the inputs I0.5/I0.6. If the switch configuration is in OFF position

the pins Pin 2/Pin 3 will be available.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be stablished an external pull-up or pull-down circuit in order to correctly work with

these pins.
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10 A Zone Features: Communications & RTC & uSD

10.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16

and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not

matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232

implementation.

10.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this

communication. The RS-485 protocol will be always enabled, the only switch that affects is the

one called “FD rs-485 HD” (See Section 8). This switch makes the choice between RS-485 Half

Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485

implementation.

10.3 I2C

I2C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino 58 I/Os PLUS. The

pull-up resistor is already implemented in the PCB.

I2C communication is configured by switches, so the switches must be configured in order to

enable the I2C communication.

34

Switch ON OFF
D ZONE

SCL/I2.6 I2.6 SCL
SDA/I2.5 I2.5 SDA
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To enable I2C the switches SCL/I2.6 & SDA/I2.5 must be set to OFF mode. In this mode the

inputs are totally disabled and the I2C is now enabled.

Industrial Shields does not provide any library to implement the I2C as it can be used with the

standard library of Arduino called Wire.

10.4 SPI

The M-Duino pins used for the SPI bus are summarized in the table below. For SPI bus MISO,

MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,

each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 51 SI 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 21/20/1/0/19/18/15/14/2/3

Check the switch configuration at section 8 to enable SS pins.

10.5 TTL

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTL0 is accessed with the function Serial (pins 0

and 1 of the Arduino Mega). TTL1 is accessed with the function Serial1 (pins 18 and 19 of the

Arduino Mega).

In order to use the TTL pins the configuration of the switches have to be the following one:

If the switches RX1/I1.6(I1.1) & TX1/I1.5(I1.0) are in OFF mode, the RX1/TX1 will be enabled. In

order to use TTL3 these switches must be in OFF mode.

10.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with

Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the

M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino

Mega pin 10).
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Switch Analog Shield
ON OFF

C ZONE
RX1/I1.6 I1.6 RX1
TX1/I1.5 I1.5 TX1



Ref. IS.MDUINO.58+ Rev. 3: 12-12-2024

10.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the I2C protocol

communication, so it is required to have enabled the I2C protocol.

4 switches have to be configured in order to enable the RTC features:

RTC SCL & RTC SDA must be set to ON mode to enable

the I2C wires to the RTC. If they are in OFF mode, the

Arduino won’t communicate with the RTC.

I2C (SCL, SDA pins) must be enabled in order to

communicate with the RTC. See section 11 I2C to

enable it.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation

called RTC.

10.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol

is always enabled, as there are no switches that configure it. However, there is a switch that

must be placed to ON mode in order to communicate with the uSD:

D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket and disables

Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD

can’t be used.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of

the PLC, it is required to open the plastic found in the frontal part and the socket is located

under the supply of the Arduino.
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LEFT ZONE
SWITCH ON OFF

NC - -
NC - -

RTC SCL RTC -
RTC SDA RTC -

Switch
ON OFF

SCL/I2.6 I2.6 SCL
SDA/I2.5 I2.5 SDA

LEFT ZONE
Switch

ON OFF
uSD

D53(SD) Q2.0 D53(SD)
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Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation

called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to

select the Chip Select of the uSD chip.

Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the

operation of an online process or machine. Unexpected operation of a process or machine

could result in death or injury to personnel and/or property damage. Before inserting a

memory card, always ensure that the CPU is offline and in a safe state.

Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la

carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le

fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un

processus ou d'une machine peut entraîner la mort ou des blessures corporelles et / ou des

dégâts matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors

ligne et en sécurité.
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11 Instructions for interconnection between Industrial

Shields controllers

11.1 RS-232 Communication:

11.2 RS-485 Communication:

11.2.1.1 Half Duplex

11.2.2 Full Duplex
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11.3 Ethernet

For Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.
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12 I/O technical details

Digital Output Waveform:

Digital Out-put Turn-off:

PWM Waveform:
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Analog Out Turn On:

Analog Out Turn-Off:

Analog /Digital input Turn-on:
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13 Typical Connections
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14 Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT – 1963502 from

Phoenix contact. MC0,5/10-G-2,5THT

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix

contact. FK-MC 0,5/10-ST-2,5

Connection details:

47

Article reference MC 0,5/10-G-2,5

THT

Height 8,1mm

Pitch 2,5mm

Dimension 22,5mm

Pin dimensions 0,8x0,8mm

Pin spacing 2,50mm

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm²

Rigid conduit section max. 0,5 mm²

Flexible conduit section min. 0,14 mm²

Flexible conduit section max. 0,5 mm²

Conduit section AWG/kcmil min. 26

Conduit section AWG/kcmil max. 20

https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General
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15 Mechanical Characteristics

- Dimension M-Duino 58 I/Os PLUS:

- DIN Rail mounting

For optimal operation of the product, it must be located in an electrical cabinet with IK08
mechanical protection. The minimum IP protection degree required is IP56.
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16 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause a misact.

- Use shielded twisted pairs for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino 58 I/Os PLUS from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino 58 I/Os PLUS. When configuring the layout of the M-Duino 58 I/Os PLUS inside
your panel, consider the heat-generating devices and locate the electronic-type devices in
the cooler areas of your cabinet. Reducing the exposure to a high-temperature
environment will extend the operating life of any electronic device. Consider also the
routing of the wiring for the devices in the electric cabinet. Avoid placing low-voltage signal
wires and communications cables in the same tray with AC power wiring and high energy,
rapidly-switched DC wiring.

49



Ref. IS.MDUINO.58+ Rev. 3: 12-12-2024

Provide adequate clearance for cooling and wiring M-Duino 58 I/Os PLUS. It is designed for
natural convection cooling. For proper cooling, you must provide a clearance of at least 25
cm above and below the devices. Also, allow at least 25 cm of depth between the front of
the modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid-filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.
Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess
temperature.
- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.
- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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17 Revision Table

Revision Number Date Changes

0 30/08/2019 First implementation

1 21/02/2020 ETL Listing Mark-Direct

2 12/01/2022 Updated CE Normative (2004/108/EC)

3 12/12/2024 Added section 3.4 (“Isolation Precautions”)
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About Industrial Shields:

Direction: Fàbrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruitós de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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Preface

This User Guide has been implemented by Boot & Work, S.L. working

under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

● Persons in charge of introducing automation devices.

● Persons who design automation systems.

● Persons who install or connect automation devices.

● Persons who manage working automation installation.

Warnings:

● Unused pins should not be connected. Ignoring the directive may damage the

controller.

● Improper use of this product may severely damage the controller.

● Refer to the controller’s User Guide regarding wiring considerations.

● Before using this product, it is the responsibility of the user to read the product’s User

Guide and all accompanying documentation.

● Maintenance must be performed by qualified personnel familiarised with the

construction, operation, and hazards involved with the control.

● Maintenance should be performed with the control out of operation and disconnected

from all sources of power.

● Care should be taken when servicing electrostatic sensitive components. The

manufacturer's recommendations for these components should be followed.
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● The M-Duino Family PLCs are Open Type Controllers. It is required that you install the

M-Duino PLC in a housing, cabinet, or electric control room. Entry to the housing,

cabinet, or electric control room should be limited to authorised personnel. Failure to

follow these installation requirements could result in severe personal injury and/or

property damage. Always follow these requirements when installing M-Duino family

PLCs.

● In case of installation or maintenance of the M-Duino please follow the instructions

marked in the Installation and Maintenance section.

● Do not disconnect equipment when a flammable or combustible atmosphere is

present. Disconnection of equipment when a flammable or combustible atmosphere is

present may cause a fire or explosion which could result in death, serious injury and/or

property damage.

Avertissements:

● Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut

endommager le contrôleur.

● Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur.

● Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de

câblage.

● Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du

produit et la documentation qui l’accompagne.

● La maintenance doit être effectuée par personnel qualifié familiarisé avec la

fabrication, le fonctionnement et les dangers liés au contrôleur.

● La maintenance doit être effectuée avec l’équipement hors service et déconnectée de

toutes les sources d'alimentation.

● Faites attention lors de l'entretien des composants sensibles à l'électricité statique. Les

recommandations du fabricant pour ces composants doivent être suivies.

● Les automates de la famille M-Duino sont des contrôleurs de type ouvert. Il est

nécessaire d'installer l'automate M-Duino dans un boîtier, une armoire ou une salle de

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences

d'installation peut entraîner des blessures graves et/ou des dommages matériels

importants. Respectez toujours ces exigences lors de l'installation des automates de la

famille M-Duino.

● En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions

indiquées dans la section Installation et Maintenance.

● Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou

combustible. La déconnexion de l'équipement en présence d'une atmosphère

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant

entraîner la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and understand this manual

Please read and understand this manual before using the product. Please consult your

comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT

BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF

PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING

THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE

INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND

INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or

standards that apply to the combination of products in the customer’s application or use of the

product.

The following are some examples of applications for which particular attention must be given.

This is not intended to be an exhaustive list of all possible uses of the products, nor is it

intended to imply that the uses may be suitable for the products:

● Systems, machines, and equipment that could present a risk to life or property.

● Nuclear energy control systems, combustion systems, railroad systems, aviation

systems, medical equipment, amusement machines, vehicles, safety equipment, and

installation subject to separate industry or government regulations.

● Outdoor use, uses involving potential chemical contamination or electrical

interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification

documents identifying ratings and limitations of use that apply to the products. This

information by itself is not sufficient for a complete determination of the suitability of the

products in combination with the system, machine, end product, or other application or use.
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Intended use of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the

catalogue and the associated technical documentation. If third-party products and components

are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,

installation, assembly, operation and maintenance have been carried out in a correct manner. It

must respect the permissible ambient conditions. You should also follow the indications and

warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated

by qualified personnel for the task entrusted and observing what is indicated in the

documentation corresponding to it, particularly the safety instructions and warnings included

in it. Due to their training and experience, qualified personnel are in a position to recognize

risks resulting from the handling or manipulation of such products / systems and to avoid

possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even

when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining

suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL

SHIELDS’s test conditions, and the users most correlate it to actual application requirements.

Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.

Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;

however, no responsibility is assumed for clerical, typographical, or proofreading errors, or

omissions.

Residual risks

The control and drive components of an Industrial Shields PLC are approved for industrial and

commercial use in industrial line supplies. Their use in public line supplies requires a different

configuration and/or additional measures. These components may only be operated in closed

housings or in higher-level control cabinets with protective covers that are closed, and when all

of the protective devices are used. These components may only be handled by qualified and
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trained technical personnel who are knowledgeable and observe all of the safety information

and instructions on the components and in the associated technical user documentation.

When carrying out a risk assessment of a machine in accordance with the EU Machinery

Directive, the machine manufacturer must consider the following residual risks associated with

the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,

maintenance, and repairs caused by, for example: − Hardware defects and/or software errors in

the sensors, controllers, actuators, and connection technology − Response times of the

controller and drive − Operating and/or ambient conditions not within the scope of the

specification − Condensation / conductive contamination − Parameterization, programming,

cabling, and installation errors − Use of radio devices / cellular phones in the immediate

vicinity of the controller − External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for

example: − Component malfunctions − Software errors − Operating and/or ambient

conditions not within the scope of the specification − External influences / damage.

3. Hazardous shock voltages caused by, for example: − Component malfunctions − Influence of

electrostatic charging − Induction of voltages in moving motors − Operating and/or ambient

conditions not within the scope of the specification − Condensation / conductive

contamination − External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to

people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the

system and/or failure to dispose of components safely and correctly.

Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials

and workmanship for a period of one year (or other period if specified) from date of sale by

Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,

REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE

OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR

INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR

IMPLIED
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Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL

DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE

PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR

STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER

CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT

THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT

SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

Recognized
Component ETL Classified

Conforms to:
UL Std. 61010-1
UL Std. 61010-2-201
Cert. To CSA Std. C22.2 No. 61010-1
Cert. ToCSA Std. C22.2 No.61010-2-201

Place for control
number:
5016476
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1 General Description M-DUINO product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is important

to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from

below and D the shield from above. Having a B and a C in the middle of them.

● The inputs in the zone B are named I0.X, being X any number suitable in the Shield.
Outputs are named as Q0.X and relays as R0.X

● The inputs in the zone C are named I1.X, being X any number suitable in the Shield.
Outputs are named as Q1.X and relays as R1.X

● The inputs in the zone D are named I2.X, being X any number suitable in the Shield.
Outputs are named as Q2.X and relays as R2.X
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1.2 Reference table

Reference Table

Model Reference

PLC M-Duino General Family

M-Duino PLC Arduino Ethernet 19R I/Os Analog / Digital Plus IS.MDUINO.19R+

M-Duino PLC Arduino Ethernet 21 I/Os Analog / Digital Plus IS.MDUINO.21+

M-Duino PLC Arduino Ethernet 38AR I/Os Analog / Digital Plus IS.MDUINO.38AR+

M-Duino PLC Arduino Ethernet 38R I/Os Analog / Digital Plus IS.MDUINO.38R+

M-Duino PLC Arduino Ethernet 42 I/Os Analog / Digital Plus IS.MDUINO.42+

M-Duino PLC Arduino Ethernet 50RRA I/Os Analog / Digital Plus IS.MDUINO.50RRA+

M-Duino PLC Arduino Ethernet 53ARR I/Os Analog / Digital Plus IS.MDUINO.53ARR+

M-Duino PLC Arduino Ethernet 54ARA I/Os Analog / Digital Plus IS.MDUINO.54ARA+

M-Duino PLC Arduino Ethernet 57AAR I/Os Analog / Digital Plus IS.MDUINO.57AAR+

M-Duino PLC Arduino Ethernet 57R I/Os Analog / Digital Plus IS.MDUINO.57R+

M-Duino PLC Arduino Ethernet 58 I/Os Analog / Digital Plus IS.MDUINO.58+

To find the reference of your M-Duino PLC, check the arrow in the picture below. In the

example, the reference is: IS.MDUINO.58+
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1.3 Zones Table

Zones Table

Model Zone A Zone B Zone C Zone D

M-Duino PLC 19R+ ✔ Relay - -

M-Duino PLC 21+ ✔ Analog / Digital - -

M-Duino PLC 38AR+ ✔ Analog / Digital Relay -

M-Duino PLC 38R+ ✔ Relay Relay -

M-Duino PLC 42+ ✔ Analog / Digital Analog / Digital -

M-Duino PLC 50RRA+ ✔ Relay Relay Analog / Digital

M-Duino PLC 53ARR+ ✔ Analog / Digital Relay Relay

M-Duino PLC 54ARA+ ✔ Analog / Digital Relay Analog / Digital

M-Duino PLC 57AAR+ ✔ Analog / Digital Analog / Digital Relay

M-Duino PLC 57R+ ✔ Relay Relay Relay

M-Duino PLC 58+ ✔ Analog / Digital Analog / Digital Analog / Digital

The distribution of the different features that provide the M-Duino PLC Family is the following

one:

Shield B Zone C Zone D Zone

Analog Shield

13 Inputs
(13 Digital Inputs, 6
of which can work as

Analog Input)

8 Outputs
(8 Digital Outputs, 3
of which can work as

Analog Output)

13 Inputs
(13 Digital Inputs, 6
of which can work as

Analog Input)

8 Outputs
(8 Digital Outputs, 3
of which can work as

Analog Output)

10 Inputs
(10 Digital Inputs, 4
of which can work as

Analog Input)

6 Outputs
(6 Digital Outputs, 2
of which can work as

Analog Outputs)

Relay Shield

6 inputs
(6 Digital Inputs, 4 of
which can work as

Analog Input)

3 Outputs
(3 Digital Outputs, 3
of which can work as

Analog Output)

8 Relays

6 inputs
(6 Digital Inputs, 4 of
which can work as

Analog Input)

3 Outputs
(3 Digital Outputs, 3
of which can work as

Analog Output)

8 Relays

6 inputs
(6 Digital Inputs, 4 of
which can work as

Analog Input)

2 Outputs
(2 Digital Outputs, 2
of which can work as

Analog Output)

7 Relays
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1.4 A Zone Features

Shield A Zone

Communication

Shield

(1x) Ethernet

(1x) USB

(1x) I2C

(2x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485

(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) Width (mm) Depth (mm) Max weight (g)

M-Duino PLC 19R+ 119.5 70.1 101 378

M-Duino PLC 21+ 119.5 70.1 101 378

M-Duino PLC 38AR+ 119.5 94.7 101 488

M-Duino PLC 38R+ 119.5 94.7 101 488

M-Duino PLC 42+ 119.5 94.7 101 488

M-Duino PLC 50RRA+ 119.5 119.3 101 598

M-Duino PLC 53ARR+ 119.5 119.3 101 598

M-Duino PLC 54ARA+ 119.5 119.3 101 598

M-Duino PLC 57AAR+ 119.5 119.3 101 598

M-Duino PLC 57R+ 119.5 119.3 101 598

M-Duino PLC 58+ 119.5 119.3 101 598
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1.6 General Features

CONNECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE Controller General Specifications Information

Input Voltage
12 to 24Vdc

Fuse protection (2.5A)
Polarity protection

Input rated voltage
24Vdc

Rated Power 30W

I max. 1.5A

Size Check size and weight table

Clock Speed 16MHz

Flash Memory 256KB of which 8KB used by bootloader

SRAM 8KB

EEPROM 4KB

Communications
I2C – Ethernet Port – USB – RS485 – RS232 – SPI –

SerialTTL (x2)
Max232-Max485-W5500

USB consideration!
Only meant for uploading or debugging, not always

connected as a serial in a project!
Cannot be working in a final

application

An/Dig Input 10bit
(0-10Vcc)

0 to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vdc

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation

Rated Voltage: 24Vdc

Max read time: 116 us

*Check Section 13 for digital
inputs threshold detection

Digital Isolated Input
(24Vcc)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation

Rated Voltage: 24Vdc

All Digital Inputs are PNP .
Click here1 for more information.

Max read time: 8 us

* Interrupt isolated Input
HS (24Vcc)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation

Rated Voltage: 24Vdc
Max read time: 8 us

Analog Output 8bit
(0-10Vcc)

0 to 10Vdc
I max: 20 mA

Separated PCB ground
Rated Voltage: 10Vdc

Output frequency: 2Hz

Rising edge time: 150 ms
Falling edge time: 252 ms

Digital Isolated Output
(24Vcc)

5 to 24Vdc
I max: 70 mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

With 70 us delay,
freq is 6.849 kHz

with pulse width of 106 us

Rising edge time: 476 ns
Falling edge time: 42.8 us

1 https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193
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Digital Isolated Output
Relay

30Vdc / 250Vac
Galvanic Isolation

Diode protected for Relay
Imax: 3A (30Vdc)
Imax: 5A (250Vac)

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70 mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Direct Arduino Pin
Output

0 to 5Vdc
I max: 40 mA

Rated Voltage: 5Vdc

Max frequency: 77kHz

Rising edge time: 200 ns
Falling edge time: 200 ns

Direct Arduino Pin
Input

0 to 5Vdc
I max: 40 mA

Rated Voltage: 5Vdc
Max read time: 8 us

I2C Pin
5V Internal Pull-up

Max frequency: 100 kHz
Rising edge time: 10 us
Falling edge time: 150 ns

One-Wire Pin
Usable pins:

Pin 2, Pin3, SCL, SDA, RX0, TX0,
RX1, TX1, MISO, MOSI, SCK

Frequency: 800 kHz

Expandability I2C - 127 elements - Serial Port RS232/RS485

* By using this type of signal it can no longer be used as Digital signal
(24Vdc)
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1.7 Power consumption of the M-Duino Family PLCs

Model Current resting
(mA)

Power resting
(W)

Current active
(mA)

Power active
(W)

21+ 99 2,376 120 2,88

42+ 92 2,208 128 3,072

58+ 76 1,824 126 3,024

19R+ 80 1,92 202 4,848

38R+ 77 1,848 313 7,512

57R+ 73 1,752 425 10,2

38AR+ 72 1,728 221 5,304

53ARR+ 71 1,704 323 7,752

57AAR+ 71 1,704 221 5,304

54ARA+ 76 1,824 231 5,544

50RRA+ 82 1,968 322 7,728

The power consumption is measured at 24Vdc.

The current resting column denotes the minimum current drawn by the PLC when all outputs
are at a LOW level, representing the PLC's baseline power consumption.

In contrast, the current active column reflects the current drawn by the PLC when all outputs
are at a HIGH level, and there are no connections to any of the outputs. While this value is not
the absolute maximum the Arduino based PLC can draw, it serves as a reference point for
expected current values.

It's important to note that the practical maximum current may vary depending on the type of
actuators connected to the outputs and the number of I/Os used. The actual consumption can
be influenced by the specific configuration and load connected to the PLC's outputs."
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2 Technical Specifications:

2.1 General Specifications:

Item M-Duino Family PLC

Power supply
voltage

DC power supply 12 to 24Vdc

Operating
voltage range

DC power supply 11.4 to 25.4Vdc

Power
consumption

DC power supply 30W max.

External power
supply

requirements

Power supply
voltage

24Vdc

Power supply
minimum output

capacity
700mA

Insulation resistance 20MΩmin.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength
2.300Vac at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the external
AC terminals and the protective ground terminal.

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each.

Ambient temperature (operating) 0º to 60ºC

Ambient humidity (operating) 10% to 90% (no condensation)

Ambient environment (operating) With no corrosive gas

Ambient temperature (storage) -20º to 60ºC

Power supply holding time 2ms min.

Weight Check size and weight table

2.2 Performance Specification:

Arduino Board ARDUINO MEGA 2560

Control method Stored program method

I/O control method Combination of the cyclic scan and immediate refresh processing methods.

Programming language
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega2560

Flash Memory 256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB

EEPROM 4KB

Clock Speed 16MHz
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2.3 Symbology

Table that includes all the symbology that is used in the serigraph of the M-Duino PLC Family:

Symbol
Standard No. /
Standard Title

Standard Reference
No. / Symbol Title

Symbol Meaning

IEC 60417 /
Graphical symbols

for use on
equipment

5031 / Direct
Current

Indicates that the equipment is
suitable for direct current only; to

identify relevant terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5032 / Alternating
Current

Indicates that the equipment is
suitable for alternating current

only; to identify relevant
terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5130 / Pulse General
To identify the control by which a

pulse is started.

IEC 60417 /
Graphical symbols

for use on
equipment

5017 / Earth,
Ground

To identify an earth (ground)
terminal in cases where neither
the symbol 5018 nor 5019 is

explicitly required.

IEC 60417 /
Graphical symbols

for use on
equipment

5115 / Signal lamp
To identify the switch by means
of which the signal lamp(s) is

(are) switched on or off.

2004/108/EC /
Electromagnetic
Compatibility

CE Marking
CE marking indicates that a

product complies with applicable
European Union regulations

ISO 7000/ Graphical
symbols for use on

equipment

0434B /
Warning symbol

Indicates a potentially hazardous
situation which, if not avoided,
could result in death or serious

injury

ISO 7000/ Graphical
symbols for use on

equipment

5036 / Dangerous
Voltage

To indicate hazards arising from
dangerous voltages
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3 Precautions

Read this manual before attempting to use any of the M-Duino PLC Family and follow its
descriptions for reference during operation.

3.1 Arduino Board

The M-Duino Family PLCs include an Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, who must have knowledge on electrical systems.

3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in

this manual. Before using M-Duino under different conditions from what has been specified in

this manual or integrating M-Duino to nuclear control systems, railroad systems, aviation

systems, vehicles, combustion systems, medical equipment, amusement machines, safety

equipment and other systems, machines, and equipment that may have a serious influence on

lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure

that the rating and performance characteristics of M-Duino are sufficient for the systems,

machines, and equipment, and be sure to provide the systems, machines, and equipment

double safety mechanisms. This manual provides information for programming and operating

the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different

systems. This means that if an external device or sensor that shares the same ground reference

(GND) with the system is connected, any potential difference between these grounds could

damage the connected components. To avoid issues with interference, ground loops, or

damage to external equipment, ensure that all connected devices share the same ground

reference or use systems with appropriate isolation.

Recommendations:

● Connection Review: Verify that all ground connections are properly made and that

there are no significant potential differences between them.

● Use of Isolation: Consider using galvanic isolators or isolation transformers if it is

necessary to connect equipment with different ground references.
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4 M-Duino Pinout

IOs Table

Model Reference
Analog

Input*¹

Digital Isolated

Input

Digital Isolated

Output

Digital/Analog

Output

Relay

Output

PWM Isolated

Output*²

19R+ IS.MDUINO.19R+ 4 2 0 3 8 3

21+ IS.MDUINO.21+ 6 7 5 3 0 3

38AR+ IS.MDUINO.38AR+ 10 9 5 6 8 6

38R+ IS.MDUINO.38R+ 8 4 0 6 16 6

42+ IS.MDUINO.42+ 12 14 10 6 0 6

50RRA+ IS.MDUINO.50RRA+ 12 10 4 8 16 8

53ARR+ IS.MDUINO.53ARR+ 14 11 5 8 15 8

54ARA+ IS.MDUINO.54ARA+ 14 15 9 8 8 8

57AAR+ IS.MDUINO.57AAR+ 16 16 10 8 7 8

57R+ IS.MDUINO.57R+ 12 6 0 8 23 8

58+ IS.MDUINO.58+ 16 20 14 8 0 8

*¹ The analog inputs can also be used as digital inputs.

*² The PWM isolated outputs can also be used as digital isolated outputs. The associated PWM

and analog outputs cannot be used at the same time (check switch configuration).
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5 Serigraphy

5.1 A Zone connection (Communications)

Base

A Zone

M-Duino
Connector

Arduino
Pin

Function

AREF
SQW

-
3.3Vdc
5Vdc
GND

AREF
SQW

-
3.3Vdc
5Vdc
GND

Arduino Pin
Arduino Pin

-
Arduino Pin

-
GND

Base

A Zone

M-Duino
Connector

Arduino
Pin

Function

SCL
SDA
RX0
TX0
RX1
TX1
TX
RX
Z-
Y+
B-
A+

PIN3
50 SO
51 SI
52 SCK
Reset
5Vdc
PIN2
GND
GND
Vdc

21
20
0
1
19
18
16
17
-
-
-
-
3
50
51
52

Reset
5Vdc
2
-
-

I2C/SS
I2C/SS
RX0/SS
TX0/SS
RX1/SS
TX1/SS
RS232
RS232
RS485
RS485
RS485
RS485

Arduino Pin
SPI
SPI
SPI
SPI
5V

Arduino Pin
Gnd

Gnd (Power Supply)
Vdc (Power Supply)

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any

device.
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Ethernet Reset USB-B

RTC Programmable button
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5.2 Analog/Digital Zone connection (I/Os)

X Zone

M-Duino
Connector

Function

IX.12
IX.11
IX.10
IX.9
IX.8
IX.7

(-)IX.6
IX.6/INT2

(-)IX.5
IX.5/INT1

(-)IX.4
IX.4

(-)IX.3
IX.3

(-)IX.2
IX.2

(-)IX.1
IX.1

(-)IX.0
IX.0

Analog/Digital In*
Analog/Digital In*
Analog/Digital In
Analog/Digital In
Analog/Digital In
Analog/Digital In

GND IX.6
Interrupt X In

GND IX.5
Interrupt X In
GND IX.4*

Digital Input*
GND IX.3

Digital Input
GND IX.2

Digital Input
GND IX.1

Digital Input
GND IX.0

Digital Input

*Connectors IX.12, IX.11 and IX.4 are not connected (NC) in D Zone.

Top Zone

Led indicator I/Os state

X Zone

M-Duino
Connector

Function

GND
AX.7
AX.6
AX.5
QVdc
COM(-)
QX.7
QX.6
QX.5
QX.4
QX.3
QX.2
QX.1
QX.0

GND
Analog Out*
Analog Out
Analog Out

External Isolated Out Vdc
External Isolated Out GND

Digital/PWM Out*
Digital/PWM Out
Digital/PWM Out

Digital Out*
Digital Out
Digital Out
Digital Out
Digital Out

*Connectors AX.7, QX.7 and QX.4 are not connected (NC) in D Zone.

2 See section 5.4 to know more about interrupt pins.
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5.3 Relay Zone connection (I/Os)

X Zone

M-Duino
Connector

Function

RX.8
RX.7
RX.6
RX.5
RX.4
AX.2
AX.1
AX.0
GND
QX.2
QX.1
QX.0

COM(-)
QVdc

Relay Out
Relay Out
Relay Out
Relay Out*
Relay Out

Analog Out*
Analog Out
Analog Out

GND
Digital/PWM Out*
Digital/PWM Out
Digital/PWM Out

External Isolated Out Gnd
External Isolated Out Vdc

*Connectors RX.5, AX.2 and QX.2 are not connected (NC) in D Zone.

Top Zone

Led indicator I/Os state

X Zone

M-Duino Connector Function

RX.3
RX.2
RX.1
GND
IX.5
IX.4
IX.3
IX.2

IX.1/INT3

(-)IX.1
IX.0/INT
(-)IX.0

Relay Out
Relay Out
Relay Out

GND
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input

Interrupt X In
GND IX.1

Interrupt X In
GND IX.0

3 See section 5.4 to know more about interrupt pins.
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5.4 Interrupt equivalence table

See the Reference Table in order to know the specific device details.

Analog/Digital Relay

Zone PLC Input

PLC

Interrupt M-Duino Pin PLC Input PLC Interrupt M-Duino Pin

B
0.6 INT1 PIN3 0.1 INT1 PIN3

0.5 INT0 PIN2 0.0 INT0 PIN2

C
1.5 INT5 PIN19 1.1 INT5 PIN19

1.6 INT4 PIN18 1.0 INT4 PIN18

D
2.5 INT3 PIN21 2.1 INT3 PIN21

2.6 INT2 PIN20 2.0 INT2 PIN20

Check this link for more information.
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6 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C

language. They can also be programmed directly using C, but it is much easier working with

Arduino IDE, as it provides lots of useful libraries.

Industrial Shields provide a boards package for programming the PLCs, making it easier and

friendlier. It includes various facilities such as not having to define the pins, etc.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.15 or above (recommended: 1.8.19).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json
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3. Press OK to save the changes.

4. Go to: Tools -> Board:… -> Boards Manager

5. Search for “industrialshields” on the browser.

27



Rev. 7: 12-03-2024

6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

Once it is selected M-Duino Family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.
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Also there are some examples of programming in File -> Examples -> M-Duino Family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/Industrial-Shields/

7 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
M-Duino Family uses USB-B cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> M-Duino Family

- Select the correct M-Duino Board (M-Duino 58+ in our example).

- Select the correct port.
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8 How to connect PLC to power supply

- M-Duino Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT

REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail:

-12Vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel operation, overvoltage protection, and

overcurrent protection. There is a LED inductor for power status, the power supply is

certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types

of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the

equipment must be separated from the dangerous voltage cables.
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9 Switch configuration

9.1 A Zone: Communications

A Zone

Switch OFF ON

SCL | XX SCL XX

SDA | XX SDA XX

RX1 | XX RX1 XX

TX1 | XX TX1 XX

Pin 3 | XX Pin 3 XX

Pin 2 | XX Pin 2 XX

SD | XX SD XX

FD | HD FD HD

This is an A Zone Switch example from M-Duino 19R+. In this

case, SCL, SDA, RX1, TX1, I0.1, Pin 2, SD and HD are enabled. This

means Pin 3, I0.0 and FD are disabled. (NC refers to Not

Connected).

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and

disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and

disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

2. RX1 | XX: Choosing between RX1 or the input XX. If the switch is ON, it enables XX and

disables RX1. If the switch is OFF, it enables RX1 and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

1. TX1 | XX: Choosing between TX1 or the input XX. If the switch is ON, it enables XX and

disables TX1. If the switch is OFF, it enables TX1 and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.
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4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and

disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC

will indicate which input is referred to XX.

3. Pin 2 | XX: Choosing between Pin 2 or the input XX. If the switch is ON, it enables XX and

disables Pin 2. If the switch is OFF, it enables Pin 2 and disables XX. The serigraphy in the PLC

will indicate which input is referred to XX.

2. SD | XX: Choosing between SD or the input XX. If the switch is ON, it enables XX and disables

SD. If the switch is OFF, it enables SD and disables XX. The serigraphy in the PLC will indicate

which input is referred to XX.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If

the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means

Full Duplex. Check section 11.2 for more information.

A Zone

Switch OFF ON

NC - -

NC - -

NC | RTC - RTC

NC | RTC - RTC

This switch enables the communication with RTC using I2C. Having this switch in ON mode

activates the communication, whereas if it is in OFF mode it disables the I2C to reach the RTC.
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9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON

NC - -

AX.7 | QX.7 AX.7 QX.7

AX.6 | QX.6 AX.6 QX.6

AX.5 | QX.5 AX.5 QX.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know

what number takes X.

We can see here an example switch from the C Zone

(Notice that X takes value 1 here).

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF

it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will

provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, output A2.7 | Q2.7 is not connected.
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9.3 Relay Shield Switches

Relay Shield Switch

Switch OFF ON

NC - -

AX.2 | QX.2 AX.2 QX.2

AX.1 | QX.1 AX.1 QX.1

AX.0 | QX.0 AX.0 QX.0

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know

what number takes X.

We can see here an example switch from the B Zone (Notice

that X takes value 0 here).

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it

can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will

provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, output A2.2 | Q2.2 is not connected.
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10 M-Duino Arduino I/Os 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed

according to Arduino features such as I/Os operating at 5V or any additional features present in

the pins (for example I2C communication in pins SCL and SDA). As these pins are directly

connected to the Arduino Mega board they are not as well protected as the normal inputs.

These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of

these pins the configuration switch must be set to OFF position (see section 9) and some extra

considerations must be taken in consideration.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TX0 1
RX1 19 Communication switch: OFF
TX1 18 Communication switch: OFF
RX 17
TX 16

MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than

5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V,

which are explained in the following sections.

10.1 I2C pins – SDA/SCL

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it

reads 5V when nothing is connected. The pull-up configuration is established by default in

these pins.

In order to use them as an internal arduino direct PIN at 5V, it has to be considered that they

are pull-up inputs (a 2200Ω resistor is used in the internal pull-up).
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10.2 Serial 0 – RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in

case that all the 5V pins are already performing a function. This is because they are shared with

the USB interface. If using these pins, the USB communication cannot be working at the same

time.

When the PLC is not installed, the USB communication is normally required for debugging,

uploading and intercommunicating with the Ethernet controller. If using both interfaces at the

same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,

they must be configured as an external pull-up or pull-down circuit in order to correctly work.

10.3 Serial 1 – RX1/TX1

To know how to configure these pins correctly, check section 9. If not using the Serial 1

interface these pins can work as digital, either input or output.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,

they must be configured as an external pull-up or pull-down circuit in order to correctly work.

10.4 SPI – MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the

Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours

cannot happen at the same time, as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,

they must be configured as an external pull-up or pull-down circuit in order to correctly work.

10.5 Pin 2/Pin 3

To know how to configure these pins correctly, check section 9.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,

they must be configured as an external pull-up or pull-down circuit in order to correctly work.
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11 A Zone Features: Communications & RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16

and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not

matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232

implementation.

Click here4 or here5 to see more about this communication.

11.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this

communication. The RS-485 protocol will be always enabled, the only switch that affects is the

one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half

Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485

implementation.

Click here6 or here7 to see more about this communication.

7
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213

6
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195

5
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16

4
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183
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11.3 I2C

I2C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor

is already implemented in the PCB.

I2C communication is configured by switches, so the switches must be configured in order to

enable the I2C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the I2C, as it can already be used

with the standard library of Arduino, called Wire.

Click here8 to see more about this communication.

11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,

MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,

each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 51 SI 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 21/20/1/0/19/18/15/14/2/3

Check the switch configuration at section 9 to enable SS pins.

Click here9 to see more about this communication.

11.5 TTL

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTL0 is accessed with the function Serial (pins 0

and 1 of the Arduino Mega). TTL1 is accessed with the function Serial1 (pins 18 and 19 of the

Arduino Mega). See section 9 for more information.

11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with

Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the

M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino

Mega pin 10).

Click here10 and here11 to see more about this communication.

11
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105

10
https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103

9
https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191

8
https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
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11.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the I2C protocol

communication, so it is required to have enabled the I2C protocol. This means 4 switches have

to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the I2C wires to the RTC. If they are in

OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more

information.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation

called RTC.

Click here12 to see more about this feature.

11.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol

is always enabled, as there are no switches that configure it. However, there is a switch that

must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch is in ON

mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of

the PLC, it is required to open the plastic found in the frontal part and the socket is located

under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation

called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to

select the Chip Select of the uSD chip.

Click here13 to see more about this feature.

13
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167

12
https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51
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Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the

operation of an online process or machine. Unexpected operation of a process or machine

could result in death or injury to personnel and/or property damage. Before inserting a

memory card, always ensure that the CPU is offline and in a safe state.

Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la

carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le

fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un

processus ou d'une machine peut entraîner la mort ou des blessures corporelles et / ou des

dégâts matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors

ligne et en sécurité.
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12 Instructions for interconnection between Industrial

Shields controllers

12.1 RS-232 Communication:

12.2 RS-485 Communication:

12.2.1 Half Duplex

12.2.2 Full Duplex
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12.3 Ethernet

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.

13 Digital inputs threshold detection

The M-Duino inputs have a minimum voltage threshold to reliably detect the signal when used

as digital input. The threshold value is different depending on the input type:

42

Input type Threshold voltage (V)

Digital input 4

Analog input 5.1
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14 I/O technical details:

A comparison between the waveforms of the I/Os from the M-Duino PLC and the Arduino

Mega is done in this section.

Digital Output Waveform:

Digital Output Turn-off:

PWM Waveform:
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Analog Out Turn-On:

Analog Out Turn-Off:

Analog /Digital input Turn-on:
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15 Typical Connections
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16 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 1881529 connector

from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:

MC 0,5/ 4-G-2,5 - 1881464

MC 0,5/ 6-G-2,5 - 1881480

MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference MC 0,5/10-G-2,5 - 1881529

Height 8.1 mm

Pitch 2.5 mm

Dimension 22.5 mm

Pin dimensions 0.8 x 0.8 mm

Pin spacing 2.5 mm
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For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix

contact.

In the PLC we can find other connectors too, and these are the references for them:

FK-MC 0,5/ 4-ST-2,5 - 1881341

FK-MC 0,5/ 6-ST-2,5 - 1881367

FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm²

Rigid conduit section max. 0,5 mm²

Flexible conduit section min. 0,14 mm²

Flexible conduit section max. 0,5 mm²

Conduit section AWG/kcmil min. 26

Conduit section AWG/kcmil max. 20

51

https://es.farnell.com/phoenix-contact/fk-mc-0-5-10-st-2-5/plug-libre-muelle-2-5-mm-10-v/dp/1792814?CMP=KNC-GES-GEN-KWL-PDP-High-Aov-phoenix-contact-15-July-22&mckv=_dc%7Cpcrid%7C603873204419%7C&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd4jIzLvIJs5K_3lEpaW5Anqo3FBLu1TwiPFtyKaiP-rj4LSIy67bWoaAuLnEALw_wcB


Rev. 7: 12-03-2024

We can also find the relay connectors.

MCV 1,5/ 2-G-3,81 1803426 is the female connector, and MC 1,5/ 2-ST-3,81, GTIN UPC is the

male one. Both are from Phoenix Contact.

Article reference MCV 1,5/ 2-G-3,81 1803426

Height 12.6 mm

Pitch 3.81 mm

Dimension a 3.81 mm

Pin dimensions 0.8 x 0.8 mm

Article reference MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm

Pitch 3.81 mm

Dimension a 3.81 mm
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17 DIN Rail mounting

For optimal operation of the product, it must be located in an electrical cabinet with IK08
mechanical protection. The minimum IP protection degree required is IP56.
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18 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25cm
above and below the devices. Also, allow at least 25cm of depth between the front of the
modules and the inside of the enclosure.
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Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.
Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.
- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.
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- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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19 Revision Table

Revision Number Date Changes

0 30/08/2019 First implementation

1 21/02/2020 ETL Listing Mark-Direct

2 12/01/2022 Updated CE Normative (2004/108/EC)

3 25/07/2022 M-Duino Family User Manual Implementation

4 11/03/2024 Added section 13 “Digital inputs threshold detection”

5 06/05/2024 Serigraphy update on Section 5.1

6 26/09/2024 Added section 3.4 (“Isolation Precautions”)

7 12/03/2024 Removed wrong IORef pin reference

About Industrial Shields:

Direction: Camí del Grau, nº25

Zip/Postal Code: 08272

City: Sant Fruitós de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611
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Mail: industrialshields@industrialshields.com
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Preface

This User Guide has been implemented by Boot & Work, S.L. working

under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

● Persons in charge of introducing automation devices.

● Persons who design automation systems.

● Persons who install or connect automation devices.

● Persons who manage working automation installation.

Warnings:

● Unused pins should not be connected. Ignoring the directive may damage the

controller.

● Improper use of this product may severely damage the controller.

● Refer to the controller’s User Guide regarding wiring considerations.

● Before using this product, it is the responsibility of the user to read the product’s User

Guide and all accompanying documentation.

● Maintenance must be performed by qualified personnel familiarised with the

construction, operation, and hazards involved with the control.

● Maintenance should be performed with the control out of operation and disconnected

from all sources of power.

● Care should be taken when servicing electrostatic sensitive components. The

manufacturer's recommendations for these components should be followed.

2



Rev. 5: 03-12-2024

● The M-Duino DALI Family PLCs are Open Type Controllers. It is required that you install

the M-Duino DALI PLC in a housing, cabinet, or electric control room. Entry to the

housing, cabinet, or electric control room should be limited to authorised personnel.

Failure to follow these installation requirements could result in severe personal injury

and/or property damage. Always follow these requirements when installing M-Duino

family PLCs.

● In case of installation or maintenance of the M-Duino please follow the instructions

marked in the Installation and Maintenance section.

● Do not disconnect equipment when a flammable or combustible atmosphere is

present. Disconnection of equipment when a flammable or combustible atmosphere is

present may cause a fire or explosion which could result in death, serious injury and/or

property damage.

Avertissements

● Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut

endommager le contrôleur.

● Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur.

● Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de

câblage.

● Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du

produit et la documentation qui l’accompagne.

● La maintenance doit être effectuée par personnel qualifié familiarisé avec la

fabrication, le fonctionnement et les dangers liés au contrôleur.

● La maintenance doit être effectuée avec l’équipement hors service et déconnectée de

toutes les sources d'alimentation.

● Faites attention lors de l'entretien des composants sensibles à l'électricité statique. Les

recommandations du fabricant pour ces composants doivent être suivies.

● Les automates de la famille M-Duino sont des contrôleurs de type ouvert. Il est

nécessaire d'installer l'automate M-Duino dans un boîtier, une armoire ou une salle de

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences

d'installation peut entraîner des blessures graves et/ou des dommages matériels

importants. Respectez toujours ces exigences lors de l'installation des automates de la

famille M-Duino.

● En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions

indiquées dans la section Installation et Maintenance.

● Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou

combustible. La déconnexion de l'équipement en présence d'une atmosphère

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant

entraîner la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and understand this manual

Please read and understand this manual before using the product. Please consult your

comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT

BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF

PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING

THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE

INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND

INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or

standards that apply to the combination of products in the customer’s application or use of the

product.

The following are some examples of applications for which particular attention must be given.

This is not intended to be an exhaustive list of all possible uses of the products, nor is it

intended to imply that the uses may be suitable for the products:

● Systems, machines, and equipment that could present a risk to life or property.

● Nuclear energy control systems, combustion systems, railroad systems, aviation

systems, medical equipment, amusement machines, vehicles, safety equipment, and

installation subject to separate industry or government regulations.

● Outdoor use, uses involving potential chemical contamination or electrical

interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification

documents identifying ratings and limitations of use that apply to the products. This

information by itself is not sufficient for a complete determination of the suitability of the

products in combination with the system, machine, end product, or other application or use.
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Intended use of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the

catalogue and the associated technical documentation. If third-party products and components

are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,

installation, assembly, operation and maintenance have been carried out in a correct manner. It

must respect the permissible ambient conditions. You should also follow the indications and

warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated

by qualified personnel for the task entrusted and observing what is indicated in the

documentation corresponding to it, particularly the safety instructions and warnings included

in it. Due to their training and experience, qualified personnel are in a position to recognize

risks resulting from the handling or manipulation of such products / systems and to avoid

possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even

when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining

suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL

SHIELDS’s test conditions, and the users most correlate it to actual application requirements.

Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.

Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;

however, no responsibility is assumed for clerical, typographical, or proofreading errors, or

omissions.

Residual Risks

The control and drive components of an Industrial Shields PLC are approved for industrial and

commercial use in industrial line supplies. Their use in public line supplies requires a different

configuration and/or additional measures. These components may only be operated in closed

housings or in higher-level control cabinets with protective covers that are closed, and
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when all of the protective devices are used. These components may only be handled by

qualified and trained technical personnel who are knowledgeable and observe all of the safety

information and instructions on the components and in the associated technical user

documentation. When carrying out a risk assessment of a machine in accordance with the EU

Machinery Directive, the machine manufacturer must consider the following residual risks

associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,

maintenance, and repairs caused by, for example: − Hardware defects and/or software errors in

the sensors, controllers, actuators, and connection technology − Response times of the

controller and drive − Operating and/or ambient conditions not within the scope of the

specification − Condensation / conductive contamination − Parameterization, programming,

cabling, and installation errors − Use of radio devices / cellular phones in the immediate

vicinity of the controller − External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for

example: − Component malfunctions − Software errors − Operating and/or ambient

conditions not within the scope of the specification − External influences / damage.

3. Hazardous shock voltages caused by, for example: − Component malfunctions − Influence of

electrostatic charging − Induction of voltages in moving motors − Operating and/or ambient

conditions not within the scope of the specification − Condensation / conductive

contamination − External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to

people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the

system and/or failure to dispose of components safely and correctly.

Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials

and workmanship for a period of one year (or other period if specified) from date of sale by

Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,

REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE

OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR

INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR

IMPLIED
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Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL

DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE

PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR

STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER

CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT

THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT

SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information .

Recognized
Component ETL Classified

Conforms to:
UL Std. 61010-1
UL Std. 61010-2-201
Cert. To CSA Std. C22.2 No. 61010-1
Cert. ToCSA Std. C22.2 No.61010-2-201

Place for control
number:
5016476
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1 General Description M-DUINO DALI product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is important

to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from

below and D the shield from above. Having a B and a C in the middle of them.

● The inputs in zone B are named I0.X, being X any number suitable in the Shield.
Outputs are named as Q0.X and relays as R0.X.

● The inputs in zone C are named I1.X, being X any number suitable in the Shield.
Outputs are named as Q1.X and relays as R1.X.

● The inputs in zone D are named I2.X, being X any number suitable in the Shield.
Outputs are named as Q2.X and relays as R2.X.

10
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1.2 Reference table

Reference Table

Model Reference

PLC M-Duino General Family

M-Duino PLC Arduino Ethernet & DALI 19R I/Os Analog / Digital Plus 004001000100

M-Duino PLC Arduino Ethernet & DALI 21 I/Os Analog / Digital Plus 004001000200

M-Duino PLC Arduino Ethernet & DALI 38AR I/Os Analog / Digital Plus 004001000700

M-Duino PLC Arduino Ethernet & DALI 38R I/Os Analog / Digital Plus 004001000300

M-Duino PLC Arduino Ethernet & DALI 42 I/Os Analog / Digital Plus 004001000400

M-Duino PLC Arduino Ethernet & DALI 50RRA I/Os Analog / Digital Plus 004001000900

M-Duino PLC Arduino Ethernet & DALI 53ARR I/Os Analog / Digital Plus 004001001000

M-Duino PLC Arduino Ethernet & DALI 54ARA I/Os Analog / Digital Plus 004001001100

M-Duino PLC Arduino Ethernet & DALI 57AAR I/Os Analog / Digital Plus 004001000800

M-Duino PLC Arduino Ethernet & DALI 57R I/Os Analog / Digital Plus 004001000500

M-Duino PLC Arduino Ethernet & DALI 58 I/Os Analog / Digital Plus 004001000600

To find the reference of your M-Duino DALI PLC, check the arrow in the picture below. In the

example, the reference is:

11
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1.3 Zones Table

Zones Table

Model Zone A Zone B Zone C Zone D

M-Duino DALI PLC 19R+ ✔ Relay - -

M-Duino DALIE PLC 21+ ✔ Analog / Digital - -

M-Duino DALI PLC 38AR+ ✔ Analog / Digital Relay -

M-Duino DALI PLC 38R+ ✔ Relay Relay -

M-Duino DALI PLC 42+ ✔ Analog / Digital Analog / Digital -

M-Duino DALI PLC 50RRA+ ✔ Relay Relay Analog / Digital

M-Duino DALI PLC 53ARR+ ✔ Analog / Digital Relay Relay

M-Duino DALI PLC 54ARA+ ✔ Analog / Digital Relay Analog / Digital

M-Duino DALI PLC 57AAR+ ✔ Analog / Digital Analog / Digital Relay

M-Duino DALI PLC 57R+ ✔ Relay Relay Relay

M-Duino DALI PLC 58+ ✔ Analog / Digital Analog / Digital Analog / Digital

The distribution of the different features that provide the M-Duino DALI PLC Family is the

following one:

Shield B Zone C Zone D Zone

Analog Shield

13 Inputs
(13 Digital Inputs, 6
of which can work as

Analog Input)

8 Outputs
(8 Digital Outputs, 3
of which can work as

Analog Output)

11 Inputs
(11 Digital Inputs, 6
of which can work as

Analog Input)

8 Outputs
(8 Digital Outputs, 3
of which can work as

Analog Output)

10 Inputs
(10 Digital Inputs, 4
of which can work as

Analog Input)

6 Outputs
(6 Digital Outputs, 2
of which can work as

Analog Outputs)

Relay Shield

6 inputs
(6 Digital Inputs, 4 of
which can work as

Analog Input)

3 Outputs
(3 Digital Outputs, 3
of which can work as

Analog Output)

8 Relays

4 inputs
(4 Digital Inputs, 4 of
which can work as

Analog Input)

3 Outputs
(3 Digital Outputs, 3
of which can work as

Analog Output)

8 Relays

6 inputs
(6 Digital Inputs, 4 of
which can work as

Analog Input)

2 Outputs
(2 Digital Outputs, 2
of which can work as

Analog Output)

7 Relays

12
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1.4 A Zone Features

Shield A Zone

Communication
Shield

(1x) Ethernet
(1x) USB
(1x) I2C
(1x) TTL
(1x) RS-232
(1x) HALF/FULL Duplex RS-485
(1x) SPI external Port
(1x) RTC
(1x) uSD Socket

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) Width (mm) Depth (mm) Max weight (g)

M-Duino DALI PLC 19R+ 119.5 70.1 101 394

M-Duino DALIE PLC 21+ 119.5 70.1 101 394

M-Duino DALI PLC 38AR+ 119.5 94.7 101 504

M-Duino DALI PLC 38R+ 119.5 94.7 101 504

M-Duino DALI PLC 42+ 119.5 94.7 101 504

M-Duino DALI PLC 50RRA+ 119.5 119.3 101 614

M-Duino DALI PLC 53ARR+ 119.5 119.3 101 614

M-Duino DALI PLC 54ARA+ 119.5 119.3 101 614

M-Duino DALI PLC 57AAR+ 119.5 119.3 101 614

M-Duino DALI PLC 57R+ 119.5 119.3 101 614

M-Duino DALI PLC 58+ 119.5 119.3 101 614

13
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1.6 General Features

CONNECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE Controller General Specifications Information

Input Voltage
12 to 24Vdc Fuse protection (2.5A)

Polarity protection

Input rated voltage
24Vdc

Rated Power 30W

I max. 1.5A

Size Check size and weight table

Clock Speed 16MHz

Flash Memory 256KB of which 8KB used by bootloader

SRAM 8KB

EEPROM 4KB

Communications
I2C – Ethernet Port – USB – RS485 – RS232 – SPI – (1x)

RX, TX (Arduino pins) – DALI
Max232-Max485-W5500

USB consideration!
Only meant for uploading or debugging, not always

connected as a serial in a project!
Cannot be working in a final

application

An/Dig Input 10bit
(0-10Vcc)

0 to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vdc

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc

Max read time: 116us

*Check Section 14 for digital
inputs threshold detection

Digital Isolated Input
(24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc

All Digital Inputs are PNP.
Click here1 for more information.

Max read time: 8us

* Interrupt isolated
Input HS (24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc
Max read time: 8us

Analog Output 8bit
(0-10Vcc)

0 to 10Vdc
I max: 20mA

Separated PCB ground
Rated Voltage: 10Vdc

Output frequency: 2Hz

Rising edge time: 150ms
Falling edge time: 252ms

Digital Isolated Output
(24Vcc)

5 to 24Vdc
I max: 70mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Imax 24Vdc: 410mA

With 70us delay,
freq is 6.849MHz

with pulse width of 106us

Rising edge time: 476ns
Falling edge time: 42.8us

1 https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193
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Digital Isolated Output
Relay

30Vdc / 250Vac
Galvanic Isolation

Diode protected for Relay
Imax: 3A (30Vdc)
Imax: 5A (250Vac)

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Direct Arduino Pin
Output

0 to 5Vdc
I max: 40mA

Rated Voltage: 5Vdc

Max frequency: 77kHz

Rising edge time: 200ns
Falling edge time: 200ns

Direct Arduino Pin
Input

0 to 5Vdc
I max: 40mA

Rated Voltage: 5Vdc
Max read time: 8us

I2C Pin
5V Pull-up

Max frequency: 100kHz
Rising edge time: 10us
Falling edge time: 150ns

One-Wire Pin
Usable pins:

Pin 2, Pin3, SCL, SDA, RX0, TX0,
MISO, MOSI, SCK

Frequency: 800kHz

Expandability I2C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)
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1.7 Power consumption of the M-Duino DALI Family PLCs

Model Current resting
(mA)

Power resting
(W)

Current active
(mA)

Power active
(W)

21+ 99 2,376 120 2,88

42+ 92 2,208 128 3,072

58+ 76 1,824 126 3,024

19R+ 80 1,92 202 4,848

38R+ 77 1,848 313 7,512

57R+ 73 1,752 425 10,2

38AR+ 72 1,728 221 5,304

53ARR+ 71 1,704 323 7,752

57AAR+ 71 1,704 221 5,304

54ARA+ 76 1,824 231 5,544

50RRA+ 82 1,968 322 7,728

The power consumption is measured at 24Vdc.

The current resting column denotes the minimum current drawn by the PLC when all outputs
are at a LOW level, representing the PLC's baseline power consumption.

In contrast, the current active column reflects the current drawn by the PLC when all outputs
are at a HIGH level, and there are no connections to any of the outputs. While this value is not
the absolute maximum the Arduino based PLC can draw, it serves as a reference point for
expected current values.

It's important to note that the practical maximum current may vary depending on the type of
actuators connected to the outputs and the number of I/Os used. The actual consumption can
be influenced by the specific configuration and load connected to the PLC's outputs."
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2 Technical Specifications:

2.1 General Specifications:

Item M-Duino DALI Family PLC

Power supply
voltage

DC power supply 12 to 24Vdc

Operating
voltage range

DC power supply 11.4 to 25.4Vdc

Power
consumption

DC power supply 30W max.

External power
supply

Power supply
voltage

24Vdc

Power supply
output capacity

700mA

Insulation resistance 20MΩmin.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength
2.300Vac at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the external

AC terminals and the protective ground terminal.

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each.

Ambient temperature (operating) 0º to 60ºC

Ambient humidity (operating) 10% to 90% (no condensation)

Ambient environment (operating) With no corrosive gas

Ambient temperature (storage) -20º to 60ºC

Power supply holding time 2ms min.

Weight Check size and weight table

2.2 Performance Specification:

Arduino Board ARDUINO MEGA 2560

Control method Stored program method

I/O control method Combination of the cyclic scan and immediate refresh processing methods.

Programming language
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a

programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega2560

Flash Memory 256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB

EEPROM 4KB

Clock Speed 16MHz
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2.3 Symbology

Table that includes all the symbology that is used in the serigraph of the M-Duino DALI PLC

Family:

Symbol
Standard No. /
Standard Title

Standard Reference
No. / Symbol Title

Symbol Meaning

IEC 60417 / Graphical
symbols for use on

equipment
5031 / Direct Current

Indicates that the equipment is
suitable for direct current only; to

identify relevant terminals

IEC 60417 / Graphical
symbols for use on

equipment

5032 / Alternating
Current

Indicates that the equipment is
suitable for alternating current

only; to identify relevant terminals

IEC 60417 / Graphical
symbols for use on

equipment
5130 / Pulse General

To identify the control by which a
pulse is started.

IEC 60417 / Graphical
symbols for use on

equipment
5017 / Earth, Ground

To identify an earth (ground)
terminal in cases where neither the
symbol 5018 nor 5019 is explicitly

required.

IEC 60417 / Graphical
symbols for use on

equipment
5115 / Signal lamp

To identify the switch by means of
which the signal lamp(s) is (are)

switched on or off.

2004/108/EC /
Electromagnetic
Compatibility

CE Marking
CE marking indicates that a product
complies with applicable European

Union regulations

ISO 7000/ Graphical
symbols for use on

equipment

0434B /
Warning symbol

Indicates a potentially hazardous
situation which, if not avoided,
could result in death or serious

injury

ISO 7000/ Graphical
symbols for use on

equipment

5036 / Dangerous
Voltage

To indicate hazards arising from
dangerous voltages
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3 Precautions

Read this manual before attempting to use any of the M-Duino DALI PLC Family and follow its
descriptions for reference during operation.

3.1 Arduino Board

The M-Duino DALI Family PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in

this manual. Before using M-Duino under different conditions from what has been specified in

this manual or integrating M-Duino to nuclear control systems, railroad systems, aviation

systems, vehicles, combustion systems, medical equipment, amusement machines, safety

equipment and other systems, machines, and equipment that may have a serious influence on

lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure

that the rating and performance characteristics of M-Duino are sufficient for the systems,

machines, and equipment, and be sure to provide the systems, machines, and equipment

double safety mechanisms. This manual provides information for programming and operating

the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different

systems. This means that if an external device or sensor that shares the same ground reference

(GND) with the system is connected, any potential difference between these grounds could

damage the connected components. To avoid issues with interference, ground loops, or

damage to external equipment, ensure that all connected devices share the same ground

reference or use systems with appropriate isolation.

Recommendations:

● Connection Review: Verify that all ground connections are properly made and that

there are no significant potential differences between them.

● Use of Isolation: Consider using galvanic isolators or isolation transformers if it is

necessary to connect equipment with different ground references.
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4 M-Duino Pinout

IOs Table

Model Reference
Analog

Input*¹

Digital Isolated

Input

Digital Isolated

Output

Digital/Analog

Output
Relay Output

PWM Isolated

Output*²

19R+ 004001000100 4 2 0 3 8 3

21+ 004001000200 6 7 8 3 0 3

38AR+ 004001000700 10 7 5 6 8 6

38R+ 004001000300 8 2 0 3 16 6

42+ 004001000400 12 12 10 6 0 6

50RRA+ 004001000900 12 8 4 8 16 8

53ARR+ 004001001000 14 9 5 8 15 8

54ARA+ 004001001100 14 13 9 8 8 8

57AAR+ 004001000800 16 14 10 8 7 8

57R+ 004001000500 12 4 0 8 23 8

58+ 004001000600 16 18 14 8 0 8

*¹ The analog inputs can also be used as digital inputs.

*² The PWM isolated outputs can also be used as digital isolated outputs. The associated PWM

and analog outputs cannot be used at the same time (check switch configuration).
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5 Serigraphy

5.1 A Zone connection (Communications)

Base

A Zone

M-Duino
Connector

Arduino
Pin

Function

AREF
SQW

-
3.3Vdc
5Vdc
GND

AREF
SQW

-
3.3Vdc
5Vdc
GND

Arduino Pin
Arduino Pin

-
Arduino Pin

-
GND

Base

A Zone

M-Duino
Connector

Arduino
Pin

Function

SCL
SDA
RX0
TX0
-
-
TX
RX
Z-
Y+
B-
A+

PIN3
50 SO
51 SI
52 SCK
Reset
Vin5
PIN2
GND
GND
24Vdc

21
20
0
1
-
-
16
17
-
-
-
-
3
50
51
52

Reset
Vin5
2
-
-

I2C/SS
I2C/SS
RX0/SS
TX0/SS

-
-

RX2(serial 2)
TX2(serial 2)

RS485
RS485
RS485
RS485

Arduino Pin
SPI
SPI
SPI
SPI
5V

Arduino Pin
Gnd
Gnd

Power Supply
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SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any

device.

Ethernet Reset USB-B

RTC battery Programmable button
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5.2 Analog/Digital Zone connection (I/Os)

X Zone

M-Duino
Connector

Function

IX.12
IX.11
IX.10
IX.9
IX.8
IX.7

(-)IX.6
IX.6/INT
(-)IX.5

IX.5/INT
(-)IX.4
IX.4

(-)IX.3
IX.3

(-)IX.2
IX.2

(-)IX.1
IX.1

(-)IX.0
IX.0

Analog/Digital In*
Analog/Digital In*
Analog/Digital In
Analog/Digital In
Analog/Digital In
Analog/Digital In

GND IX.6
Interrupt X In2

GND IX.5
Interrupt X In3

GND IX.4*
Digital Input*

GND IX.3
Digital Input
GND IX.2

Digital Input
GND IX.1

Digital Input
GND IX.0

Digital Input

*Connectors IX.12, IX.11 and IX.4 are not connected (NC) in D Zone.

Top Zone

Led indicator I/Os state

X Zone

M-Duino
Connector

Function

GND
AX.7
AX.6
AX.5
QVdc
COM(-)
QX.7
QX.6
QX.5
QX.4
QX.3
QX.2
QX.1
QX.0

GND
Analog Out*
Analog Out
Analog Out

External Isolated Out Vdc
External Isolated Out GND

Digital/PWM Out*
Digital/PWM Out
Digital/PWM Out

Digital Out*
Digital Out
Digital Out
Digital Out
Digital Out

*Connectors AX.7, QX.7 and QX.4 are not connected (NC) in D Zone.

2 See section 5.4 to know more about interrupt pins.
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5.3 Relay Zone connection (I/Os)

X Zone

M-Duino
Connector

Function

RX.8
RX.7
RX.6
RX.5
RX.4
AX.2
AX.1
AX.0
GND
QX.2
QX.1
QX.0

COM(-)
QVdc

Relay Out
Relay Out
Relay Out
Relay Out*
Relay Out

Analog Out*
Analog Out
Analog Out

GND
Digital/PWM Out*
Digital/PWM Out
Digital/PWM Out

External Isolated Out Gnd
External Isolated Out Vdc

*Connectors RX.5, AX.2 and QX.2 are not connected (NC) in D Zone.

Top Zone

Led indicator I/Os state

X Zone

M-Duino Connector Function

RX.3
RX.2
RX.1
GND
IX.5
IX.4
IX.3
IX.2

IX.1/INT3

(-)IX.1
IX.0/INT4

(-)IX.0

Relay Out
Relay Out
Relay Out

GND
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input

Interrupt X In
GND IX.1

Interrupt X In
GND IX.0

3 See section 5.4 to know more about interrupt pins.
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5.4 Interrupt equivalence table

See the Reference Table in order to know the specific device details.

Analog/Digital Relay

Zone PLC Input
PLC

Interrupt
M-Duino Pin PLC Input PLC Interrupt M-Duino Pin

B
0.6 INT1 PIN3 0.1 INT1 PIN3

0.5 INT0 PIN2 0.0 INT0 PIN2

C
- - - - - -

- - - - - -

D
2.5 INT3 PIN21 2.1 INT3 PIN21

2.6 INT2 PIN20 2.0 INT2 PIN20

Check this link for more information.
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6 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C

language. They can also be programmed directly using C, but it is much easier working with

Arduino IDE, as it provides lots of useful libraries.

Industrial Shields provide a boards package for programming the PLCs, making it easier and

friendlier. It includes various facilities such as not having to define the pins, etc.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.15 or above (recommended: 1.8.19).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.
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2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board:… -> Boards Manager

5. Search for “industrialshields” on the browser.

27
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

Once it is selected M-Duino DALI Family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

Also there are some examples of programming in File -> Examples -> Examples for M-Duino

DALI family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/Industrial-Shields/

28
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7 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
M-Duino DALI Family uses B-USB cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> M-Duino DALI Family

- Select the correct M-Duino Board (M-Duino 19R+ DALI in our example).

- Select the correct port.
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8 How to connect PLC to power supply

- M-Duino DALI Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT

REVERSIBLE!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail:

-12Vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel operation, overvoltage protection, and

overcurrent protection. There is a LED inductor for power status, the power supply is

certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types

of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the

equipment must be separated from the dangerous voltage cables.
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9 Switch configuration

9.1 A Zone: Communications

A Zone

Switch OFF ON

SCL | XX SCL XX

SDA | XX SDA XX

DALI | - DALI -

DALI | - DALI -

Pin 3 | XX Pin 3 XX

Pin 2 | XX Pin 2 XX

SD | XX SD XX

FD | HD FD HD

This is an D Zone Switch example from M-Duino 58+ DALI. In this

case, SCL, SDA, I0.6, I0.5, Q2.0 and HD are enabled. This means SCL,

SDA, Pin 3, Pin 2, SD and FD are disabled.

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and

disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and

disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

2. DALI | - : Always at OFF position.

1. DALI | - : Always at OFF position.
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4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and

disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC

will indicate which input is referred to XX.

3. Pin 2 | XX: Choosing between Pin 2 or the input XX. If the switch is ON, it enables XX and

disables Pin 2. If the switch is OFF, it enables Pin 2 and disables XX. The serigraphy in the PLC

will indicate which input is referred to XX.

2. SD | XX: Choosing between SD or the input XX. If the switch is ON, it enables XX and disables

SD. If the switch is OFF, it enables SD and disables XX. The serigraphy in the PLC will indicate

which input is referred to XX.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If

the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means

Full Duplex. Check section 11.2 for more information.

A Zone

Switch OFF ON

NC - -

NC - -

NC | RTC - RTC

NC | RTC - RTC

This switch enables the communication with RTC using I2C. Having both switches in ON mode

activates the communication, whereas if they are in OFF mode I2C is disabled to reach the RTC.
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9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON

NC - -

AX.7 | QX.7 AX.7 QX.7

AX.6 | QX.6 AX.6 QX.6

AX.5 | QX.5 AX.5 QX.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know

what number takes X.

We can see here an example switch from the C Zone

(Notice that X takes value 1 here).

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF

it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will

provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, output A2.7 | Q2.7 is not connected.
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9.3 Relay Shield Switches

Relay Shield Switch

Switch OFF ON

NC - -

AX.2 | QX.2 AX.2 QX.2

AX.1 | QX.1 AX.1 QX.1

AX.0 | QX.0 AX.0 QX.0

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know

what number takes X.

We can see here an example switch from the B Zone (Notice

that X takes value 0 here).

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it

can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will

provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, output A2.2 | Q2.2 is not connected.
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10 M-Duino Arduino I/Os 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed

according to Arduino features such as I/Os operating at 5V or any additional features present in

the pins (for example I2C communication in pins SCL and SDA). As these pins are directly

connected to the Arduino Mega board they are not as well protected as the normal inputs.

These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of

these pins the configuration switch must be set to OFF position (see section 9) and some extra

considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TX0 1
RX 17
TX 16

MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than

5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.

Now it is going to be shown the considerations to operate with these pins.

10.1 I2C pins – SDA/SCL

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it

reads 5V when nothing is connected. The pull-up configuration is established by default in

these pins.

If it is meant to use them as an internal arduino direct PIN at 5V, it has to be considered that

they are pull-up inputs (2200Ω resistor is used in the internal pull-up).
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10.2 Serial 0 – RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in

case that all the 5V pins are already performing a function. This is because they are shared with

the USB interface. If using these pins, the USB communication cannot be working at the same

time.

When the PLC is not installed, USB communication is normally required for debugging or

uploading/updating the program. If using both interfaces at the same time the Arduino board

will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be established as an external pull-up or pull-down circuit in order to correctly work with

these pins.

10.3 SPI – MISO/MOSI/SCK

These pins can only work as 5V pins if the Ethernet protocol is not going to be used. As the

Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours

cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be established as an external pull-up or pull-down circuit in order to correctly work with

these pins.

10.4 Pin 2/Pin 3

To know how to configure these pins correctly, check section 9.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be established as an external pull-up or pull-down circuit in order to correctly work with

these pins.
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11 A Zone Features: Communications & RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16

and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not

matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232

implementation.

Click here4 or here5 to see more about this communication.

11.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this

communication. The RS-485 protocol will be always enabled, the only switch that affects is the

one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half

Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485

implementation.

Click here6 or here7 to see more about this communication.

7
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213

6
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195

5
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16

4
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183
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11.3 I2C

I2C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor

is already implemented in the PCB.

I2C communication is configured by switches, so the switches must be configured in order to

enable the I2C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the I2C as it can be used with the

standard library of Arduino called Wire.

Click here8 to see more about this communication.

11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,

MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,

each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 51 SI 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX3/TX3/Pin2/Pin3 21/20/1/0/15/14/2/3

Check the switch configuration at section 9 to enable SS pins.

Click here9 to see more about this communication.

11.5 TTL

M-Duino has two TTL ports, RX0/TX0, RX/TX. TTL0 is accessed with the function Serial (pins 0

and 1 of the Arduino Mega). TTL is accessed with the function Serial2 (pins 16 and 17 of the

Arduino Mega). See section 9 for more information.

11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with

Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the

M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino

Mega pin 10). Click here10 and here11 to see more about this communication.

11
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105

10
https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103

9
https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191

8
https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
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11.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the I2C protocol

communication, so it is required to have enabled the I2C protocol. This means 4 switches have

to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the I2C wires to the RTC. If they are in

OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more

information.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation

called RTC.

Click here12 to see more about this feature.

11.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol

is always enabled, as there are no switches that configure it. However, there is a switch that

must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch is in ON

mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of

the PLC, it is required to open the plastic found in the frontal part and the socket is located

under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation

called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to

select the Chip Select of the uSD chip.

Click here13 to see more about this feature.

13
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167

12
https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51
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Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the

operation of an online process or machine. Unexpected operation of a process or machine

could result in death or injury to personnel and/or property damage. Before inserting a

memory card, always ensure that the CPU is offline and in a safe state.

Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la

carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le

fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un

processus ou d'une machine peut entraîner la mort ou des blessures corporelles et / ou des

dégâts matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors

ligne et en sécurité.
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12 Examples

12.1 Lighting Protocol DALI in a PLC Arduino

To know what the DALI Protocol is and how it works in an industrial environment, look at this

post14. A detailed description of DALI is done in it.

12.2How to work with DALI Arduino Library and an industrial PLC

In this other link15 a useful explanation on how the DALI Protocol can be implemented and used

in industrial PLCs is given. Also, there is an example code to help in understanding the

fundamentals of DALI communication.

15

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-work-with-dali-arduino-librar
y-and-an-industrial-plc-221

14

https://www.industrialshields.com/blog/arduino-industrial-1/post/lighting-protocol-dali-in-a-plc-arduino
-238
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13 Instructions for interconnection between Industrial

Shields controllers

13.1 RS-232 Communication:

13.2 RS-485 Communication:

13.2.1 Half Duplex

13.2.2 Full Duplex
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13.3 Ethernet

For Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.

14 Digital inputs threshold detection

The M-Duino inputs have a minimum voltage threshold to reliably detect the signal when used

as digital input. The threshold value is different depending on the input type:

43

Input type Threshold voltage (V)

Digital input 4

Analog input 5.1
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15 I/O technical details

A comparison between the waveforms of the I/Os from the M-Duino DALI Family PLC and the

Arduino Mega is done in this section.

Digital Output Waveform:

Digital Output Turn-off:

PWM Waveform:
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Analog Out Turn-On:

Analog Out Turn-Off:

Analog /Digital input Turn-on:
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16 Typical Connections

46



Rev. 5: 03-12-2024

47



Rev. 5: 03-12-2024

48



Rev. 5: 03-12-2024

49



Rev. 5: 03-12-2024

50



Rev. 5: 03-12-2024

17 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 188152916

connector from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:

MC 0,5/ 4-G-2,5 - 1881464

MC 0,5/ 6-G-2,5 - 1881480

MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference MC 0,5/10-G-2,5 - 1881529

Height 8.1 mm

Pitch 2.5 mm

Dimension 22.5 mm

Pin dimensions 0.8 x 0.8 mm

Pin spacing 2.5 mm

16 https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529
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For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 188140617 connector from Phoenix

contact.

In the PLC we can find other connectors too, and these are the references for them:

FK-MC 0,5/ 4-ST-2,5 - 1881341

FK-MC 0,5/ 6-ST-2,5 - 1881367

FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm²

Rigid conduit section max. 0,5 mm²

Flexible conduit section min. 0,14 mm²

Flexible conduit section max. 0,5 mm²

Conduit section AWG/kcmil min. 26

Conduit section AWG/kcmil max. 20

We can also find the relay connectors.

17

https://es.farnell.com/phoenix-contact/fk-mc-0-5-10-st-2-5/plug-libre-muelle-2-5-mm-10-v/dp/1792814
?CMP=KNC-GES-GEN-KWL-PDP-High-Aov-phoenix-contact-15-July-22&mckv=_dc%7Cpcrid%7C60387320
4419%7C&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd4jIzLvIJs5K_3lEpaW5Anqo3FBLu1TwiPFtyKaiP-rj4LSIy6
7bWoaAuLnEALw_wcB
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MCV 1,5/ 2-G-3,81 180342618 is the female connector, andMC 1,5/ 2-ST-3,81, GTIN UPC19 is the

male one. Both are from Phoenix Contact.

Article reference MCV 1,5/ 2-G-3,81 1803426

Height 12.6 mm

Pitch 3.81 mm

Dimension a 3.81 mm

Pin dimensions 0.8 x 0.8 mm

Article reference MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm

Pitch 3.81 mm

Dimension a 3.81 mm

19

https://es.farnell.com/phoenix-contact/1803578/terminal-block-pluggable-2pos/dp/3704907?gclid=Cj0K
CQjw_viWBhD8ARIsAH1mCd6YjA37NqmaaFBXgbRyGExfAM8qDodVOWZPfYsLLQhnVygDn8ufNsIaAmgYE
ALw_wcB&mckv=_dc%7Cpcrid%7C575710444791%7Cplid%7C%7Ckword%7C%7Cmatch%7C%7Cslid%7C
%7Cproduct%7C3704907%7Cpgrid%7C131987845643%7Cptaid%7Cpla-372506228807&CMP=KNC-GES-
GEN-SMART-SHOPPING-High-Jan-2022&gross_price=true

18

https://www.tme.eu/es/details/mcv1.5_2-g-3.81/bloque-de-bornas-extraibles/phoenix-contact/mcv-1-5
-2-g-3-81-1803426/?brutto=1&currency=EUR&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd763F0sGBmfjy5p
mZm9dKysA6ePciWt8md8utGsZX1OfLpgsBx4mnoaAo9GEALw_wcB

53

https://www.tme.eu/es/details/mcv1.5_2-g-3.81/bloque-de-bornas-extraibles/phoenix-contact/mcv-1-5-2-g-3-81-1803426/?brutto=1&currency=EUR&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd763F0sGBmfjy5pmZm9dKysA6ePciWt8md8utGsZX1OfLpgsBx4mnoaAo9GEALw_wcB
https://es.farnell.com/phoenix-contact/1803578/terminal-block-pluggable-2pos/dp/3704907?gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd6YjA37NqmaaFBXgbRyGExfAM8qDodVOWZPfYsLLQhnVygDn8ufNsIaAmgYEALw_wcB&mckv=_dc%7Cpcrid%7C575710444791%7Cplid%7C%7Ckword%7C%7Cmatch%7C%7Cslid%7C%7Cproduct%7C3704907%7Cpgrid%7C131987845643%7Cptaid%7Cpla-372506228807&CMP=KNC-GES-GEN-SMART-SHOPPING-High-Jan-2022&gross_price=true


Rev. 5: 03-12-2024

18 DIN Rail mounting

For optimal operation of the product, it must be located in an electrical cabinet with
IK08 mechanical protection. The minimum IP protection degree required is IP56.
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19 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause a misact.

- Use shielded twisted pairs for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
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above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.
Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25 cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by an excess
of temperature.
- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

56



Rev. 5: 03-12-2024

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.
- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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20 Revision Table

Revision Number Date Changes

0 30/07/2020 First implementation

1 11/08/2020 Added DALI Communication

2 05/10/2022 M-Duino DALI Family User Manual Implementation

3 11/03/2024 Added section 14 “Digital inputs threshold detection”

4 26/09/2024 Added section 3.4 (“Isolation Precautions”)

5 03/12/2024 Removed wrong IORef pin reference

About Industrial Shields:

Direction: Camí del Grau, nº25

Zip/Postal Code: 08272

City: Sant Fruitós de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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Preface

This User Guide has been implemented by Boot & Work, S.L. working

under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

● Persons in charge of introducing automation devices.

● Persons who design automation systems.

● Persons who install or connect automation devices.

● Persons who manage working automation installation.

Warnings:

● Unused pins should not be connected. Ignoring the directive may damage the

controller.

● Improper use of this product may severely damage the controller.

● Refer to the controller’s User Guide regarding wiring considerations.

● Before using this product, it is the responsibility of the user to read the product’s User

Guide and all accompanying documentation.

● Maintenance must be performed by qualified personnel familiarised with the

construction, operation, and hazards involved with the control.

● Maintenance should be performed with the control out of operation and disconnected

from all sources of power.

● Care should be taken when servicing electrostatic sensitive components. The

manufacturer's recommendations for these components should be followed.
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● The M-Duino GPRS Family PLCs are Open Type Controllers. It is required that you install

the M-Duino GPRS PLC in a housing, cabinet, or electric control room. Entry to the

housing, cabinet, or electric control room should be limited to authorised personnel.

Failure to follow these installation requirements could result in severe personal injury

and/or property damage. Always follow these requirements when installing M-Duino

family PLCs.

● In case of installation or maintenance of the M-Duino please follow the instructions

marked in the Installation and Maintenance section.

● Do not disconnect equipment when a flammable or combustible atmosphere is

present. Disconnection of equipment when a flammable or combustible atmosphere is

present may cause a fire or explosion which could result in death, serious injury and/or

property damage.

Avertissements:

● Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut

endommager le contrôleur.

● Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur.

● Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de

câblage.

● Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du

produit et la documentation qui l’accompagne.

● La maintenance doit être effectuée par personnel qualifié familiarisé avec la

fabrication, le fonctionnement et les dangers liés au contrôleur.

● La maintenance doit être effectuée avec l’équipement hors service et déconnectée de

toutes les sources d'alimentation.

● Faites attention lors de l'entretien des composants sensibles à l'électricité statique. Les

recommandations du fabricant pour ces composants doivent être suivies.

● Les automates de la famille M-Duino sont des contrôleurs de type ouvert. Il est

nécessaire d'installer l'automate M-Duino dans un boîtier, une armoire ou une salle de

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences

d'installation peut entraîner des blessures graves et/ou des dommages matériels

importants. Respectez toujours ces exigences lors de l'installation des automates de la

famille M-Duino.

● En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions

indiquées dans la section Installation et Maintenance.

● Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou

combustible. La déconnexion de l'équipement en présence d'une atmosphère

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant

entraîner la mort, des blessures graves et/ou des dommages matériels.

3



Rev. 6: 03-12-2024

Application Considerations and Warranty

Read and understand this manual

Please read and understand this manual before using the product. Please consult your

comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT

BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF

PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING

THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE

INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND

INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or

standards that apply to the combination of products in the customer’s application or use of the

product.

The following are some examples of applications for which particular attention must be given.

This is not intended to be an exhaustive list of all possible uses of the products, nor is it

intended to imply that the uses may be suitable for the products:

● Systems, machines, and equipment that could present a risk to life or property.

● Nuclear energy control systems, combustion systems, railroad systems, aviation

systems, medical equipment, amusement machines, vehicles, safety equipment, and

installation subject to separate industry or government regulations.

● Outdoor use, uses involving potential chemical contamination or electrical

interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification

documents identifying ratings and limitations of use that apply to the products. This

information by itself is not sufficient for a complete determination of the suitability of the

products in combination with the system, machine, end product, or other application or use.
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Intended use of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the

catalogue and the associated technical documentation. If third-party products and components

are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,

installation, assembly, operation and maintenance have been carried out in a correct manner. It

must respect the permissible ambient conditions. You should also follow the indications and

warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated

by qualified personnel for the task entrusted and observing what is indicated in the

documentation corresponding to it, particularly the safety instructions and warnings included

in it. Due to their training and experience, qualified personnel are in a position to recognize

risks resulting from the handling or manipulation of such products / systems and to avoid

possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even

when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining

suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL

SHIELDS’s test conditions, and the users most correlate it to actual application requirements.

Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.

5



Rev. 6: 03-12-2024

Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;

however, no responsibility is assumed for clerical, typographical, or proofreading errors, or

omissions.

Residual Risks

The control and drive components of an Industrial Shields PLC are approved for industrial and

commercial use in industrial line supplies. Their use in public line supplies requires a different

configuration and/or additional measures. These components may only be operated in closed

housings or in higher-level control cabinets with protective covers that are closed, and when all

of the protective devices are used. These components may only be handled by qualified and

trained technical personnel who are knowledgeable and observe all of the safety information

and instructions on the components and in the associated technical user documentation.

When carrying out a risk assessment of a machine in accordance with the EU Machinery

Directive, the machine manufacturer must consider the following residual risks associated with

the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,

maintenance, and repairs caused by, for example: − Hardware defects and/or software errors in

the sensors, controllers, actuators, and connection technology − Response times of the

controller and drive − Operating and/or ambient conditions not within the scope of the

specification − Condensation / conductive contamination − Parameterization, programming,

cabling, and installation errors − Use of radio devices / cellular phones in the immediate

vicinity of the controller − External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for

example: − Component malfunctions − Software errors − Operating and/or ambient

conditions not within the scope of the specification − External influences / damage.

3. Hazardous shock voltages caused by, for example: − Component malfunctions − Influence of

electrostatic charging − Induction of voltages in moving motors − Operating and/or ambient

conditions not within the scope of the specification − Condensation / conductive

contamination − External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to

people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the

system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials

and workmanship for a period of one year (or other period if specified) from date of sale by

Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,

REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE

OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR

INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR

IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL

DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE

PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR

STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER

CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT

THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT

SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

Recognized
Component ETL Classified

Conforms to:
UL Std. 61010-1
UL Std. 61010-2-201
Cert. To CSA Std. C22.2 No. 61010-1
Cert. ToCSA Std. C22.2 No.61010-2-201

Place for control
number:
5016476
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1 General Description M-DUINO GPRS product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is important

to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from

below and D the shield from above. Having a B and a C in the middle of them.:

● The inputs in the zone B are named I0.X, being X any number suitable in the Shield.
Outputs are named as Q0.X and relays as R0.X

● The inputs in the zone C are named I1.X, being X any number suitable in the Shield.
Outputs are named as Q1.X and relays as R1.X

● The inputs in the zone D are named I2.X, being X any number suitable in the Shield.
Outputs are named as Q2.X and relays as R2.X
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1.2 Reference table

Reference Table

Model Reference

PLC M-Duino General Family

M-DUINO PLC Arduino Ethernet & GPRS 19R I/Os Relay / Analog / Digital PLUS 006001000100

M-DUINO PLC Arduino Ethernet & GPRS 21 I/Os Analog/Digital PLUS 006001000200

M-DUINO PLC Arduino Ethernet & GPRS 38AR I/Os Relay / Analog / Digital PLUS 006001000700

M-DUINO PLC Arduino Ethernet & GPRS 38R I/Os Relay / Analog / Digital PLUS 006001000300

M-DUINO PLC Arduino Ethernet & GPRS 42 I/Os Analog/Digital PLUS 006001000400

M-DUINO PLC Arduino Ethernet & GPRS 50RRA I/Os Relay / Analog / Digital PLUS 006001000900

M-DUINO PLC Arduino Ethernet & GPRS 53ARR I/Os Relay / Analog / Digital PLUS 006001001000

M-DUINO PLC Arduino Ethernet & GPRS 54ARA I/Os Relay / Analog / Digital PLUS 006001001100

M-DUINO PLC Arduino Ethernet & GPRS 57AAR I/Os Relay / Analog / Digital PLUS 006001000800

M-DUINO PLC Arduino Ethernet & GPRS 57R I/Os Relay / Analog / Digital PLUS 006001000500

M-DUINO PLC Arduino Ethernet & GPRS 58 I/Os Analog/Digital PLUS 006001000600

To find the reference of your M-Duino GPRS PLC, check the arrow in the picture below. In the

example, the reference is:

11



Rev. 6: 03-12-2024

1.3 Zones Table

Zones Table

Model Zone A Zone B Zone C Zone D

M-Duino GPRS PLC 19R+ ✔ Relay - -

M-Duino GPRS PLC 21+ ✔ Analog / Digital - -

M-Duino GPRS PLC 38AR+ ✔ Analog / Digital Relay -

M-Duino GPRS PLC 38R+ ✔ Relay Relay -

M-Duino GPRS PLC 42+ ✔ Analog / Digital Analog / Digital -

M-Duino GPRS PLC 50RRA+ ✔ Relay Relay Analog / Digital

M-Duino GPRS PLC 53ARR+ ✔ Analog / Digital Relay Relay

M-Duino GPRS PLC 54ARA+ ✔ Analog / Digital Relay Analog / Digital

M-Duino GPRS PLC 57AAR+ ✔ Analog / Digital Analog / Digital Relay

M-Duino GPRS PLC 57R+ ✔ Relay Relay Relay

M-Duino GPRS PLC 58+ ✔ Analog / Digital Analog / Digital Analog / Digital

The distribution of the different features that provide the M-Duino GPRS PLC Family is the

following one:

Shield B Zone C Zone D Zone

Analog Shield

12 Inputs
(12 Digital Inputs, 6
of which can work as

Analog Input)

8 Outputs
(8 Digital Outputs, 3
of which can work as

Analog Output)

11 Inputs
(11 Digital Inputs, 6
of which can work as

Analog Input)

8 Outputs
(8 Digital Outputs, 3
of which can work as

Analog Output)

10 Inputs
(10 Digital Inputs, 4
of which can work as

Analog Input)

6 Outputs
(6 Digital Outputs, 2
of which can work as

Analog Outputs)

Relay Shield

5 inputs
(5 Digital Inputs, 4 of
which can work as

Analog Input)

3 Outputs
(3 Digital Outputs, 3
of which can work as

Analog Output)

8 Relays

5inputs
(5 Digital Inputs, 4 of
which can work as

Analog Input)

3 Outputs
(3 Digital Outputs, 3
of which can work as

Analog Output)

8 Relays

6 inputs
(6 Digital Inputs, 4 of
which can work as

Analog Input)

2 Outputs
(2 Digital Outputs, 2
of which can work as

Analog Output)

7 Relays
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1.4 A Zone Features

Shield A Zone

Communication

Shield

(1x) Ethernet

(1x) USB

(1x) I2C

(1x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485

(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

(1x) GPRS/GSM

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) Width (mm) Depth (mm) Max weight (g)

M-Duino GPRS PLC 19R+ 119.5 70.1 101 394

M-Duino GPRS PLC 21+ 119.5 70.1 101 394

M-Duino GPRS PLC 38AR+ 119.5 94.7 101 504

M-Duino GPRS PLC 38R+ 119.5 94.7 101 504

M-Duino GPRS PLC 42+ 119.5 94.7 101 504

M-Duino GPRS PLC 50RRA+ 119.5 119.3 101 614

M-Duino GPRS PLC 53ARR+ 119.5 119.3 101 614

M-Duino GPRS PLC 54ARA+ 119.5 119.3 101 614

M-Duino GPRS PLC 57AAR+ 119.5 119.3 101 614

M-Duino GPRS PLC 57R+ 119.5 119.3 101 614

M-Duino GPRS PLC 58+ 119.5 119.3 101 614
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1.6 General Features

CONNECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE Controller General Specifications Information

Input Voltage
12 to 24Vdc

Fuse protection (2.5A)
Polarity protection

Input rated voltage
24Vdc

Rated Power 30 W

I max. 1.5A

Size Check size and weight table

Clock Speed 16MHz

Flash Memory 256KB of which 8KB used by bootloader

SRAM 8KB

EEPROM 4KB

Communications
I2C – Ethernet Port – USB – RS485 – RS232 – SPI – (3x)

RX, TX (Arduino pins)
Max232-Max485-W5500 -

Sim800L

USB consideration!
Only meant for uploading or debugging, not always

connected as a serial in a project!
Cannot be working in a final

application

An/Dig Input 10bit
(0-10Vcc)

0 to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vdc

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc

Max read time: 116us

*Check Section 14 for digital
inputs threshold detection

Digital Isolated Input
(24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc

All Digital Inputs are PNP.
Click here1 for more information.

Max read time: 8us

* Interrupt isolated
Input HS (24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc
Max read time: 8us

Analog Output 8bit
(0-10Vcc)

0 to 10Vdc
I max: 20mA

Separated PCB ground
Rated Voltage: 10Vdc

Output frequency: 2Hz

Rising edge time: 150ms
Falling edge time: 252ms

Digital Isolated Output
(24Vcc)

5 to 24Vdc
I max: 70mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Imax 24Vdc: 410mA

With 70 us delay,
freq is 6.849MHz

with pulse width of 106us

Rising edge time: 476ns
Falling edge time: 42.8us

1 https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193
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Digital Isolated Output
Relay

30Vdc / 250Vac
Galvanic Isolation

Diode protected for Relay
Imax: 3A (30Vdc)
Imax: 5A (250Vac)

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Direct Arduino Pin
Output

0 to 5Vdc
I max: 40mA

Rated Voltage: 5Vdc

Max frequency: 77kHz

Rising edge time: 200ns
Falling edge time: 200ns

Direct Arduino Pin
Input

0 to 5Vdc
I max: 40mA

Rated Voltage: 5Vdc
Max read time: 8us

I2C Pin
5V Pull-up

Max frequency: 100kHz
Rising edge time: 10us
Falling edge time: 150ns

One-Wire Pin
Usable pins:

Pin3, SCL, SDA, RX0, TX0,
MISO, MOSI, SCK

Frequency: 800kHz

Expandability I2C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)

15



Rev. 6: 03-12-2024

1.7 Power consumption of the M-Duino LoRa Family PLCs

Model Current resting
(mA)

Power resting
(W)

Current active
(mA)

Power active
(W)

21+ 99 2,376 120 2,88

42+ 92 2,208 128 3,072

58+ 76 1,824 126 3,024

19R+ 80 1,92 202 4,848

38R+ 77 1,848 313 7,512

57R+ 73 1,752 425 10,2

38AR+ 72 1,728 221 5,304

53ARR+ 71 1,704 323 7,752

57AAR+ 71 1,704 221 5,304

54ARA+ 76 1,824 231 5,544

50RRA+ 82 1,968 322 7,728

The power consumption is measured at 24Vdc.

The current resting column denotes the minimum current drawn by the PLC when all outputs
are at a LOW level, representing the PLC's baseline power consumption.

In contrast, the current active column reflects the current drawn by the PLC when all outputs
are at a HIGH level, and there are no connections to any of the outputs. While this value is not
the absolute maximum the Arduino based PLC can draw, it serves as a reference point for
expected current values.

It's important to note that the practical maximum current may vary depending on the type of
actuators connected to the outputs and the number of I/Os used. The actual consumption can
be influenced by the specific configuration and load connected to the PLC's outputs."
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2 Technical Specifications

2.1 General Specifications

Item M-Duino GPRS Family PLC

Power supply
voltage

DC power supply 12 to 24Vdc

Operating
voltage range

DC power supply 11.4 to 25.4Vdc

Power
consumption

DC power supply 30W max.

External power
supply

Power supply
voltage

24Vdc

Power supply
output capacity

700mA

Insulation resistance 20MΩmin.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength
2.300Vac at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the external

AC terminals and the protective ground terminal.

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each.

Ambient temperature (operating) 0º to 60ºC

Ambient humidity (operating) 10% to 90% (no condensation)

Ambient environment (operating) With no corrosive gas

Ambient temperature (storage) -20º to 60ºC

Power supply holding time 2ms min.

Weight Check size and weight table

2.2 Performance Specification

Arduino Board ARDUINO MEGA 2560

Control method Stored program method

I/O control method Combination of the cyclic scan and immediate refresh processing methods.

Programming language
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a

programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega2560

Flash Memory 256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB

EEPROM 4KB

Clock Speed 16MHz
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2.3 Symbology

Table that includes all the symbology that is used in the serigraph of the M-Duino GPRS PLC

Family:

Symbol Standard No. /
Standard Title

Standard
Reference No. /
Symbol Title

Symbol Meaning

IEC 60417 /
Graphical symbols

for use on
equipment

5031 / Direct
Current

Indicates that the equipment is
suitable for direct current only;
to identify relevant terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5032 / Alternating
Current

Indicates that the equipment is
suitable for alternating current

only; to identify relevant
terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5130 / Pulse
General

To identify the control by which
a pulse is started.

IEC 60417 /
Graphical symbols

for use on
equipment

5017 / Earth,
Ground

To identify an earth (ground)
terminal in cases where

neither the symbol 5018 nor
5019 is explicitly required.

IEC 60417 /
Graphical symbols

for use on
equipment

5115 / Signal lamp

To identify the switch by
means of which the signal

lamp(s) is (are) switched on or
off.

2004/108/EC /
Electromagnetic
Compatibility

CE Marking

CE marking indicates that a
product complies with

applicable European Union
regulations

ISO 7000/
Graphical symbols

for use on
equipment

0434B /
Warning symbol

Indicates a potentially
hazardous situation which, if
not avoided, could result in
death or serious injury

ISO 7000/
Graphical symbols

for use on
equipment

5036 / Dangerous
Voltage

To indicate hazards arising
from dangerous voltages
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3 Precautions

Read this manual before attempting to use any of the M-Duino GPRS PLC Family and follow its
descriptions for reference during operation.

3.1 Arduino Board

The M-Duino GPRS Family PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in

this manual. Before using M-Duino under different conditions from what has been specified in

this manual or integrating M-Duino to nuclear control systems, railroad systems, aviation

systems, vehicles, combustion systems, medical equipment, amusement machines, safety

equipment and other systems, machines, and equipment that may have a serious influence on

lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure

that the rating and performance characteristics of M-Duino are sufficient for the systems,

machines, and equipment, and be sure to provide the systems, machines, and equipment

double safety mechanisms. This manual provides information for programming and operating

the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different

systems. This means that if an external device or sensor that shares the same ground reference

(GND) with the system is connected, any potential difference between these grounds could

damage the connected components. To avoid issues with interference, ground loops, or

damage to external equipment, ensure that all connected devices share the same ground

reference or use systems with appropriate isolation.

Recommendations:

● Connection Review: Verify that all ground connections are properly made and that

there are no significant potential differences between them.

● Use of Isolation: Consider using galvanic isolators or isolation transformers if it is

necessary to connect equipment with different ground references.
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4 M-Duino Pinout

IOs Table

Model Reference

Analog

Input*¹

Digital Isolated

Input

Digital Isolated

Output

Digital/Analog

Output

Relay

Output

PWM Isolated

output*²

19R+ 006001000100 4 1 0 3 8 3

21+ 006001000200 6 6 5 3 0 3

38AR+ 006001000700 10 6 5 6 8 6

38R+ 006001000300 8 1 0 6 16 6

42+ 006001000400 12 11 10 6 0 6

50RRA+ 006001000900 12 7 4 8 16 8

53ARR+ 006001001000 14 8 5 8 15 8

54ARA+ 006001001100 14 12 9 8 8 8

57AAR+ 006001000800 16 13 10 8 7 8

57R+ 006001000500 12 3 0 8 23 8

58+ 006001000600 16 17 14 8 0 8

*¹ The analog inputs can also be used as digital inputs.

*² The PWM isolated outputs can also be used as digital isolated outputs. The associated PWM

and analog outputs cannot be used at the same time (check switch configuration).
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5 Serigraphy

5.1 A Zone connection (Communications)

Base

A Zone

M-Duino
Connector

Arduino
Pin

Function

AREF
SQW

-
3.3Vdc
5Vdc
GND

AREF
SQW

-
3.3Vdc
5Vdc
GND

Arduino Pin
Arduino Pin

-
Arduino Pin

-
GND

Base

A Zone

M-Duino
Connector

Arduino
Pin

Function

SCL
SDA
RX0
TX0
-
-
TX
RX
Z-
Y+
B-
A+

PIN3
50 SO
51 SI
52 SCK
Reset
Vin5
-

GND
GND
24Vdc

21
20
0
1
-
-
16
17
-
-
-
-
3
50
51
52

Reset
Vin5
-
-
-

I2C/SS
I2C/SS
RX0/SS
TX0/SS

-
-

RX2(serial 2)
TX2(serial 2)

RS485
RS485
RS485
RS485

Arduino Pin
SPI
SPI
SPI
SPI
5V
-

Gnd
Gnd

Power Supply
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SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any

device.

Ethernet Reset USB-B

RTC Programmable button
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5.2 Analog/Digital Zone connection (I/Os)

X Zone

M-Duino
Connector

Function

IX.12
IX.11
IX.10
IX.9
IX.8
IX.7

(-)IX.6
IX.6/INT2

(-)IX.5
IX.5/INT3

(-)IX.4
IX.4

(-)IX.3
IX.3

(-)IX.2
IX.2

(-)IX.1
IX.1

(-)IX.0
IX.0

Analog/Digital In*
Analog/Digital In*
Analog/Digital In
Analog/Digital In
Analog/Digital In
Analog/Digital In

GND IX.6
Interrupt X In**

GND IX.5
Interrupt X In**

GND IX.4
Digital Input*

GND IX.3
Digital Input
GND IX.2

Digital Input
GND IX.1

Digital Input
GND IX.0

Digital Input

*Connectors IX.12, IX.11 and IX.4 are not connected (NC) in D
Zone.
**Connectors IX.6 and IX.5 are not connected (NC) in C Zone and
connector IX.5 is not connected (NC) in B Zone.

2 See section 5.4 to know more about interrupt pins.
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Top Zone

Led indicator I/Os state

X Zone

M-Duino
Connector

Function

GND
AX.7
AX.6
AX.5
QVdc
COM(-)
QX.7
QX.6
QX.5
QX.4
QX.3
QX.2
QX.1
QX.0

GND
Analog Out*
Analog Out
Analog Out

External Isolated Out Vdc
External Isolated Out GND

Digital/PWM Out*
Digital/PWM Out
Digital/PWM Out

Digital Out*
Digital Out
Digital Out
Digital Out
Digital Out

*Connectors AX.7, QX.7 and QX.4 are not connected (NC) in D Zone.

5.3 Relay Zone connection (I/Os)

X Zone

M-Duino
Connector

Function

RX.8
RX.7
RX.6
RX.5
RX.4
AX.2
AX.1
AX.0
GND
QX.2
QX.1
QX.0

COM(-)
QVdc

Relay Out
Relay Out
Relay Out
Relay Out*
Relay Out

Analog Out*
Analog Out
Analog Out

GND
Digital/PWM Out*
Digital/PWM Out
Digital/PWM Out

External Isolated Out Gnd
External Isolated Out Vdc

*Connectors RX.5, AX.2 and QX.2 are not connected (NC) in D Zone.
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Top Zone

Led indicator I/Os state

X Zone

M-Duino Connector Function

RX.3
RX.2
RX.1
GND
IX.5
IX.4
IX.3
IX.2

IX.1/INT3

(-)IX.1
IX.0/INT
(-)IX.0

Relay Out
Relay Out
Relay Out

GND
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input

Interrupt X In**
GND IX.1

Interrupt X In*/**
GND IX.0

*Connector IX.0 is not connected (NC) in B Zone.
**Connectors IX.1 and IX.0 are not connected (NC) in C Zone.

5.4 Interrupt equivalence table

See the Reference Table in order to know the specific device details.

Analog/Digital Relay

Zone PLC Input
PLC

Interrupt
M-Duino Pin PLC Input PLC Interrupt M-Duino Pin

B
0.6 INT1 PIN3 0.1 INT2 PIN3

- - - - - -

C
- - - - - -

- - - - - -

D
2.5 INT3 PIN21 2.1 INT1 PIN21

2.6 INT2 PIN20 2.0 INT0 PIN20

Check this link for more information.

3 See section 5.4 to know more about interrupt pins.
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6 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C

language. They can also be programmed directly using C, but it is much easier working with

Arduino IDE, as it provides lots of useful libraries.

Industrial Shields provide a boards package for programming the PLCs, making it easier and

friendlier. It includes various facilities such as not having to define the pins, etc.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.15 or above (recommended: 1.8.19).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.
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2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board:… -> Boards Manager

5. Search for “industrialshields” on the browser.
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

Once it is selected M-Duino GPRS Family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

Also there are some examples of programming in File -> Examples -> Examples for M-Duino

GPRS family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/Industrial-Shields/
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7 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
M-Duino GPRS Family uses B-USB cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> M-Duino GPRS Family

- Select the correct M-Duino Board (M-Duino 19R+ GPRS in our example).

- Select the correct port.
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8 How to connect PLC to power supply

- M-Duino GPRS Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT

REVERSIBLE!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail:

-12Vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel operation, overvoltage protection, and

overcurrent protection. There is a LED inductor for power status, the power supply is

certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types

of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the

equipment must be separated from the dangerous voltage cables.
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9 Switch configuration

9.1 A Zone: Communications

A Zone

Switch OFF ON

SCL | XX SCL XX

SDA | XX SDA XX

GPRS | - GPRS -

GPRS| - GPRS -

Pin 3 | XX Pin 3 XX

GPRS RST | - GPRS RST -

SD | - SD -

FD | HD FD HD

This is a Switch example from the M-Duino 57R+ GPRS. In this

case, SCL, SDA, I0.1, SD and HD are enabled. This means I2.1, I2.0,

Pin3 and FD are disabled.

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and

disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and

disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

2. GPRS | - : Always at OFF position.

1. GPRS | - : Always at OFF position.
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4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and

disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC

will indicate which input is referred to XX.

3. GPRS RST | - : Always at OFF position.

2. SD | - : Always at OFF position.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If

the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means

Full Duplex. Check section 11.2 for more information.

A Zone

Switch OFF ON

NC - -

NC - -

NC | RTC - RTC

NC | RTC - RTC

This switch enables the communication with RTC using I2C. Having both switches in ON mode

activates the communication, whereas if they are in OFF mode I2C is disabled to reach the RTC.

32



Rev. 6: 03-12-2024

9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON

NC - -

AX.7 | QX.7 AX.7 QX.7

AX.6 | QX.6 AX.6 QX.6

AX.5 | QX.5 AX.5 QX.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know

what number takes X.

We can see here an example switch from the C Zone

(Notice that X takes value 1 here).

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF

it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will

provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, output A2.7 | Q2.7 is not connected.
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9.3 Relay Shield Switches

Relay Shield Switch

Switch OFF ON

NC - -

AX.2 | QX.2 AX.2 QX.2

AX.1 | QX.1 AX.1 QX.1

AX.0 | QX.0 AX.0 QX.0

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know

what number takes X.

We can see here an example switch from the B Zone (Notice

that X takes value 0 here).

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it

can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will

provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, output A2.2 | Q2.2 is not connected.
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10 M-Duino Arduino I/Os 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed

according to Arduino features such as I/Os operating at 5V or any additional features present in

the pins (for example I2C communication in pins SCL and SDA). As these pins are directly

connected to the Arduino Mega board they are not as well protected as the normal inputs.

These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of

these pins the configuration switch must be set to OFF position (see section 9) and some extra

considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TX0 1

RX (RS232) 17
TX (RS232) 16

MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than

5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.

Now it is going to be shown the considerations to operate with these pins.

10.1 I2C pins – SDA/SCL

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it

reads 5V when nothing is connected. The pull-up configuration is established by default in

these pins.

In order to use them as an internal arduino direct PIN at 5V, it has to be considered that they

are pull-up inputs (a 2200Ω resistor is used in the internal pull-up).
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10.2 Serial 0 – RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in

case that all the 5V pins are already performing a function. This is because they are shared with

the USB interface. If using these pins, the USB communication cannot be working at the same

time.

When the PLC is not installed, the USB communication is normally required for debugging,

uploading and intercommunicating with the Ethernet controller. If using both interfaces at the

same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be established as an external pull-up or pull-down circuit in order to correctly work with

these pins.

10.3 SPI – MISO/MOSI/SCK

These pins can only work as 5V pins if the Ethernet protocol is not going to be used. As the

Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours

cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be established as an external pull-up or pull-down circuit in order to correctly work with

these pins.

10.4 Pin 3

To know how to configure this pin correctly, check section 9.

This pin is not established with a pull-up or a pull-down configuration. The state of the pin is

unknown. If the pin must be used, it requires a pull-up or a pull-down configuration. The

Arduino board allows the pin to be set in a pull-up configuration. If not it must be established

as an external pull-up or pull-down circuit in order to correctly work with this pin.
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11 A Zone Features: Communications & RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16

and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not

matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232

implementation.

Click here4 or here5 to see more about this communication.

11.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this

communication. The RS-485 protocol will be always enabled, the only switch that affects is the

one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half

Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485

implementation.

Click here6 or here7 to see more about this communication.

7
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213

6
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195

5
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16

4
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183
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11.3 I2C

I2C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor

is already implemented in the PCB.

I2C communication is configured by switches, so the switches must be configured in order to

enable the I2C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the I2C as it can be used with the

standard library of Arduino called Wire.

Click here8 to see more about this communication.

11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,

MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,

each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 51 SI 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX/TX/Pin3 21/20/1/0/16/17/3

Check the switch configuration at section 9 to enable SS pins.

Click here9 to see more about this communication.

11.5 TTL

M-Duino has two TTL ports, RX0/TX0 and RX/TX. TTL0 is accessed with the function Serial (pins

0 and 1 of the Arduino Mega) and TTL2 is accessed with the function Serial2 (pins 16 and 17 of

the Arduino Mega). See section 9 for more information.

11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with

Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the

M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino

Mega pin 10).

Click here10 and here11 to see more about this communication.

11
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105

10
https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103

9
https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191

8
https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
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11.7 GPRS & GSM

The SIM800L module is the integrated module for the use of GPRS / GSM in this PLC. Its

principal features are:

● Quad-band 850/900/1800/1900MHz.

● Work only with 2G technology.

● Can send / receive SMS messages.

● Can send / receive GPRS data (TCP/IP, HTTP, MQTT).

● Controlled by AT Commands (3GPP TS 27.0077, 27.005 and SIMCOM enhanced AT

Commands).

● AT Command interface with transmission speed “automatic” detection.

● Max. transmission speed: 85.6 Kbps.

● Serial transmission speed: 1200 bps up to 115200 bps (baud rate).

● SIM size: Micro SIM.

When defining the pins in the program, take into account that the internal connections

between the SIM800L module and the Arduino Leonardo are the following:

Arduino Mega Pinout SIM800L Pinout

5Vdc Vcc

GND GND

Rx1 (Pin 19) TxD

Tx1 (Pin 18) RxD

Pin 2 GPRS RESET

The GPRS / GSM protocol is always enabled as there are no switches that configure it. The

protocol uses the Serial 1 pins of the equipment to be able to communicate and the Pin 2 for

the module reset.
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11.8 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the I2C protocol

communication, so it is required to have enabled the I2C protocol. This means 4 switches have

to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the I2C wires to the RTC. If they are in

OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more

information.

Using the boards package of Industrial Shields, there is a library that simplifies the RTC

implementation called RTC.

Click here12 to see more about this feature.

11.9 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol

is always enabled, as there are no switches that configure it. However, there is a switch that

must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch is in ON

mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of

the PLC, it is required to open the plastic found in the frontal part and the socket is located

under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation

called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to

select the Chip Select of the uSD chip.

Click here13 to see more about this feature.

13
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167

12
https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51
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Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the

operation of an online process or machine. Unexpected operation of a process or machine

could result in death or injury to personnel and/or property damage. Before inserting a

memory card, always ensure that the CPU is offline and in a safe state.

Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la

carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le

fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un

processus ou d'une machine peut entraîner la mort ou des blessures corporelles et / ou des

dégâts matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors

ligne et en sécurité.
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12 GPRS & GSM Programming Examples

12.1How to use the GPRS Module

By following the steps on this blog14, you will learn how to work with the GPRS Module that is

inside the PLC. A brief explanation about the examples provided by the Industrial Shields

libraries from GPRS is done.

12.2How to send SMS using GPRS from an M-Duino

Two blogs about how SMSs can be sent using GPRS have been written. The first one talks about

sending SMS when a temperature sensor reaches a certain threshold. You can find the blog

here15.

The second one is about general features of the GPRS module and describes an example from

Adafruit FONA libraries. Click this link16 to go to the blog.

16

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-send-sms-by-using-plc-contro
ller-arduino-296

15

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-send-sms-using-gprs-from-an
-mduino-403

14 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-gprs-module-158
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13 Instructions for interconnection between Industrial

Shields controllers

13.1 RS-232 Communication:

13.2 RS-485 Communication:

13.2.1 Half Duplex

43



Rev. 6: 03-12-2024

13.2.2 Full Duplex

13.3 Ethernet

For Ethernet communication between Industrial Shields equipment an SFTP CAT-6 Ethernet

crossover cable must be used.

14 Digital inputs threshold detection

The M-Duino inputs have a minimum voltage threshold to reliably detect the signal when used

as digital input. The threshold value is different depending on the input type:

44

Input type Threshold voltage (V)

Digital input 4

Analog input 5.1
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15 I/O technical details:

A comparison between the waveforms of the I/Os from the M-Duino GPRS Family PLC and the

Arduino Mega is done in this section.

Digital Output Waveform:

Digital Output Turn-off:

PWM Waveform:
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Analog Out Turn-On:

Analog Out Turn-Off:

Analog /Digital input Turn-on:
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16 Typical Connections
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17 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 188152917

connector from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:

MC 0,5/ 4-G-2,5 - 1881464

MC 0,5/ 6-G-2,5 - 1881480

MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference MC 0,5/10-G-2,5 - 1881529

Height 8.1 mm

Pitch 2.5 mm

Dimension 22.5 mm

Pin dimensions 0.8 x 0.8 mm

Pin spacing 2.5 mm

17 https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529

52

https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529


Rev. 6: 03-12-2024

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 188140618 connector from Phoenix

contact.

In the PLC we can find other connectors too, and these are the references for them:

FK-MC 0,5/ 4-ST-2,5 - 1881341

FK-MC 0,5/ 6-ST-2,5 - 1881367

FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm²

Rigid conduit section max. 0,5 mm²

Flexible conduit section min. 0,14 mm²

Flexible conduit section max. 0,5 mm²

Conduit section AWG/kcmil min. 26

Conduit section AWG/kcmil max. 20

We can also find the relay connectors.

18

https://es.farnell.com/phoenix-contact/fk-mc-0-5-10-st-2-5/plug-libre-muelle-2-5-mm-10-v/dp/1792814
?CMP=KNC-GES-GEN-KWL-PDP-High-Aov-phoenix-contact-15-July-22&mckv=_dc%7Cpcrid%7C60387320
4419%7C&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd4jIzLvIJs5K_3lEpaW5Anqo3FBLu1TwiPFtyKaiP-rj4LSIy6
7bWoaAuLnEALw_wcB
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MCV 1,5/ 2-G-3,81 180342619 is the female connector, andMC 1,5/ 2-ST-3,81, GTIN UPC20 is the

male one. Both are from Phoenix Contact.

Article reference MCV 1,5/ 2-G-3,81 1803426

Height 12.6 mm

Pitch 3.81 mm

Dimension a 3.81 mm

Pin dimensions 0.8 x 0.8 mm

Article reference MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm

Pitch 3.81 mm

Dimension a 3.81 mm

20

https://es.farnell.com/phoenix-contact/1803578/terminal-block-pluggable-2pos/dp/3704907?gclid=Cj0K
CQjw_viWBhD8ARIsAH1mCd6YjA37NqmaaFBXgbRyGExfAM8qDodVOWZPfYsLLQhnVygDn8ufNsIaAmgYE
ALw_wcB&mckv=_dc%7Cpcrid%7C575710444791%7Cplid%7C%7Ckword%7C%7Cmatch%7C%7Cslid%7C
%7Cproduct%7C3704907%7Cpgrid%7C131987845643%7Cptaid%7Cpla-372506228807&CMP=KNC-GES-
GEN-SMART-SHOPPING-High-Jan-2022&gross_price=true

19

https://www.tme.eu/es/details/mcv1.5_2-g-3.81/bloque-de-bornas-extraibles/phoenix-contact/mcv-1-5
-2-g-3-81-1803426/?brutto=1&currency=EUR&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd763F0sGBmfjy5p
mZm9dKysA6ePciWt8md8utGsZX1OfLpgsBx4mnoaAo9GEALw_wcB
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18 DIN Rail mounting

For optimal operation of the product, it must be located in an electrical cabinet with
IK08 mechanical protection. The minimum IP protection degree required is IP56.
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19 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
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above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.
Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by an excess
of temperature.
- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.
- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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20 Revision Table

Revision Number Date Changes

0 29/08/2019 First implementation

1 02/03/2020 Second implementation

2 23/11/2020 Third implementation

3 30/09/2022 M-Duino GPRS Family User Manual Implementation

4 11/03/2024 Added section 14 “Digital inputs threshold detection”

5 26/09/2024 Added section 3.4 (“Isolation Precautions”)

6 03/12/2024 Removed wrong IORef pin reference

About Industrial Shields:

Direction: Camí del Grau, nº25

Zip/Postal Code: 08272

City: Sant Fruitós de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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Preface

This User Guide has been implemented by Boot & Work, S.L. working

under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

● Persons in charge of introducing automation devices.

● Persons who design automation systems.

● Persons who install or connect automation devices.

● Persons who manage working automation installation.

Warnings:

● Unused pins should not be connected. Ignoring the directive may damage the

controller.

● Improper use of this product may severely damage the controller.

● Refer to the controller’s User Guide regarding wiring considerations.

● Before using this product, it is the responsibility of the user to read the product’s User

Guide and all accompanying documentation.

● Maintenance must be performed by qualified personnel familiarised with the

construction, operation, and hazards involved with the control.

● Maintenance should be performed with the control out of operation and disconnected

from all sources of power.

● Care should be taken when servicing electrostatic sensitive components. The

manufacturer's recommendations for these components should be followed.
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● The M-Duino LoRa Family PLCs are Open Type Controllers. It is required that you install

the M-Duino LoRa PLC in a housing, cabinet, or electric control room. Entry to the

housing, cabinet, or electric control room should be limited to authorised personnel.

Failure to follow these installation requirements could result in severe personal injury

and/or property damage. Always follow these requirements when installing M-Duino

family PLCs.

● In case of installation or maintenance of the M-Duino please follow the instructions

marked in the Installation and Maintenance section.

● Do not disconnect equipment when a flammable or combustible atmosphere is

present. Disconnection of equipment when a flammable or combustible atmosphere is

present may cause a fire or explosion which could result in death, serious injury and/or

property damage.

Avertissements:

● Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut

endommager le contrôleur.

● Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur.

● Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de

câblage.

● Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du

produit et la documentation qui l’accompagne.

● La maintenance doit être effectuée par personnel qualifié familiarisé avec la

fabrication, le fonctionnement et les dangers liés au contrôleur.

● La maintenance doit être effectuée avec l’équipement hors service et déconnectée de

toutes les sources d'alimentation.

● Faites attention lors de l'entretien des composants sensibles à l'électricité statique. Les

recommandations du fabricant pour ces composants doivent être suivies.

● Les automates de la famille M-Duino sont des contrôleurs de type ouvert. Il est

nécessaire d'installer l'automate M-Duino dans un boîtier, une armoire ou une salle de

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences

d'installation peut entraîner des blessures graves et/ou des dommages matériels

importants. Respectez toujours ces exigences lors de l'installation des automates de la

famille M-Duino.

● En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions

indiquées dans la section Installation et Maintenance.

● Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou

combustible. La déconnexion de l'équipement en présence d'une atmosphère

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant

entraîner la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and understand this manual

Please read and understand this manual before using the product. Please consult your

comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT

BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF

PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING

THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE

INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND

INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or

standards that apply to the combination of products in the customer’s application or use of the

product.

The following are some examples of applications for which particular attention must be given.

This is not intended to be an exhaustive list of all possible uses of the products, nor is it

intended to imply that the uses may be suitable for the products:

● Systems, machines, and equipment that could present a risk to life or property.

● Nuclear energy control systems, combustion systems, railroad systems, aviation

systems, medical equipment, amusement machines, vehicles, safety equipment, and

installation subject to separate industry or government regulations.

● Outdoor use, uses involving potential chemical contamination or electrical

interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification

documents identifying ratings and limitations of use that apply to the products. This

information by itself is not sufficient for a complete determination of the suitability of the

products in combination with the system, machine, end product, or other application or use.
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Intended use of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the

catalogue and the associated technical documentation. If third-party products and components

are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,

installation, assembly, operation and maintenance have been carried out in a correct manner. It

must respect the permissible ambient conditions. You should also follow the indications and

warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated

by qualified personnel for the task entrusted and observing what is indicated in the

documentation corresponding to it, particularly the safety instructions and warnings included

in it. Due to their training and experience, qualified personnel are in a position to recognize

risks resulting from the handling or manipulation of such products / systems and to avoid

possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even

when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining

suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL

SHIELDS’s test conditions, and the users most correlate it to actual application requirements.

Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;

however, no responsibility is assumed for clerical, typographical, or proofreading errors, or

omissions.

Residual Risks

The control and drive components of an Industrial Shields PLC are approved for industrial and

commercial use in industrial line supplies. Their use in public line supplies requires a different

configuration and/or additional measures. These components may only be operated in closed

housings or in higher-level control cabinets with protective covers that are closed, and when all

of the protective devices are used. These components may only be handled by qualified and

trained technical personnel who are knowledgeable and observe all of the safety information

and instructions on the components and in the associated technical user documentation.

When carrying out a risk assessment of a machine in accordance with the EU Machinery

Directive, the machine manufacturer must consider the following residual risks associated with

the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,

maintenance, and repairs caused by, for example: − Hardware defects and/or software errors in

the sensors, controllers, actuators, and connection technology − Response times of the

controller and drive − Operating and/or ambient conditions not within the scope of the

specification − Condensation / conductive contamination − Parameterization, programming,

cabling, and installation errors − Use of radio devices / cellular phones in the immediate

vicinity of the controller − External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for

example: − Component malfunctions − Software errors − Operating and/or ambient

conditions not within the scope of the specification − External influences / damage.

3. Hazardous shock voltages caused by, for example: − Component malfunctions − Influence of

electrostatic charging − Induction of voltages in moving motors − Operating and/or ambient

conditions not within the scope of the specification − Condensation / conductive

contamination − External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to

people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the

system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials

and workmanship for a period of one year (or other period if specified) from date of sale by

Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,

REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE

OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR

INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR

IMPLIED.

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL

DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE

PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR

STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER

CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT

THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT

SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

Recognized
Component ETL Classified

Conforms to:
UL Std. 61010-1
UL Std. 61010-2-201
Cert. To CSA Std. C22.2 No. 61010-1
Cert. ToCSA Std. C22.2 No.61010-2-201

Place for control
number:
5016476
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1 General Description M-DUINO LoRa product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is important

to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from

below and D the shield from above. Having a B and a C in the middle of them.:

● The inputs in the zone B are named I0.X, being X any number suitable in the Shield.
Outputs are named as Q0.X and relays as R0.X

● The inputs in the zone C are named I1.X, being X any number suitable in the Shield.
Outputs are named as Q1.X and relays as R1.X

● The inputs in the zone D are named I2.X, being X any number suitable in the Shield.
Outputs are named as Q2.X and relays as R2.X
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1.2 Reference table

Reference Table

Model Reference

PLC M-Duino General Family

M-DUINO PLC Arduino Ethernet & LoRa 19R I/Os Relay / Analog / Digital PLUS 015001000100

M-DUINO PLC Arduino Ethernet & LoRa 21 I/Os Analog/Digital PLUS 015001000200

M-DUINO PLC Arduino Ethernet & LoRa 38R I/Os Relay / Analog / Digital PLUS 015001000300

M-DUINO PLC Arduino Ethernet & LoRa 38AR I/Os Relay / Analog / Digital PLUS 015001000700

M-DUINO PLC Arduino Ethernet & LoRa 42 I/Os Analog/Digital PLUS 015001000400

M-DUINO PLC Arduino Ethernet & LoRa 50RRA I/Os Relay / Analog / Digital PLUS 015001000900

M-DUINO PLC Arduino Ethernet & LoRa 53ARR I/Os Relay / Analog / Digital PLUS 015001001000

M-DUINO PLC Arduino Ethernet & LoRa 54ARA I/Os Relay / Analog / Digital PLUS 015001001100

M-DUINO PLC Arduino Ethernet & LoRa 57AAR I/Os Relay / Analog / Digital PLUS 015001000800

M-DUINO PLC Arduino Ethernet & LoRa 57R I/Os Relay / Analog / Digital PLUS 015001000500

M-DUINO PLC Arduino Ethernet & LoRa 58 I/Os Analog/Digital PLUS 015001000600

To find the reference of your M-Duino LoRa PLC, check the arrow in the picture below. In the

example, the reference is:

11
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1.3 Zones Table

Zones Table

Model Zone A Zone B Zone C Zone D

M-Duino LoRa PLC 19R+ ✔ Relay - -

M-Duino LoRa PLC 21+ ✔ Analog / Digital - -

M-Duino LoRa PLC 38R+ ✔ Relay Relay -

M-Duino LoRa PLC 38AR+ ✔ Analog / Digital Relay -

M-Duino LoRa PLC 42+ ✔ Analog / Digital Analog / Digital -

M-Duino LoRa PLC 50RRA+ ✔ Relay Relay Analog / Digital

M-Duino LoRa PLC 53ARR+ ✔ Analog / Digital Relay Relay

M-Duino LoRa PLC 54ARA+ ✔ Analog / Digital Relay Analog / Digital

M-Duino LoRa PLC 57AAR+ ✔ Analog / Digital Analog / Digital Relay

M-Duino LoRa PLC 57R+ ✔ Relay Relay Relay

M-Duino LoRa PLC 58+ ✔ Analog / Digital Analog / Digital Analog / Digital

The distribution of the different features that provide the M-Duino LoRa PLC Family is the

following one:

Shield B Zone C Zone D Zone

Analog Shield

12 Inputs
(12 Digital Inputs, 6
of which can work as

Analog Input)

8 Outputs
(8 Digital Outputs, 3
of which can work as

Analog Output)

13 Inputs
(13 Digital Inputs, 6
of which can work as

Analog Input)

8 Outputs
(8 Digital Outputs, 3
of which can work as

Analog Output)

10 Inputs
(10 Digital Inputs, 4
of which can work as

Analog Input)

4 Outputs
(4 Digital Outputs)

Relay Shield

5 inputs
(5 Digital Inputs, 4 of
which can work as

Analog Input)

3 Outputs
(3 Digital Outputs, 3
of which can work as

Analog Output)

8 Relays

6 inputs
(5 Digital Inputs, 4 of
which can work as

Analog Input)

3 Outputs
(3 Digital Outputs, 3
of which can work as

Analog Output)

8 Relays

6 inputs
(6 Digital Inputs, 4 of
which can work as

Analog Input)

0 Outputs

7 Relays

12
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1.4 A Zone Features

Shield A Zone

Communication

Shield

(1x) Ethernet

(1x) USB

(1x) I2C

(2x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485

(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

(1x) LoRa

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) Width (mm) Depth (mm) Max weight (g)

M-Duino LoRa PLC 19R+ 119.5 70.1 101 394

M-Duino LoRa PLC 21+ 119.5 70.1 101 394

M-Duino LoRa PLC 38R+ 119.5 94.7 101 504

M-Duino LoRa PLC 38AR+ 119.5 94.7 101 504

M-Duino LoRa PLC 42+ 119.5 94.7 101 504

M-Duino LoRa PLC 50RRA+ 119.5 119.3 101 614

M-Duino LoRa PLC 53ARR+ 119.5 119.3 101 614

M-Duino LoRa PLC 54ARA+ 119.5 119.3 101 614

M-Duino LoRa PLC 57AAR+ 119.5 119.3 101 614

M-Duino LoRa PLC 57R+ 119.5 119.3 101 614

M-Duino LoRa PLC 58+ 119.5 119.3 101 614
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1.6 General Features

CONNECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE Controller General Specifications Information

Input Voltage
12 to 24Vdc

Fuse protection (2.5A)
Polarity protection

Input rated voltage
24 Vdc

Rated Power 30W

I max. 1.5A

Size Check size and weight table

Clock Speed 16MHz

Flash Memory 256KB of which 8KB used by bootloader

SRAM 8KB

EEPROM 4KB

Communications
I2C – Ethernet Port – USB – RS485 – RS232 – SPI – (2x)

RX, TX (Arduino pins)
Max232-Max485-W5500 -

Sim800L

USB consideration!
Only meant for uploading or debugging, not always

connected as a serial in a project!
Cannot be working in a final

application

An/Dig Input 10bit
(0-10Vcc)

0 to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vdc

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc

Max read time: 116 us

*Check Section 14 for digital
inputs threshold detection

Digital Isolated Input
(24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc

All Digital Inputs are PNP .
Click here1 for more information.

Max read time: 8us

* Interrupt isolated
Input HS (24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc
Max read time: 8us

Analog Output 8bit
(0-10Vcc)

0 to 10Vdc
I max: 20mA

Separated PCB ground
Rated Voltage: 10Vdc

Output frequency: 2Hz

Rising edge time: 150ms
Falling edge time: 252ms

Digital Isolated Output
(24Vcc)

5 to 24Vdc
I max: 70mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Imax 24Vdc: 410mA

With 70us delay,
freq is 6.849MHz

with pulse width of 106us

Rising edge time: 476ns
Falling edge time: 42.8us

1 https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193
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Digital Isolated Output
Relay

30Vdc / 250Vac
Galvanic Isolation

Diode protected for Relay
Imax: 3A (30Vdc)
Imax: 5A (250Vac)

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Direct Arduino Pin
Output

0 to 5Vdc
I max: 40mA

Rated Voltage: 5Vdc

Max frequency: 77kHz

Rising edge time: 200ns
Falling edge time: 200ns

Direct Arduino Pin
Input

0 to 5Vdc
I max: 40mA

Rated Voltage: 5Vdc
Max read time: 8us

I2C Pin
5V Pull-up

Max frequency: 100kHz
Rising edge time: 10us
Falling edge time: 150ns

One-Wire Pin
Usable pins:

Pin3, SCL, SDA, RX0, TX0,
RX1, TX1, MISO, MOSI, SCK

Frequency: 800kHz

Expandability I2C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)
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1.7 Power consumption of the M-Duino LoRa Family PLCs

Model Current resting
(mA)

Power resting
(W)

Current active
(mA)

Power active
(W)

21+ 99 2,376 120 2,88

42+ 92 2,208 128 3,072

58+ 76 1,824 126 3,024

19R+ 80 1,92 202 4,848

38R+ 77 1,848 313 7,512

57R+ 73 1,752 425 10,2

38AR+ 72 1,728 221 5,304

53ARR+ 71 1,704 323 7,752

57AAR+ 71 1,704 221 5,304

54ARA+ 76 1,824 231 5,544

50RRA+ 82 1,968 322 7,728

The power consumption is measured at 24Vdc.

The current resting column denotes the minimum current drawn by the PLC when all outputs
are at a LOW level, representing the PLC's baseline power consumption.

In contrast, the current active column reflects the current drawn by the PLC when all outputs
are at a HIGH level, and there are no connections to any of the outputs. While this value is not
the absolute maximum the Arduino based PLC can draw, it serves as a reference point for
expected current values.

It's important to note that the practical maximum current may vary depending on the type of
actuators connected to the outputs and the number of I/Os used. The actual consumption can
be influenced by the specific configuration and load connected to the PLC's outputs."
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2 Technical Specifications

2.1 General Specifications

Item M-Duino LoRa Family PLC

Power supply
voltage

DC power supply 12 to 24Vdc

Operating
voltage range

DC power supply 11.4 to 25.4Vdc

Power
consumption

DC power supply 30W max.

External power
supply

Power supply
voltage

24Vdc

Power supply
output capacity

700mA

Insulation resistance 20MΩmin.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength
2.300Vac at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the external

AC terminals and the protective ground terminal.

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each.

Ambient temperature (operating) 0º to 60ºC

Ambient humidity (operating) 10% to 90% (no condensation)

Ambient environment (operating) With no corrosive gas

Ambient temperature (storage) -20º to 60ºC

Power supply holding time 2ms min.

Weight Check size and weight table

2.2 Performance Specification

Arduino Board ARDUINO MEGA 2560

Control method Stored program method

I/O control method Combination of the cyclic scan and immediate refresh processing methods.

Programming language
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a

programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega2560

Flash Memory 256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB

EEPROM 4KB

Clock Speed 16MHz

17
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2.3 Symbology

Table that includes all the symbology that is used in the serigraph of the M-Duino LoRa PLC

Family:

Symbol Standard No. /
Standard Title

Standard
Reference No. /
Symbol Title

Symbol Meaning

IEC 60417 /
Graphical symbols

for use on
equipment

5031 / Direct
Current

Indicates that the equipment is
suitable for direct current only;
to identify relevant terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5032 / Alternating
Current

Indicates that the equipment is
suitable for alternating current

only; to identify relevant
terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5130 / Pulse
General

To identify the control by which
a pulse is started.

IEC 60417 /
Graphical symbols

for use on
equipment

5017 / Earth,
Ground

To identify an earth (ground)
terminal in cases where

neither the symbol 5018 nor
5019 is explicitly required.

IEC 60417 /
Graphical symbols

for use on
equipment

5115 / Signal lamp

To identify the switch by
means of which the signal

lamp(s) is (are) switched on or
off.

2004/108/EC /
Electromagnetic
Compatibility

CE Marking

CE marking indicates that a
product complies with

applicable European Union
regulations

ISO 7000/
Graphical symbols

for use on
equipment

0434B /
Warning symbol

Indicates a potentially
hazardous situation which, if
not avoided, could result in
death or serious injury

ISO 7000/
Graphical symbols

for use on
equipment

5036 / Dangerous
Voltage

To indicate hazards arising
from dangerous voltages

18
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3 Precautions

Read this manual before attempting to use any of the M-Duino LoRa PLC Family and follow its
descriptions for reference during operation.

3.1 Arduino Board

The M-Duino LoRa Family PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in

this manual. Before using M-Duino under different conditions from what has been specified in

this manual or integrating M-Duino to nuclear control systems, railroad systems, aviation

systems, vehicles, combustion systems, medical equipment, amusement machines, safety

equipment and other systems, machines, and equipment that may have a serious influence on

lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure

that the rating and performance characteristics of M-Duino are sufficient for the systems,

machines, and equipment, and be sure to provide the systems, machines, and equipment

double safety mechanisms. This manual provides information for programming and operating

the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different

systems. This means that if an external device or sensor that shares the same ground reference

(GND) with the system is connected, any potential difference between these grounds could

damage the connected components. To avoid issues with interference, ground loops, or

damage to external equipment, ensure that all connected devices share the same ground

reference or use systems with appropriate isolation.

Recommendations:

● Connection Review: Verify that all ground connections are properly made and that

there are no significant potential differences between them.

● Use of Isolation: Consider using galvanic isolators or isolation transformers if it is

necessary to connect equipment with different ground references.
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4 M-Duino Pinout

IOs Table

Model Reference
Analog

Input*¹

Digital Isolated

Input

Digital Isolated

Output

Digital/Analog

Output

Relay

Output

PWM Isolated

Outputs*²

19R+ 015001000100 4 1 0 3 8 3

21+ 015001000200 6 6 5 3 0 3

38AR+ 015001000300 10 7 5 6 8 6

38R+ 015001000300 8 3 0 6 16 6

42+ 015001000400 12 13 10 6 0 6

50RRA+ 015001000900 12 9 4 6 16 6

53ARR+ 015001001000 14 10 5 6 15 6

54ARA+ 015001001100 14 14 9 6 8 6

57AAR+ 015001000800 16 15 10 6 7 6

57R+ 015001000500 12 5 0 6 23 6

58+ 015001000600 16 19 14 6 0 6

*¹ The analog inputs can also be used as digital inputs.

*² The PWM isolated outputs can also be used as digital isolated outputs. The associated PWM

and analog outputs cannot be used at the same time (check switch configuration).
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5 Serigraphy

5.1 A Zone connection (Communications)

Base

A Zone

M-Duino
Connector

Arduino
Pin

Function

AREF
SQW

-
3.3Vdc
5Vdc
GND

AREF
SQW

-
3.3Vdc
5Vdc
GND

Arduino Pin
Arduino Pin

-
Arduino Pin

-
GND

Base

A Zone

M-Duino
Connector

Arduino
Pin

Function

SCL
SDA
RX0
TX0
RX1
TX1
TX
RX
Z-
Y+
B-
A+

PIN3
50 SO
51 SI
52 SCK
Reset
Vin5
-

GND
GND
24Vdc

21
20
0
1
19
18
16
17
-
-
-
-
3
50
51
52

Reset
Vin5
-
-
-

I2C/SS
I2C/SS
RX0/SS
TX0/SS

RX1(serial 1)
TX1(serial 1)
RX2(serial 2)
TX2(serial 2)

RS485
RS485
RS485
RS485

Arduino Pin
SPI
SPI
SPI
SPI
5V
-

Gnd
Gnd

Power Supply
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SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any

device.

Ethernet Reset USB-B

RTC Programmable button
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5.2 Analog/Digital Zone connection (I/Os)

X Zone

M-Duino
Connector

Function

IX.12
IX.11
IX.10
IX.9
IX.8
IX.7

(-)IX.6
IX.6/INT2

(-)IX.5
IX.5/INT3

(-)IX.4
IX.4

(-)IX.3
IX.3

(-)IX.2
IX.2

(-)IX.1
IX.1

(-)IX.0
IX.0

Analog/Digital In*
Analog/Digital In*
Analog/Digital In
Analog/Digital In
Analog/Digital In
Analog/Digital In

GND IX.6
Interrupt X In

GND IX.5
Interrupt X In
GND IX.4*

Digital Input*
GND IX.3

Digital Input
GND IX.2

Digital Input
GND IX.1

Digital Input
GND IX.0

Digital Input

*Connectors IX.12, IX.11 and IX.4 are not connected (NC) in D Zone

Top Zone

Led indicator I/Os state

X Zone

M-Duino
Connector

Function

GND
AX.7
AX.6
AX.5
QVdc
COM(-)
QX.7
QX.6
QX.5
QX.4
QX.3
QX.2
QX.1
QX.0

GND
Analog Out*
Analog Out*
Analog Out*

External Isolated Out Vdc
External Isolated Out GND

Digital/PWM Out*
Digital/PWM Out*
Digital/PWM Out*

Digital Out*
Digital Out
Digital Out
Digital Out
Digital Out

*Connectors AX.7, AX.6, AX.5, QX.7, QX.6, QX.5 and QX.4 are not connected (NC) in D Zone.

2 See section 5.4 to know more about interrupt pins.
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5.3 Relay Zone connection (I/Os)

X Zone

M-Duino
Connector

Function

RX.8
RX.7
RX.6
RX.5
RX.4
AX.2
AX.1
AX.0
GND
QX.2
QX.1
QX.0

COM(-)
QVdc

Relay Out
Relay Out
Relay Out
Relay Out*
Relay Out

Analog Out*
Analog Out*
Analog Out*

GND*
Digital/PWM Out*
Digital/PWM Out*
Digital/PWM Out*

External Isolated Out Gnd
External Isolated Out Vdc

*Connectors RX.5, AX.2, AX.1, AX.0, GND, QX.2, QX.1, QX.0 and are not

connected (NC) in D Zone.

Top Zone

Led indicator I/Os state

X Zone

M-Duino Connector Function

RX.3
RX.2
RX.1
GND
IX.5
IX.4
IX.3
IX.2

IX.1/INT3

(-)IX.1
IX.0/INT4

(-)IX.0

Relay Out
Relay Out
Relay Out

GND
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input

Interrupt X In
GND IX.1

Interrupt X In
GND IX.0

3 See section 5.4 to know more about interrupt pins.
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5.4 Interrupt equivalence table

See the Reference Table in order to know the specific device details.

Analog/Digital Relay

Zone PLC Input

PLC

Interrupt M-Duino Pin PLC Input PLC Interrupt M-Duino Pin

B
0.6 INT1 PIN3 0.1 INT2 PIN3

- - - - - -

C
1.6 INT4 PIN19 1.1 INT4 PIN19

1.5 INT5 PIN18 1.0 INT5 PIN18

D
2.5 INT3 PIN21 2.1 INT1 PIN21

2.6 INT2 PIN20 2.0 INT0 PIN20

Check this link for more information.

25

https://www.industrialshields.com/blog/arduino-industrial-1/post/external-interrupt-using-hall-effect-sensor-with-arduino-based-plc-109


Rev. 6: 03-12-2024

6 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C

language. They can also be programmed directly using C, but it is much easier working with

Arduino IDE, as it provides lots of useful libraries.

Industrial Shields provide a boards package for programming the PLCs, making it easier and

friendlier. It includes various facilities such as not having to define the pins, etc.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.15 or above (recommended: 1.8.19).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.
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2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board:… -> Boards Manager

5. Search for “industrialshields” on the browser.
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

Once it is selected M-Duino LoRa Family, an extra option will appear on Tools:

There, it can select the exact model for every family.

Also there are some examples of programming in File -> Examples -> Examples for M-Duino

LoRa family.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/Industrial-Shields/
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7 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
M-Duino LoRa Family uses B-USB cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> M-Duino LoRa Family

- Select the correct M-Duino Board (M-Duino 19R+ LoRa in our example).

- Select the correct port.
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8 How to connect PLC to power supply

- M-Duino LoRa Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT

REVERSIBLE!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail:

-12Vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel operation, overvoltage protection, and

overcurrent protection. There is a LED inductor for power status, the power supply is

certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types

of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the

equipment must be separated from the dangerous voltage cables.
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9 Switch configuration

9.1 A Zone: Communications

A Zone

Switch OFF ON

SCL | XX SCL XX

SDA | XX SDA XX

RX1 | XX RX1 XX

TX1 | XX TX1 XX

Pin 3 | XX Pin 3 XX

LoRa | NC LoRa NC

SD | XX SD XX

FD | HD FD HD

This is an D Zone Switch example from M-Duino 58+ LoRa. In

this case, SCL, SDA, Pin 3, LoRa, SD and FD are enabled. This

means I2.6, I2.5, I1.6, I1.5, I0.6, Q2.0 and HD are disabled.

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and

disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and

disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

2. RX1 | XX: Choosing between RX1 or the input XX. If the switch is ON, it enables XX and

disables RX1. If the switch is OFF, it enables RX1 and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

31



Rev. 6: 03-12-2024

1. TX1 | XX: Choosing between TX1 or the input XX. If the switch is ON, it enables XX and

disables TX1. If the switch is OFF, it enables TX1 and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and

disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC

will indicate which input is referred to XX.

3. LoRa | NC: Choosing between LoRa communication or NC. If the switch is ON, it disables

LoRa. If the switch is OFF, it enables LoRa.

2. SD | XX: Choosing between SD or the input XX. If the switch is ON, it enables XX and disables

SD. If the switch is OFF, it enables SD and disables XX. The serigraphy in the PLC will indicate

which input is referred to XX.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If

the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means

Full Duplex. Check section 11.2 for more information.

A Zone

Switch OFF ON

NC - -

NC - -

NC | RTC - RTC

NC | RTC - RTC

This switch enables the communication with RTC using I2C. Having both switches in ON mode

activates the communication, whereas if they are in OFF mode I2C is disabled to reach the RTC.
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9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON

NC - -

AX.7 | QX.7 AX.7 QX.7

AX.6 | QX.6 AX.6 QX.6

AX.5 | QX.5 AX.5 QX.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know

what number takes X.

We can see here an example switch from the C Zone

(Notice that X takes value 1 here).

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF

it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will

provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, no connectors are connected (NC).
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9.3 Relay Shield Switches

Relay Shield Switch

Switch OFF ON

NC - -

AX.2 | QX.2 AX.2 QX.2

AX.1 | QX.1 AX.1 QX.1

AX.0 | QX.0 AX.0 QX.0

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know

what number takes X.

We can see here an example switch from the B Zone (Notice

that X takes value 0 here).

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it

can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will

provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, no connectors are connected (NC).
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10 M-Duino Arduino I/Os 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed

according to Arduino features such as I/Os operating at 5V or any additional features present in

the pins (for example I2C communication in pins SCL and SDA). As these pins are directly

connected to the Arduino Mega board they are not as well protected as the normal inputs.

These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of

these pins the configuration switch must be set to OFF position (see section 9) and some extra

considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TX0 1
RX1 19 Communication switch: OFF
TX1 18 Communication switch: OFF
RX 17
TX 16

MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than

5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.

Now it is going to be shown the considerations to operate with these pins.

10.1 I2C pins – SDA/SCL

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it

reads 5V when nothing is connected. The pull-up configuration is established by default in

these pins.

If it is meant to use them as an internal arduino direct PIN at 5V, it has to be considered that

they are pull-up inputs (2200Ω resistor is used in the internal pull-up).
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10.2 Serial 0 – RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in

case that all the 5V pins are already performing a function. This is because they are shared with

the USB interface. If using these pins, the USB communication cannot be working at the same

time.

When the PLC is not installed, the USB communication is normally required for debugging,

uploading and intercommunicating with the Ethernet controller. If using both interfaces at the

same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,

they must be configured as an external pull-up or pull-down circuit in order to correctly work.

10.3 Serial 1 – RX1/TX1

To know how to configure these pins correctly, check section 9. If not using the Serial 1

interface these pins can work as digital, either input or output.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,

they must be configured as an external pull-up or pull-down circuit in order to correctly work.

10.4 SPI – MISO/MOSI/SCK

These pins can only work as 5V pins if the Ethernet protocol is not going to be used. As the

Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours

cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not,

they must be configured as an external pull-up or pull-down circuit in order to correctly work.

10.5 Pin 3

To know how to configure this pin correctly, check section 9.

This pin is not established with a pull-up or a pull-down configuration. The state of the pin is

unknown. If the pin must be used, it requires a pull-up or a pull-down configuration. The

Arduino board allows the pin to be set in a pull-up configuration. If not, it must be established

as an external pull-up or pull-down circuit in order to correctly work with this pin.
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11 A Zone Features: Communications & RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16

and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not

matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232

implementation.

Click here4 or here5 to see more about this communication.

11.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this

communication. The RS-485 protocol will be always enabled, the only switch that affects is the

one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half

Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485

implementation.

Click here6 or here7 to see more about this communication.

7
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213

6
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195

5
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16

4
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183
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11.3 I2C

I2C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor

is already implemented in the PCB.

I2C communication is configured by switches, so the switches must be configured in order to

enable the I2C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the I2C as it can be used with the

standard library of Arduino called Wire.

Click here8 to see more about this communication.

11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,

MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,

each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 51 SI 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/Pin3 21/20/1/0/19/18/15/14/3

Check the switch configuration at section 9 to enable SS pins.

Click here9 to see more about this communication.

11.5 TTL

M-Duino has one TTL port, RX0/TX0. TTL0 is accessed with the function Serial (pins 0 and 1 of

the Arduino Mega). See section 9 for more information.

11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with

Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the

M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino

Mega pin 10).

Click here10 and here11 to see more about this communication.

11
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105

10
https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103

9
https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191

8
https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
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11.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the I2C protocol

communication, so it is required to have enabled the I2C protocol. This means 4 switches have

to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the I2C wires to the RTC. If they are in

OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more

information.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation

called RTC.

Click here12 to see more about this feature.

11.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol

is always enabled, as there are no switches that configure it. However, there is a switch that

must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch is in ON

mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of

the PLC, it is required to open the plastic found in the frontal part and the socket is located

under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation

called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to

select the Chip Select of the uSD chip.

Click here13 to see more about this feature.

13
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167

12
https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51
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Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the

operation of an online process or machine. Unexpected operation of a process or machine

could result in death or injury to personnel and/or property damage. Before inserting a

memory card, always ensure that the CPU is offline and in a safe state.

Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la

carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le

fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un

processus ou d'une machine peut entraîner la mort ou des blessures corporelles et / ou des

dégâts matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors

ligne et en sécurité.
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12 Examples

12.1What is LoRa and LoRaWAN?

For more information of the LoRa modulation, check this post14. In it you will find everything

you need to know about this communication.

To learn about the LoRaWAN protocol look at this other link15. A deep description and

explanation about the protocol is done in this blog

12.2How to work with LoRaWAN and a PLC controller

If interested on working with LoRaWAN and a PLC controller this post16 may be helpful. In

addition, two examples are provided using the authentication methods OTAA or ABP. With

them, you will be able to communicate between the PLC and The Things Network.

16

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-work-with-lorawan-and-a-plc-
controller-255

15 https://www.industrialshields.com/blog/arduino-industrial-1/post/what-is-lorawan-253

14 https://www.industrialshields.com/blog/arduino-industrial-1/post/what-is-lora-254
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13 Instructions for interconnection between Industrial

Shields controllers

13.1 RS-232 Communication:

13.2 RS-485 Communication:

13.2.1 Half Duplex

13.2.2 Full Duplex
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13.3 Ethernet

For Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.

14 Digital inputs threshold detection

The M-Duino inputs have a minimum voltage threshold to reliably detect the signal when used

as digital input. The threshold value is different depending on the input type:

43

Input type Threshold voltage (V)

Digital input 4

Analog input 5.1
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15 I/O technical details:

A comparison between the waveforms of the I/Os from the M-Duino LoRa Family PLC and the

Arduino Mega is done in this section.

Digital Output Waveform:

Digital Output Turn-off:

PWM Waveform:
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Analog Out Turn-On:

Analog Out Turn-Off:

Analog /Digital input Turn-on:
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16 Typical Connections

46



Rev. 6: 03-12-2024

47



Rev. 6: 03-12-2024

48



Rev. 6: 03-12-2024

49



Rev. 6: 03-12-2024

50



Rev. 6: 03-12-2024

17 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 188152917

connector from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:

MC 0,5/ 4-G-2,5 - 1881464

MC 0,5/ 6-G-2,5 - 1881480

MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference MC 0,5/10-G-2,5 - 1881529

Height 8.1 mm

Pitch 2.5 mm

Dimension 22.5 mm

Pin dimensions 0.8 x 0.8 mm

Pin spacing 2.5 mm

17 https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529
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For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 188140618 connector from Phoenix

contact.

In the PLC we can find other connectors too, and these are the references for them:

FK-MC 0,5/ 4-ST-2,5 - 1881341

FK-MC 0,5/ 6-ST-2,5 - 1881367

FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm²

Rigid conduit section max. 0,5 mm²

Flexible conduit section min. 0,14 mm²

Flexible conduit section max. 0,5 mm²

Conduit section AWG/kcmil min. 26

Conduit section AWG/kcmil max. 20

We can also find the relay connectors.

18

https://es.farnell.com/phoenix-contact/fk-mc-0-5-10-st-2-5/plug-libre-muelle-2-5-mm-10-v/dp/1792814
?CMP=KNC-GES-GEN-KWL-PDP-High-Aov-phoenix-contact-15-July-22&mckv=_dc%7Cpcrid%7C60387320
4419%7C&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd4jIzLvIJs5K_3lEpaW5Anqo3FBLu1TwiPFtyKaiP-rj4LSIy6
7bWoaAuLnEALw_wcB
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MCV 1,5/ 2-G-3,81 180342619 is the female connector, andMC 1,5/ 2-ST-3,81, GTIN UPC20 is the

male one. Both are from Phoenix Contact.

Article reference MCV 1,5/ 2-G-3,81 1803426

Height 12.6 mm

Pitch 3.81 mm

Dimension a 3.81 mm

Pin dimensions 0.8 x 0.8 mm

Article reference MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm

Pitch 3.81 mm

Dimension a 3.81 mm

20

https://es.farnell.com/phoenix-contact/1803578/terminal-block-pluggable-2pos/dp/3704907?gclid=Cj0K
CQjw_viWBhD8ARIsAH1mCd6YjA37NqmaaFBXgbRyGExfAM8qDodVOWZPfYsLLQhnVygDn8ufNsIaAmgYE
ALw_wcB&mckv=_dc%7Cpcrid%7C575710444791%7Cplid%7C%7Ckword%7C%7Cmatch%7C%7Cslid%7C
%7Cproduct%7C3704907%7Cpgrid%7C131987845643%7Cptaid%7Cpla-372506228807&CMP=KNC-GES-
GEN-SMART-SHOPPING-High-Jan-2022&gross_price=true

19

https://www.tme.eu/es/details/mcv1.5_2-g-3.81/bloque-de-bornas-extraibles/phoenix-contact/mcv-1-5
-2-g-3-81-1803426/?brutto=1&currency=EUR&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd763F0sGBmfjy5p
mZm9dKysA6ePciWt8md8utGsZX1OfLpgsBx4mnoaAo9GEALw_wcB
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18 DIN Rail mounting

For optimal operation of the product, it must be located in an electrical cabinet with
IK08 mechanical protection. The minimum IP protection degree required is IP56.
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19 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause a misact.

- Use shielded twisted pairs for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.
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Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.
Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25 cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by an excess
of temperature.
- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
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and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.
- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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20 Revision Table

Revision Number Date Changes

0 27/08/2020 First implementation

1 01/12/2021 I/O’s serigraphy changed

2 04/10/2022 M-Duino LoRa Family User Manual Implementation

3 27/07/2023 Pinout count changed

4 11/03/2024 Added section 14 “Digital inputs threshold detection”

5 26/09/2024 Added section 3.4 (“Isolation Precautions”)

6 03/12/2024 Removed wrong IORef pin reference

About Industrial Shields:

Direction: Camí del Grau, nº25

Zip/Postal Code: 08272

City: Sant Fruitós de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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Preface

This User Guide has been implemented by Boot & Work, S.L. working

under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

● Persons in charge of introducing automation devices.

● Persons who design automation systems.

● Persons who install or connect automation devices.

● Persons who manage working automation installation.

Warnings:

● Unused pins should not be connected. Ignoring the directive may damage the

controller.

● Improper use of this product may severely damage the controller.

● Refer to the controller’s User Guide regarding wiring considerations.

● Before using this product, it is the responsibility of the user to read the product’s User

Guide and all accompanying documentation.

● Maintenance must be performed by qualified personnel familiarised with the

construction, operation, and hazards involved with the control.

● Maintenance should be performed with the control out of operation and disconnected

from all sources of power.

● Care should be taken when servicing electrostatic sensitive components. The

manufacturer's recommendations for these components should be followed.
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● The M-Duino WiFi/BLE Family PLCs are Open Type Controllers. It is required that you

install the M-Duino WiFi/BLE PLC in a housing, cabinet, or electric control room. Entry

to the housing, cabinet, or electric control room should be limited to authorised

personnel. Failure to follow these installation requirements could result in severe

personal injury and/or property damage. Always follow these requirements when

installing M-Duino family PLCs.

● In case of installation or maintenance of the M-Duino please follow the instructions

marked in the Installation and Maintenance section.

● Do not disconnect equipment when a flammable or combustible atmosphere is

present. Disconnection of equipment when a flammable or combustible atmosphere is

present may cause a fire or explosion which could result in death, serious injury and/or

property damage.

Avertissements:

● Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut

endommager le contrôleur.

● Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur.

● Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de

câblage.

● Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du

produit et la documentation qui l’accompagne.

● La maintenance doit être effectuée par personnel qualifié familiarisé avec la

fabrication, le fonctionnement et les dangers liés au contrôleur.

● La maintenance doit être effectuée avec l’équipement hors service et déconnectée de

toutes les sources d'alimentation.

● Faites attention lors de l'entretien des composants sensibles à l'électricité statique. Les

recommandations du fabricant pour ces composants doivent être suivies.

● Les automates de la famille M-Duino sont des contrôleurs de type ouvert. Il est

nécessaire d'installer l'automate M-Duino dans un boîtier, une armoire ou une salle de

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences

d'installation peut entraîner des blessures graves et/ou des dommages matériels

importants. Respectez toujours ces exigences lors de l'installation des automates de la

famille M-Duino.

● En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions

indiquées dans la section Installation et Maintenance.

● Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou

combustible. La déconnexion de l'équipement en présence d'une atmosphère

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant

entraîner la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and understand this manual

Please read and understand this manual before using the product. Please consult your

comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT

BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF

PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING

THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE

INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND

INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or

standards that apply to the combination of products in the customer’s application or use of the

product.

The following are some examples of applications for which particular attention must be given.

This is not intended to be an exhaustive list of all possible uses of the products, nor is it

intended to imply that the uses may be suitable for the products:

● Systems, machines, and equipment that could present a risk to life or property.

● Nuclear energy control systems, combustion systems, railroad systems, aviation

systems, medical equipment, amusement machines, vehicles, safety equipment, and

installation subject to separate industry or government regulations.

● Outdoor use, uses involving potential chemical contamination or electrical

interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification

documents identifying ratings and limitations of use that apply to the products. This

information by itself is not sufficient for a complete determination of the suitability of the

products in combination with the system, machine, end product, or other application or use.
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Intended use of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the

catalogue and the associated technical documentation. If third-party products and components

are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,

installation, assembly, operation and maintenance have been carried out in a correct It must

respect the permissible ambient conditions. You should also follow the indications and

warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated

by qualified personnel for the task entrusted and observing what is indicated in the

documentation corresponding to it, particularly the safety instructions and warnings included

in it. Due to their training and experience, qualified personnel are in a position to recognize

risks resulting from the handling or manipulation of such products / systems and to avoid

possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even

when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining

suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL

SHIELDS’s test conditions, and the users most correlate it to actual application requirements.

Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;

however, no responsibility is assumed for clerical, typographical, or proofreading errors, or

omissions.

Residual risks

The control and drive components of an Industrial Shields PLC are approved for industrial and

commercial use in industrial line supplies. Their use in public line supplies requires a different

configuration and/or additional measures. These components may only be operated in closed

housings or in higher-level control cabinets with protective covers that are closed, and when all

of the protective devices are used. These components may only be handled by qualified and

trained technical personnel who are knowledgeable and observe all of the safety information

and instructions on the components and in the associated technical user documentation.

When carrying out a risk assessment of a machine in accordance with the EU Machinery

Directive, the machine manufacturer must consider the following residual risks associated with

the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,

maintenance, and repairs caused by, for example: − Hardware defects and/or software errors in

the sensors, controllers, actuators, and connection technology − Response times of the

controller and drive − Operating and/or ambient conditions not within the scope of the

specification − Condensation / conductive contamination − Parameterization, programming,

cabling, and installation errors − Use of radio devices / cellular phones in the immediate

vicinity of the controller − External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for

example: − Component malfunctions − Software errors − Operating and/or ambient

conditions not within the scope of the specification − External influences / damage.

3. Hazardous shock voltages caused by, for example: − Component malfunctions − Influence of

electrostatic charging − Induction of voltages in moving motors − Operating and/or ambient

conditions not within the scope of the specification − Condensation / conductive

contamination − External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to

people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the

system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials

and workmanship for a period of one year (or other period if specified) from date of sale by

Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,

REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE

OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR

INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR

IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL

DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE

PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR

STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER

CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT

THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT

SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.

ETL Listing Mark-Direct Imprint information

Recognized
Component ETL Classified

Conforms to:
UL Std. 61010-1
UL Std. 61010-2-201
Cert. To CSA Std. C22.2 No. 61010-1
Cert. ToCSA Std. C22.2 No.61010-2-201

Place for control
number:
5016476
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1 General Description M-DUINO WiFi/BLE product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is important

to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the shield from

below and D the shield from above. Having a B and a C in the middle of them.:

● The inputs in the zone B are named I0.X, being X any number suitable in the Shield.
Outputs are named as Q0.X and relays as R0.X

● The inputs in the zone C are named I1.X, being X any number suitable in the Shield.
Outputs are named as Q1.X and relays as R1.X

● The inputs in the zone D are named I2.X, being X any number suitable in the Shield.
Outputs are named as Q2.X and relays as R2.X
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1.2 Reference table

Reference Table

Model Reference

PLC M-Duino General Family

M-Duino PLC Arduino Ethernet & WiFi & BLE 19R I/Os Analog / Digital Plus 007001000100

M-Duino PLC Arduino Ethernet & WiFi & BLE 21 I/Os Analog / Digital Plus 007001000200

M-Duino PLC Arduino Ethernet & WiFi & BLE 38AR I/Os Analog / Digital Plus 007001000700

M-Duino PLC Arduino Ethernet & WiFi & BLE 38R I/Os Analog / Digital Plus 007001000300

M-Duino PLC Arduino Ethernet & WiFi & BLE 42 I/Os Analog / Digital Plus 007001000400

M-Duino PLC Arduino Ethernet & WiFi & BLE 50RRA I/Os Analog / Digital Plus 007001000900

M-Duino PLC Arduino Ethernet & WiFi & BLE 53ARR I/Os Analog / Digital Plus 007001001000

M-Duino PLC Arduino Ethernet & WiFi & BLE 54ARA I/Os Analog / Digital Plus 007001001100

M-Duino PLC Arduino Ethernet & WiFi & BLE 57AAR I/Os Analog / Digital Plus 007001000800

M-Duino PLC Arduino Ethernet & WiFi & BLE 57R I/Os Analog / Digital Plus 007001000500

M-Duino PLC Arduino Ethernet & WiFi & BLE 58 I/Os Analog / Digital Plus 007001000600

To find the reference of your M-Duino WiFi/BLE PLC, check the arrow in the picture below. In

the example, the reference is:
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1.3 Zones Table

Zones Table

Model Zone A Zone B Zone C Zone D

M-Duino WiFi/BLE PLC 19R+ ✔ Relay - -

M-Duino WiFi/BLE PLC 21+ ✔ Analog / Digital - -

M-Duino WiFi/BLE PLC 38AR+ ✔ Analog / Digital Relay -

M-Duino WiFi/BLE PLC 38R+ ✔ Relay Relay -

M-Duino WiFi/BLE PLC 42+ ✔ Analog / Digital Analog / Digital -

M-Duino WiFi/BLE PLC 50RRA+ ✔ Relay Relay Analog / Digital

M-Duino WiFi/BLE PLC 53ARR+ ✔ Analog / Digital Relay Relay

M-Duino WiFi/BLE PLC 54ARA+ ✔ Analog / Digital Relay Analog / Digital

M-Duino WiFi/BLE PLC 57AAR+ ✔ Analog / Digital Analog / Digital Relay

M-Duino WiFi/BLE PLC 57R+ ✔ Relay Relay Relay

M-Duino WiFi/BLE PLC 58+ ✔ Analog / Digital Analog / Digital Analog / Digital

The distribution of the different features that provide the M-Duino WiFi/BLE PLC Family is the

following one:

Shield B Zone C Zone D Zone

Analog Shield

13 Inputs
(13 Digital Inputs, 6
of which can work as

Analog Input)

8 Outputs
(8 Digital Outputs, 3
of which can work as

Analog Output)

11 Inputs
(11 Digital Inputs, 6
of which can work as

Analog Input)

8 Outputs
(8 Digital Outputs, 3
of which can work as

Analog Output)

10 Inputs
(10 Digital Inputs, 4
of which can work as

Analog Input)

6 Outputs
(6 Digital Outputs, 2
of which can work as

Analog Outputs)

Relay Shield

6 inputs
(6 Digital Inputs, 4 of
which can work as

Analog Input)

3 Outputs
(3 Digital Outputs, 3
of which can work as

Analog Output)

8 Relays

4 inputs
(4 Digital Inputs, 4 of
which can work as

Analog Input)

3 Outputs
(3 Digital Outputs, 3
of which can work as

Analog Output)

8 Relays

6 inputs
(6 Digital Inputs, 4 of
which can work as

Analog Input)

2 Outputs
(2 Digital Outputs, 2
of which can work as

Analog Output)

7 Relays

12
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1.4 A Zone Features

Shield A Zone

Communication

Shield

(1x) Ethernet

(1x) USB

(1x) I2C

(1x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485

(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

(1x) WiFi/BLE

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) Width (mm) Depth (mm) Max weight (g)

M-Duino WiFi/BLE PLC 19R+ 119.5 70.1 101 394

M-Duino WiFi/BLE PLC 21+ 119.5 70.1 101 394

M-Duino WiFi/BLE PLC 38AR+ 119.5 94.7 101 504

M-Duino WiFi/BLE PLC 38R+ 119.5 94.7 101 504

M-Duino WiFi/BLE PLC 42+ 119.5 94.7 101 504

M-Duino WiFi/BLE PLC 50RRA+ 119.5 119.3 101 614

M-Duino WiFi/BLE PLC 53ARR+ 119.5 119.3 101 614

M-Duino WiFi/BLE PLC 54ARA+ 119.5 119.3 101 614

M-Duino WiFi/BLE PLC 57AAR+ 119.5 119.3 101 614

M-Duino WiFi/BLE PLC 57R+ 119.5 119.3 101 614

M-Duino WiFi/BLE PLC 58+ 119.5 119.3 101 614

13
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1.6 General Features

CONNECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE Controller General Specifications Information

Input Voltage
12 to 24Vdc Fuse protection (2.5A)

Polarity protection

Input rated voltage
24 Vdc

Rated Power 30W

I max. 1.5A

Size Check size and weight table

Clock Speed 16MHz

Flash Memory 256KB of which 8KB used by bootloader

SRAM 8KB

EEPROM 4KB

Communications
I2C – Ethernet Port – USB – RS485 – RS232 – SPI –

(1x) RX, TX (Arduino pins) – Wi-Fi
Max232-Max485-W5500 -

ESP32

USB consideration!
Only meant for uploading or debugging, not
always connected as a serial in a project!

Cannot be working in a final
application

An/Dig Input 10bit
(0-10Vcc)

0 to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vdc

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc

Max read time: 116us

*Check Section 14 for digital
inputs threshold detection

Digital Isolated Input
(24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc

All Digital Inputs are PNP.
Click here1 for more

information.

Max read time: 8us

* Interrupt isolated
Input HS (24Vcc)

5 to 24Vdc
I min: 2 to 12mA
Galvanic Isolation

Rated Voltage: 24Vdc
Max read time: 8us

Analog Output 8bit
(0-10Vcc)

0 to 10Vdc
I max: 20mA

Separated PCB ground
Rated Voltage: 10Vdc

Output frequency: 2Hz

Rising edge time: 150ms
Falling edge time: 252ms

1 https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193
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Digital Isolated Output
(24Vcc)

5 to 24Vdc
I max: 70mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Imax 24Vdc: 410mA

With 70 us delay,
freq is 6.849MHz

with pulse width of 106us

Rising edge time: 476ns
Falling edge time: 42.8us

Digital Isolated Output
Relay

30Vdc / 250Vac
Galvanic Isolation

Diode protected for Relay
Imax: 3A (30Vdc)
Imax: 5A (250Vac)

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
I max: 70mA

Galvanic Isolation
Diode Protected for Relay

Rated Voltage: 24Vdc

Direct Arduino Pin
Output

0 to 5Vdc
I max: 40mA

Rated Voltage: 5Vdc

Max frequency: 77kHz

Rising edge time: 200ns
Falling edge time: 200ns

Direct Arduino Pin
Input

0 to 5Vdc
I max: 40mA

Rated Voltage: 5Vdc
Max read time: 8us

I2C Pin
5V Pull-up

Max frequency: 100kHz
Rising edge time: 10us
Falling edge time: 150ns

One-Wire Pin
Usable pins:

Pin 2, Pin3, SCL, SDA, RX0, TX0,
MISO, MOSI, SCK

Frequency: 800kHz

Expandability I2C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal (24Vdc)
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1.7 Power consumption of the M-Duino WiFi/BLE Family PLCs

Model Current resting
(mA)

Power resting
(W)

Current active
(mA)

Power active
(W)

21+ 99 2,376 120 2,88

42+ 92 2,208 128 3,072

58+ 76 1,824 126 3,024

19R+ 80 1,92 202 4,848

38R+ 77 1,848 313 7,512

57R+ 73 1,752 425 10,2

38AR+ 72 1,728 221 5,304

53ARR+ 71 1,704 323 7,752

57AAR+ 71 1,704 221 5,304

54ARA+ 76 1,824 231 5,544

50RRA+ 82 1,968 322 7,728

The power consumption is measured at 24Vdc.

The current resting column denotes the minimum current drawn by the PLC when all outputs
are at a LOW level, representing the PLC's baseline power consumption.

In contrast, the current active column reflects the current drawn by the PLC when all outputs
are at a HIGH level, and there are no connections to any of the outputs. While this value is not
the absolute maximum the Arduino based PLC can draw, it serves as a reference point for
expected current values.

It's important to note that the practical maximum current may vary depending on the type of
actuators connected to the outputs and the number of I/Os used. The actual consumption can
be influenced by the specific configuration and load connected to the PLC's outputs."
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2 Technical Specifications

2.1 General Specifications

Item M-Duino WiFi/BLE Family PLC

Power supply
voltage

DC power supply 12 to 24Vdc

Operating
voltage range

DC power supply 11.4 to 25.4Vdc

Power
consumption

DC power supply 30W max.

External
power supply

Power supply
voltage

24Vdc

Power supply
output capacity

700mA

Insulation resistance 20MΩmin.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength
2.300Vac at 50/60 Hz for one minute with a leakage current of 10mA max. Between all

the external AC terminals and the protective ground terminal.

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each.

Ambient temperature (operating) 0º to 60ºC

Ambient humidity (operating) 10% to 90% (no condensation)

Ambient environment (operating) With no corrosive gas

Ambient temperature (storage) -20º to 60ºC

Power supply holding time 2ms min.

Weight Check size and weight table

2.2 Performance Specification:

Arduino Board ARDUINO MEGA 2560

Control method Stored program method

I/O control method Combination of the cyclic scan and immediate refresh processing methods.

Programming language
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of
a programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller ATmega2560

Flash Memory 256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB

EEPROM 4KB

Clock Speed 16MHz

17
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2.3 Symbology

Table that includes all the symbology that is used in the serigraph of the M-Duino WiFi/BLE PLC

Family:

Symbol
Standard No. /
Standard Title

Standard Reference
No. / Symbol Title

Symbol Meaning

IEC 60417 /
Graphical symbols

for use on
equipment

5031 / Direct
Current

Indicates that the equipment is
suitable for direct current only; to

identify relevant terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5032 / Alternating
Current

Indicates that the equipment is
suitable for alternating current

only; to identify relevant
terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5130 / Pulse General
To identify the control by which a

pulse is started.

IEC 60417 /
Graphical symbols

for use on
equipment

5017 / Earth,
Ground

To identify an earth (ground)
terminal in cases where neither
the symbol 5018 nor 5019 is

explicitly required.

IEC 60417 /
Graphical symbols

for use on
equipment

5115 / Signal lamp
To identify the switch by means
of which the signal lamp(s) is

(are) switched on or off.

2004/108/EC /
Electromagnetic
Compatibility

CE Marking
CE marking indicates that a

product complies with applicable
European Union regulations

ISO 7000/ Graphical
symbols for use on

equipment

0434B /
Warning symbol

Indicates a potentially hazardous
situation which, if not avoided,
could result in death or serious

injury

ISO 7000/ Graphical
symbols for use on

equipment

5036 / Dangerous
Voltage

To indicate hazards arising from
dangerous voltages
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3 Precautions

Read this manual before attempting to use any of the M-Duino GPRS PLC Family and follow its
descriptions for reference during operation.

3.1 Arduino Board

The M-Duino GPRS Family PLCs include Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in

this manual. Before using M-Duino under different conditions from what has been specified in

this manual or integrating M-Duino to nuclear control systems, railroad systems, aviation

systems, vehicles, combustion systems, medical equipment, amusement machines, safety

equipment and other systems, machines, and equipment that may have a serious influence on

lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure

that the rating and performance characteristics of M-Duino are sufficient for the systems,

machines, and equipment, and be sure to provide the systems, machines, and equipment

double safety mechanisms. This manual provides information for programming and operating

the M-Duino.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different

systems. This means that if an external device or sensor that shares the same ground reference

(GND) with the system is connected, any potential difference between these grounds could

damage the connected components. To avoid issues with interference, ground loops, or

damage to external equipment, ensure that all connected devices share the same ground

reference or use systems with appropriate isolation.

Recommendations:

● Connection Review: Verify that all ground connections are properly made and that

there are no significant potential differences between them.

● Use of Isolation: Consider using galvanic isolators or isolation transformers if it is

necessary to connect equipment with different ground references.
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4 M-Duino Pinout

IOs Table

Model Reference

Analog

Input*¹

Digital Isolated

Input

Digital Isolated

Output

Digital/Analog

Output Relay Output

PWM Isolated

Output*²

19R+ 007001000100 4 2 0 3 8 3

21+ 007001000200 6 7 5 3 0 3

38AR+ 007001000700 10 7 5 6 8 6

38R+ 007001000300 8 2 0 6 16 6

42+ 007001000400 12 12 10 6 0 6

50RRA+ 007001000900 12 8 4 8 16 8

53ARR+ 007001001000 14 9 5 8 15 8

54ARA+ 007001001100 14 13 9 8 8 8

57AAR+ 007001000800 16 14 10 8 7 8

57R+ 007001000500 12 4 0 8 23 8

58+ 007001000600 16 18 14 8 0 8

*¹ The analog inputs can also be used as digital inputs.

*² The PWM isolated outputs can also be used as digital isolated outputs. The associated PWM

and analog outputs cannot be used at the same time (check switch configuration).
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5 Serigraphy

5.1 A Zone connection (Communications)

Base

A Zone

M-Duino
Connector

Arduino
Pin

Function

AREF
SQW

-
3.3Vdc
5Vdc
GND

AREF
SQW

-
3.3Vdc
5Vdc
GND

Arduino Pin
Arduino Pin

-
-

GND

Base

A Zone

M-Duino
Connector

Arduino
Pin

Function

SCL
SDA
RX0
TX0
-
-
TX
RX
Z-
Y+
B-
A+

PIN3
50 SO
51 SI
52 SCK
Reset
Vin5
PIN2
GND
GND
24Vdc

21
20
0
1
-
-
16
17
-
-
-
-
3
50
51
52

Reset
Vin5
2
-
-

I2C/SS
I2C/SS
RX0/SS
TX0/SS

-
-

RX2(serial 2)
TX2(serial 2)

RS485
RS485
RS485
RS485

Arduino Pin
SPI
SPI
SPI
SPI
5V

Arduino Pin
Gnd
Gnd

Power Supply

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any

device.
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Ethernet Reset USB-B

RTC Programmable button
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5.2 Analog/Digital Zone connection (I/Os)

X Zone

M-Duino
Connector

Function

IX.12
IX.11
IX.10
IX.9
IX.8
IX.7

(-)IX.6
IX.6/INT
(-)IX.5

IX.5/INT
(-)IX.4
IX.4

(-)IX.3
IX.3

(-)IX.2
IX.2

(-)IX.1
IX.1

(-)IX.0
IX.0

Analog/Digital In*
Analog/Digital In*
Analog/Digital In
Analog/Digital In
Analog/Digital In
Analog/Digital In

GND IX.6
Interrupt X In2

GND IX.5
Interrupt X In3

GND IX.4*
Digital Input*

GND IX.3
Digital Input
GND IX.2

Digital Input
GND IX.1

Digital Input
GND IX.0

Digital Input

*Connectors IX.12, IX.11 and IX.4 are not connected (NC) in D Zone.

Top Zone

Led indicator I/Os state

X Zone

M-Duino
Connector

Function

GND
AX.7
AX.6
AX.5
QVdc
COM(-)
QX.7
QX.6
QX.5
QX.4
QX.3
QX.2
QX.1
QX.0

GND
Analog Out*
Analog Out
Analog Out

External Isolated Out Vdc
External Isolated Out GND

Digital/PWM Out*
Digital/PWM Out
Digital/PWM Out

Digital Out*
Digital Out
Digital Out
Digital Out
Digital Out

*Connectors AX.7, QX.7 and QX.4 are not connected (NC) in D Zone.

2 See section 5.4 to know more about interrupt pins.
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5.3 Relay Zone connection (I/Os)

X Zone

M-Duino
Connector

Function

RX.8
RX.7
RX.6
RX.5
RX.4
AX.2
AX.1
AX.0
GND
QX.2
QX.1
QX.0

COM(-)
QVdc

Relay Out
Relay Out
Relay Out
Relay Out*
Relay Out

Analog Out*
Analog Out
Analog Out

GND
Digital/PWM Out*
Digital/PWM Out
Digital/PWM Out

External Isolated Out Gnd
External Isolated Out Vdc

*Connectors RX.5, AX.2 and QX.2 are not connected (NC) in D Zone.

Top Zone

Led indicator I/Os state

X Zone

M-Duino Connector Function

RX.3
RX.2
RX.1
GND
IX.5
IX.4
IX.3
IX.2

IX.1/INT3

(-)IX.1
IX.0/INT4

(-)IX.0

Relay Out
Relay Out
Relay Out

GND
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input
Analog/Digital Input

Interrupt X In
GND IX.1

Interrupt X In
GND IX.0

3 See section 5.4 to know more about interrupt pins.
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5.4 Interrupt equivalence table

See the Reference Table in order to know the specific device details.

Analog/Digital Relay

Zone PLC Input PLC Interrupt M-Duino Pin PLC Input PLC Interrupt M-Duino Pin

B
0.6 INT1 PIN3 0.1 INT1 PIN3

0.5 INT0 PIN2 0.0 INT0 PIN2

C
1.5 INT5 PIN19 - - -

1.6 INT4 PIN18 - - -

D
2.5 INT3 PIN21 2.1 INT3 PIN21

2.6 INT2 PIN20 2.0 INT2 PIN20

If WiFi is activated through switches, interrupts INT5 and INT4 will not work.

Check this link for more information.
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6 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C

language. They can also be programmed directly using C, but it is much easier working with

Arduino IDE, as it provides lots of useful libraries.

Industrial Shields provide a boards package for programming the PLCs, making it easier and

friendlier. It includes various facilities such as not having to define the pins, etc.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.15 or above (recommended: 1.8.19).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.
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2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board:… -> Boards Manager

5. Search for “industrialshields” on the browser.
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

Once it is selected M-Duino WiFi/BT Family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

Also there are some examples of programming in File -> Examples -> Examples for WiFi

module.

Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/Industrial-Shields/
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7 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
M-Duino WiFi/BLE Family uses B-USB cable.

- Open Arduino IDE interface:

- Select Industrial Shields boards -> M-Duino WIFI/BT Family

- Select the correct M-Duino Board (M-Duino 58+WIFI/BT in our example).

- Select the correct port.
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8 How to connect PLC to power supply

- M-Duino WIFI/BLE Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT

REVERSIBLE!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail:

-12Vdc / 24Vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel operation, overvoltage protection, and

overcurrent protection. There is a LED inductor for power status, the power supply is

certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types

of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the

equipment must be separated from the dangerous voltage cables.
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9 Switch configuration

9.1 A Zone: Communications

A Zone

Switch OFF ON

SCL | XX SCL XX

SDA | XX SDA XX

WiFi | XX WiFi XX

WiFi | XX WiFi XX

Pin 3 | XX Pin 3 XX

Pin 2 | XX Pin 2 XX

SD | XX SD XX

FD | HD FD HD

This is an D Zone Switch example from M-Duino 58+ WIFI/BLE. In

this case, SCL, SDA, I1.6, I1.5, I0.6, I0.5, Q2.0 and HD are enabled.

This means SCL, SDA, WIFI, Pin 3, Pin 2, SD and FD are disabled.

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and

disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and

disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX.

2. WiFi | XX: Choosing between WiFi or the input XX. If the switch is ON, it enables XX and

disables WiFi. If the switch is OFF, it enables WiFi and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX. Both WiFi switches must be enabled to activate WiFi

connection

1. WiFi | XX: Choosing between WiFi or the input XX. If the switch is ON, it enables XX and

disables WiFi. If the switch is OFF, it enables WiFi and disables XX. The serigraphy in the PLC will

indicate which input is referred to XX. Both WiFi switches must be enabled to activate WiFi

connection.
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4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and

disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC

will indicate which input is referred to XX.

3. Pin 2 | XX: Choosing between Pin 2 or the input XX. If the switch is ON, it enables XX and

disables Pin 2. If the switch is OFF, it enables Pin 2 and disables XX. The serigraphy in the PLC

will indicate which input is referred to XX.

2. SD | XX: Choosing between SD or the input XX. If the switch is ON, it enables XX and disables

SD. If the switch is OFF, it enables SD and disables XX. The serigraphy in the PLC will indicate

which input is referred to XX.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If

the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means

Full Duplex. Check section 11.2 for more information.

A Zone

Switch OFF ON

NC - -

NC - -

NC | RTC - RTC

NC | RTC - RTC

This switch enables the communication with RTC using

I2C. Having both switches in ON mode activates the

communication, whereas if they are in OFF mode I2C is disabled to reach the RTC.
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9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON

NC - -

AX.7 | QX.7 AX.7 QX.7

AX.6 | QX.6 AX.6 QX.6

AX.5 | QX.5 AX.5 QX.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know

what number takes X.

We can see here an example switch from the C Zone

(Notice that X takes value 1 here).

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF

it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will

provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, output A2.7 | Q2.7 is not connected.
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9.3 Relay Shield Switches

Relay Shield Switch

Switch OFF ON

NC - -

AX.2 | QX.2 AX.2 QX.2

AX.1 | QX.1 AX.1 QX.1

AX.0 | QX.0 AX.0 QX.0

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know

what number takes X.

We can see here an example switch from the B Zone (Notice

that X takes value 0 here).

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it

can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide

this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will

provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, output A2.2 | Q2.2 is not connected.
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10 M-Duino Arduino I/Os 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed

according to Arduino features such as I/Os operating at 5V or any additional features present in

the pins (for example I2C communication in pins SCL and SDA). As these pins are directly

connected to the Arduino Mega board they are not as well protected as the normal inputs.

These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of

these pins the configuration switch must be set to OFF position (see section 9) and some extra

considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TX0 1
RX 17
TX 16

MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than

5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.

Now it is going to be shown the considerations to operate with these pins.

10.1 I2C pins – SDA/SCL

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it

reads 5V when nothing is connected. The pull-up configuration is established by default in

these pins.

If it is meant to use them as an internal arduino direct PIN at 5V, it has to be considered that

they are pull-up inputs (2200Ω resistor is used in the internal pull-up).
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10.2 Serial 0 – RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in

case that all the 5V pins are already performing a function. This is because they are shared with

the USB interface. If using these pins, the USB communication cannot be working at the same

time.

When the PLC is not installed, the USB communication is normally required for debugging,

uploading and intercommunicating with the Ethernet controller. If using both interfaces at the

same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be established as an external pull-up or pull-down circuit in order to correctly work with

these pins.

10.3 SPI – MISO/MOSI/SCK

These pins can only work as 5V pins if the Ethernet protocol is not going to be used. As the

Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours

cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be established as an external pull-up or pull-down circuit in order to correctly work with

these pins.

10.4 Pin 2/Pin 3

To know how to configure these pins correctly, check section 9.

These pins are not established with a pull-up or a pull-down configuration. The state of these

pins is unknown. If these pins must be used, they require a pull-up or a pull-down

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it

must be established as an external pull-up or pull-down circuit in order to correctly work with

these pins.
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11 A Zone Features: Communications & RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16

and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not

matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232

implementation.

Click here4 or here5 to see more about this communication.

11.2 RS-485

For RS485 communication protocol the defined Arduino Mega pins are shown in the chart

below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this

communication. The RS-485 protocol will be always enabled, the only switch that affects is the

one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half

Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485

implementation.

Click here6 or here7 to see more about this communication.

7
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213

6
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195

5
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16

4
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183
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11.3 I2C

I2C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor

is already implemented in the PCB.

I2C communication is configured by switches, so the switches must be configured in order to

enable the I2C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the I2C as it can be used with the

standard library of Arduino called Wire.

Click here8 to see more about this communication.

11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,

MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,

each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 51 SI 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX3/TX3/Pin2/Pin3 21/20/1/0/15/14/2/3

Check the switch configuration at section 9 to enable SS pins.

Click here9 to see more about this communication.

11.5 TTL

M-Duino has two TTL ports, RX0/TX0, RX/TX. TTL0 is accessed with the function Serial (pins 0

and 1 of the Arduino Mega). TTL is accessed with the function Serial2 (pins 16 and 17 of the

Arduino Mega). See section 9 for more information.

9
https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191

8
https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
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11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the IC compatible with

Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the

M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS Arduino

Mega pin 10). Click here10 and here11 to see more about this communication.

11.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the I2C protocol

communication, so it is required to have enabled the I2C protocol. This means 4 switches have

to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the I2C wires to the RTC. If they are in

OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more

information.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation

called RTC. Click here12 to see more about this feature.

11.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol

is always enabled, as there are no switches that configure it. However, there is a switch that

must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch is in ON

mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of

the PLC, it is required to open the plastic found in the frontal part and the socket is located

under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation

called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to

select the Chip Select of the uSD chip. Click here13 to see more about this feature.

13
https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167

12
https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51

11
https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105

10
https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103
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Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the

operation of an online process or machine. Unexpected operation of a process or machine

could result in death or injury to personnel and/or property damage. Before inserting a

memory card, always ensure that the CPU is offline and in a safe state.

Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la

carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le

fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un

processus ou d'une machine peut entraîner la mort ou des blessures corporelles et / ou des

dégâts matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors

ligne et en sécurité.

11.9WiFi & BLE

The WiFi and Bluetooth integrated module consists of a single 2.4 GHz Wi-Fi and Bluetooth

combo chip designed with the TSMC ultra-low-power, 40 nm technology. It is designed to

achieve the best power and RF performance, showing robustness, versatility and reliability in a

wide variety of applications and power scenarios. Some applications are Generic Low-power

IoT Sensor Hub, Generic Low-power IoT Data Loggers and Mesh Network.

It is designed for Internet-of-Things (IoT) applications.

11.9.1 General Specifications:

Wi-Fi

● 802.11 b/g/n

● 802.11 n (2.4 GHz), up to 150 Mbps

Bluetooth

● Bluetooth 4.2 BR/EDR BLE dual-mode controller

● +12 dBm transmitting power

● NZIF receiver with -97 dBm BLE sensitivity
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11.9.2 WiFi & Bluetooth Module Configuration
In order to configure the WiFi & BLE module, you must connect it to a PC. To connect it you will

need a micro USB to USB cable.

The slot for the micro USB input is located on the right side of your equipment.

To load the program into the ESP32 you have to use the appropriate board. For that, update

our board to the latest version. Go to Tools -> Board -> Boards Manager. Search by

industrialshields-esp32.

Now you are able to install the board. Go to Tools -> Boards -> industrialshields-esp32 -> WiFi

module.
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The internal connection between the ESP32 module and the Arduino Mega is the following:

Arduino Mega Pinout ESP32 Pinout

5Vdc Vcc

GND GND

Tx1 (Pin 18) TxD

Rx1 (Pin 19) RxD

WiFi and Bluetooth are always enabled as there are no switches that configure it. The WiFi and

Bluetooth module uses Serial1 for communication.

More information:

https://www.industrialshields.com/blog/arduino-industrial-1/post/esp32-bluetooth-ble-wifi-13

3
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12 Examples

12.1 Communication system between M-Duino and WiFi module

As seen in the chart above, a Serial TTL communication is used to interact between Arduino

Mega 2560 board and ESP32 module. In this blog14, an introduction to this communication

between modules is done using an example code.

12.2How to connect your ESP based PLC to Wi-Fi

If having problems connecting your ESP32 based PLC to Wi-Fi, follow this other blog15. There

you can find a brief description of the code provided and also an explanation about how the

ESP32 board and the Arduino shield are connected to each other.

12.3 Interact with M-Duino WiFi/BLE PLC via Bluetooth

To learn how to work with BLE from the ESP32 board, follow the instructions on this blog16. In

it, a useful example of usage of the BLE feature is explained. In addition, communication

between the M-Duino board and the ESP32 is also covered in the blog.

16 https://www.industrialshields.com/blog/arduino-industrial-1/post/interact-with-m-duino-wifi-ble-plc-via-bluetooth-480

15 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-your-esp32-based-plc-to-wi-fi-452

14

https://www.industrialshields.com/blog/arduino-industrial-1/post/communication-system-between-m-duino-and-wifi-module-148
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13 Instructions for interconnection between Industrial

Shields controllers

13.1 RS-232 Communication:

13.2 RS-485 Communication:

13.2.1 Half Duplex

13.2.2 Full Duplex
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13.3 Ethernet

For Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet

crossover cable must be used.

14 Digital inputs threshold detection
The M-Duino inputs have a minimum voltage threshold to reliably detect the signal when used

as digital input. The threshold value is different depending on the input type:

45

Input type Threshold voltage (V)

Digital input 4

Analog input 5.1
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15 I/O technical details
A comparison between the waveforms of the I/Os from the M-Duino WiFi/BLE Family PLC and

the Arduino Mega is done in this section.

Digital Output Waveform:

Digital Output Turn-off:

PWM Waveform:
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Analog Out Turn-On:

Analog Out Turn-Off:

Analog /Digital input Turn-on:
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16 Typical Connections
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17 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 188152917

connector from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:

MC 0,5/ 4-G-2,5 - 1881464

MC 0,5/ 6-G-2,5 - 1881480

MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference MC 0,5/10-G-2,5 - 1881529

Height 8.1 mm

Pitch 2.5 mm

Dimension 22.5 mm

Pin dimensions 0.8 x 0.8 mm

Pin spacing 2.5 mm

17 https://www.phoenixcontact.com/en-us/products/pcb-header-mc-0510-g-25-1881529
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For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 188140618 connector from Phoenix

contact.

In the PLC we can find other connectors too, and these are the references for them:

FK-MC 0,5/ 4-ST-2,5 - 1881341

FK-MC 0,5/ 6-ST-2,5 - 1881367

FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm²

Rigid conduit section max. 0,5 mm²

Flexible conduit section min. 0,14 mm²

Flexible conduit section max. 0,5 mm²

Conduit section AWG/kcmil min. 26

Conduit section AWG/kcmil max. 20

18

https://es.farnell.com/phoenix-contact/fk-mc-0-5-10-st-2-5/plug-libre-muelle-2-5-mm-10-v/dp/1792814
?CMP=KNC-GES-GEN-KWL-PDP-High-Aov-phoenix-contact-15-July-22&mckv=_dc%7Cpcrid%7C60387320
4419%7C&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd4jIzLvIJs5K_3lEpaW5Anqo3FBLu1TwiPFtyKaiP-rj4LSIy6
7bWoaAuLnEALw_wcB
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We can also find the relay connectors.

MCV 1,5/ 2-G-3,81 180342619 is the female connector, and MC 1,5/ 2-ST-3,81, GTIN UPC20 is the

male one. Both are from Phoenix Contact.

Article reference MCV 1,5/ 2-G-3,81 1803426

Height 12.6 mm

Pitch 3.81 mm

Dimension a 3.81 mm

Pin dimensions 0.8 x 0.8 mm

Article reference MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm

Pitch 3.81 mm

Dimension a 3.81 mm

20

https://es.farnell.com/phoenix-contact/1803578/terminal-block-pluggable-2pos/dp/3704907?gclid=Cj0K
CQjw_viWBhD8ARIsAH1mCd6YjA37NqmaaFBXgbRyGExfAM8qDodVOWZPfYsLLQhnVygDn8ufNsIaAmgYE
ALw_wcB&mckv=_dc%7Cpcrid%7C575710444791%7Cplid%7C%7Ckword%7C%7Cmatch%7C%7Cslid%7C
%7Cproduct%7C3704907%7Cpgrid%7C131987845643%7Cptaid%7Cpla-372506228807&CMP=KNC-GES-
GEN-SMART-SHOPPING-High-Jan-2022&gross_price=true

19

https://www.tme.eu/es/details/mcv1.5_2-g-3.81/bloque-de-bornas-extraibles/phoenix-contact/mcv-1-5
-2-g-3-81-1803426/?brutto=1&currency=EUR&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd763F0sGBmfjy5p
mZm9dKysA6ePciWt8md8utGsZX1OfLpgsBx4mnoaAo9GEALw_wcB
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18 DIN Rail mounting

For optimal operation of the product, it must be located in an electrical cabinet with
IK08 mechanical protection. The minimum IP protection degree required is IP56.
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19 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.
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Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.
Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25 cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by an excess
of temperature.
- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
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and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.
- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:
- If the equipment is suitable to be repaired, it must be verified that the equipment

remains in a safe state after repair.
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20 Revision Table

Revision Number Date Changes

0 26/07/2019 First implementation

1 02/03/2020 Second implementation

2 08/06/2022 Third implementation

3 30/09/2022
M-Duino WiFi/BLE Family User Manual

Implementation

4 11/03/2024 Added section 14 “Digital inputs threshold detection”

5 26/09/2024 Added section 3.4 (“Isolation Precautions”)

6 03/12/2024 Removed wrong IORef pin reference

About Industrial Shields:

Direction: Camí del Grau, nº25

Zip/Postal Code: 08272

City: Sant Fruitós de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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